ODOT Analysis and Traffic Simulation Manual (OATS)

July 2020
# Table of Contents

1. **Chapter 1. Traffic Analysis Scoping** ................................................................. 1
   1.1 *Scoping Elements* ......................................................................................... 1
       1.1.1 Traffic Analysis Type .................................................................................. 1
       1.1.2 Project Description ...................................................................................... 2
       1.1.3 Traffic Analysis Objective .......................................................................... 2
       1.1.4 Analysis Boundary Limits .......................................................................... 2
       1.1.5 Study Periods and Analysis Years .............................................................. 3
       1.1.6 Traffic Analysis Tool Selection ................................................................... 3
       1.1.7 Data Requirements and Data Collection Plan ............................................. 4
       1.1.8 Project Traffic Forecasting ......................................................................... 4
       1.1.9 Project Alternatives ..................................................................................... 4
       1.1.10 Performance Measures of Effectiveness (MOEs) ....................................... 5
       1.1.11 Analysis Report and Documentation ........................................................... 5
   1.2 *Traffic Analysis Scoping Checklist* ............................................................... 5

2. **Chapter 2. Traffic Analysis Limits** ................................................................. 6
   2.1 *Spatial Boundary Limit* .................................................................................. 6
   2.2 *Temporal Boundary Limits* .......................................................................... 7

3. **Chapter 3. Analysis Tool Selection** .............................................................. 8
   3.1 *Traffic Analysis Tools* ................................................................................... 8
       3.1.1 Highway Capacity Manual (HCM)/Highway Capacity Software (HCS) ....... 8
       3.1.2 TransModeler ............................................................................................. 8
   3.2 *Which Tool is Appropriate?* .......................................................................... 8
   3.3 *Comparing Results.* ..................................................................................... 11

4. **Chapter 4. Data Collection** ......................................................................... 12
   4.1 *Field Observation* ......................................................................................... 12
   4.2 *Traffic Counts* ............................................................................................... 12
       4.2.1 Turning Movement Counts ......................................................................... 12
       4.2.2 Demand vs. Capacity .................................................................................. 13
       4.2.3 Mainline and Arterial Segment Counts ..................................................... 13
       4.2.4 Volume Balancing and Smoothing ............................................................. 14
       4.2.5 SDE Tool Count Collection ....................................................................... 14
   4.3 *Average Speed/Travel Time* ......................................................................... 14
   4.4 *Queue Lengths* ............................................................................................... 15
   4.5 *Existing Signal Timings* ................................................................................ 15
   4.6 *Free-Flow Speed* ........................................................................................... 16
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.7</td>
<td>Lane Utilization</td>
<td>.................</td>
<td>16</td>
</tr>
<tr>
<td>4.8</td>
<td>Data Needs Summary</td>
<td>..................................</td>
<td>18</td>
</tr>
<tr>
<td>5</td>
<td>Chapter 5. General Traffic Analysis</td>
<td>........................................</td>
<td>20</td>
</tr>
<tr>
<td>5.1</td>
<td>Grade</td>
<td>..................................</td>
<td>20</td>
</tr>
<tr>
<td>5.2</td>
<td>Peak Hour Factor</td>
<td>..................................</td>
<td>20</td>
</tr>
<tr>
<td>5.3</td>
<td>Saturation Flow Rate</td>
<td>..................................</td>
<td>21</td>
</tr>
<tr>
<td>5.4</td>
<td>Right Turn Treatments</td>
<td>..................................</td>
<td>22</td>
</tr>
<tr>
<td>5.5</td>
<td>Heavy Vehicle Percentages</td>
<td>..................................</td>
<td>22</td>
</tr>
<tr>
<td>5.6</td>
<td>Lane Utilization</td>
<td>..................................</td>
<td>22</td>
</tr>
<tr>
<td>5.7</td>
<td>Signal Timing</td>
<td>..................................</td>
<td>23</td>
</tr>
<tr>
<td>5.8</td>
<td>Calibration/Validation</td>
<td>..................................</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>Chapter 6. Highway Capacity Software (HCS) and the Highway Capacity Manual (HCM)</td>
<td>.......................................</td>
<td>27</td>
</tr>
<tr>
<td>6.1</td>
<td>HCS Quick Input Guides</td>
<td>..................................</td>
<td>27</td>
</tr>
<tr>
<td>6.2</td>
<td>HCS Applications</td>
<td>..................................</td>
<td>46</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Uninterrupted Flow Applications</td>
<td>..................................</td>
<td>46</td>
</tr>
<tr>
<td>6.2.1.1</td>
<td>Freeways</td>
<td>..................................</td>
<td>47</td>
</tr>
<tr>
<td>6.2.1.2</td>
<td>Multilane Highways</td>
<td>..................................</td>
<td>52</td>
</tr>
<tr>
<td>6.2.1.3</td>
<td>Two-Lane Highways</td>
<td>..................................</td>
<td>54</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Interrupted Flow Applications</td>
<td>..................................</td>
<td>56</td>
</tr>
<tr>
<td>6.2.2.1</td>
<td>Signalized Intersections and Urban Streets</td>
<td>..................................</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Traffic section</td>
<td>..................................</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>Phasing section</td>
<td>..................................</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Timing section</td>
<td>..................................</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>General section</td>
<td>..................................</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>Intersection section</td>
<td>..................................</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>Segment section</td>
<td>..................................</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Signals section</td>
<td>..................................</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Access Point and Access Points sections</td>
<td>..................................</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Optimization section</td>
<td>..................................</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Origin-Destination section</td>
<td>..................................</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Interchanges and Alternative Intersections section</td>
<td>..................................</td>
<td>70</td>
</tr>
<tr>
<td>6.2.2.2</td>
<td>Stop-Controlled Intersections</td>
<td>..................................</td>
<td>71</td>
</tr>
<tr>
<td>6.2.2.3</td>
<td>Roundabouts</td>
<td>..................................</td>
<td>75</td>
</tr>
<tr>
<td>6.3</td>
<td>When to Apply HCS Methods</td>
<td>..................................</td>
<td>77</td>
</tr>
<tr>
<td>6.3.1</td>
<td>Facilities vs. Points</td>
<td>..................................</td>
<td>77</td>
</tr>
<tr>
<td>6.3.2</td>
<td>Under-Saturation vs. Over-Saturation</td>
<td>..................................</td>
<td>78</td>
</tr>
<tr>
<td>6.3.3</td>
<td>HCS vs. TransModeler</td>
<td>..................................</td>
<td>79</td>
</tr>
<tr>
<td>6.4</td>
<td>Performance Measures</td>
<td>..................................</td>
<td>79</td>
</tr>
</tbody>
</table>
7 Chapter 7. Traffic Simulation with TransModeler ........................................ 93

6.5 Calibration ................................................................................................. 82
  6.5.1 Calibration of Uninterrupted Flow HCS Models .................................. 85
  6.5.2 Calibration of HCS Interrupted Flow Models ....................................... 85
  6.5.2.1 Signalized Intersections ................................................................... 86
  6.5.2.2 Stop Control Intersections ............................................................... 87
  6.5.2.3 Roundabouts .................................................................................. 89
  6.5.2.4 Interchange Ramp Terminals and Alternative Intersections .............. 89

6.6 Reporting/Output ...................................................................................... 90
  6.6.1 Performance Measures ......................................................................... 90
  6.6.2 Tables vs. Graphics ............................................................................. 90

7 Model Development .................................................................................... 93
  7.1 About this TransModeler Guidance .......................................................... 93
  7.1.1 About TransModeler SE ..................................................................... 93
  7.1.1.2 Simulation Project Setup Process ...................................................... 95
  7.1.2 File Organization .................................................................................. 96
  7.1.2.1 Organizing Project Files .................................................................. 96
  7.1.2.2 Defining Scenarios ......................................................................... 98
  7.1.2.3 Copying Projects ........................................................................... 99
  7.1.2.4 Archiving Projects ......................................................................... 100
  7.1.2.5 Summary of Project Settings ......................................................... 100
  7.1.3 Network Coding .................................................................................. 101
  7.1.3.1 Creating a New Network ................................................................ 102
     Coding from Scratch based on Satellite Imagery ....................................... 103
     Importing from Synchro ......................................................................... 104
     Importing from HCS ............................................................................. 104
     Exporting from Freely Available Statewide Simulation Databases ........... 105
  7.1.3.2 Geometrics ..................................................................................... 105
     Satellite Imagery and Google Earth ......................................................... 106
     Grade and Horizontal Curvature ............................................................... 108
     Elevation ................................................................................................. 110
     Intersections ........................................................................................... 110
     Pedestrians ............................................................................................. 112
     Roundabouts ........................................................................................... 112
     Freeways and Ramps ............................................................................. 113
  7.1.3.3 Lane Connectors ............................................................................. 116
  7.1.3.4 Centroids and Centroid Connectors ............................................... 117
  7.1.3.5 Checking a Network for Errors ....................................................... 118
  7.1.4 Traffic Control and Management .......................................................... 120
  7.1.4.1 Intersection Control ....................................................................... 120
     Traffic Signal Timing ................................................................................ 120
     Detection for Traffic-Actuated Signals .................................................... 122
     Stop or Yield Control ............................................................................. 123
  7.1.4.2 Traffic Signal Optimization .............................................................. 123
  7.1.4.3 Speed Limits ................................................................................... 125
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1.5</td>
<td>Road Classification</td>
<td>128</td>
</tr>
<tr>
<td>7.1.6</td>
<td>Naming Streets and Centroids</td>
<td>129</td>
</tr>
<tr>
<td>7.1.6.1</td>
<td>Naming Streets</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>Importance of Street Names on Freeways</td>
<td>130</td>
</tr>
<tr>
<td>7.1.6.2</td>
<td>Naming Centroids</td>
<td>130</td>
</tr>
<tr>
<td>7.1.7</td>
<td>Superlinks</td>
<td>131</td>
</tr>
<tr>
<td></td>
<td>Superlink Example 1: Channelized Right Turn Lanes</td>
<td>132</td>
</tr>
<tr>
<td></td>
<td>Superlink Example 2: Roundabouts with Splitter Islands</td>
<td>133</td>
</tr>
<tr>
<td></td>
<td>Superlink Example 3: Nodes in the Middle of Superlinks</td>
<td>134</td>
</tr>
<tr>
<td>7.1.8</td>
<td>Selection Sets</td>
<td>134</td>
</tr>
<tr>
<td>7.1.8.1</td>
<td>Creating Selection Sets</td>
<td>135</td>
</tr>
<tr>
<td>7.1.8.2</td>
<td>Common Uses for Selection Sets</td>
<td>135</td>
</tr>
<tr>
<td>7.1.8.3</td>
<td>Navigating to Features in a Selection Set</td>
<td>135</td>
</tr>
<tr>
<td>7.1.9</td>
<td>Dataviews and Supplementary Model Data</td>
<td>135</td>
</tr>
<tr>
<td>7.2</td>
<td>Demand Input Development</td>
<td>136</td>
</tr>
<tr>
<td>7.2.1</td>
<td>Type I Projects: Demand as Turning Volumes</td>
<td>137</td>
</tr>
<tr>
<td>7.2.1.1</td>
<td>Demand as Turning Volumes: Drawbacks</td>
<td>137</td>
</tr>
<tr>
<td>7.2.1.2</td>
<td>Entering Turning Volumes</td>
<td>139</td>
</tr>
<tr>
<td>7.2.1.3</td>
<td>Checking a Turning Movement Table for Errors</td>
<td>140</td>
</tr>
<tr>
<td>7.2.1.4</td>
<td>Managing Unbalanced Turning Volumes</td>
<td>140</td>
</tr>
<tr>
<td>7.2.1.5</td>
<td>Managing Oversaturated Conditions when Demand is Defined by Turning Volumes</td>
<td>142</td>
</tr>
<tr>
<td>7.2.1.6</td>
<td>Managing U-turns at Interchanges and Similar Scenarios</td>
<td>142</td>
</tr>
<tr>
<td>7.2.1.7</td>
<td>Using Turning Volumes to Define Demand</td>
<td>143</td>
</tr>
<tr>
<td>7.2.1.8</td>
<td>O-D Matrices as an Alternative to Turning Volumes</td>
<td>144</td>
</tr>
<tr>
<td>7.2.2</td>
<td>Type II and Type III Projects: Demand as O-D Matrices</td>
<td>144</td>
</tr>
<tr>
<td>7.2.2.1</td>
<td>Demand as O-D Matrices: Advantages and Disadvantages (Type II, Type III)</td>
<td>145</td>
</tr>
<tr>
<td>7.2.2.2</td>
<td>Sources of O-D Volumes or Patterns (Type II, Type III)</td>
<td>145</td>
</tr>
<tr>
<td>7.2.2.3</td>
<td>Editing Volumes in O-D Matrices (Type II, Type III)</td>
<td>146</td>
</tr>
<tr>
<td>7.2.2.4</td>
<td>Using O-D Matrices Estimated with the SDE (Type III)</td>
<td>147</td>
</tr>
<tr>
<td>7.2.2.5</td>
<td>Peak Hour Factors with O-D Matrices (Type I, Type II, Type III)</td>
<td>148</td>
</tr>
<tr>
<td>7.2.2.6</td>
<td>Traffic Analysis Zone Connectivity (Type III)</td>
<td>150</td>
</tr>
<tr>
<td>7.2.3</td>
<td>Specifying the Vehicle Fleet Mix</td>
<td>151</td>
</tr>
<tr>
<td>7.2.3.1</td>
<td>Varying Vehicle Fleet Mix by Origin and Destination</td>
<td>151</td>
</tr>
<tr>
<td>7.2.3.2</td>
<td>Varying Vehicle Fleet Mix by Origin with Local Loading Parameters</td>
<td>152</td>
</tr>
<tr>
<td>7.2.4</td>
<td>Boundary Conditions</td>
<td>153</td>
</tr>
<tr>
<td>7.2.4.1</td>
<td>Geographic Boundary Conditions: Scoping the Study Area</td>
<td>153</td>
</tr>
<tr>
<td>7.2.4.2</td>
<td>Temporal Boundary Conditions: Scoping the Analysis Period</td>
<td>154</td>
</tr>
<tr>
<td>7.3</td>
<td>Calibration and Validation</td>
<td>155</td>
</tr>
<tr>
<td>7.3.1</td>
<td>Familiarize with Existing Conditions</td>
<td>157</td>
</tr>
<tr>
<td>7.3.2</td>
<td>Visually Audit the Model</td>
<td>158</td>
</tr>
<tr>
<td>7.3.2.1</td>
<td>What to Watch For</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Bottleneck Formation</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Vehicles Queued Outside the Network</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Vehicles Missing Turning Movements</td>
<td>159</td>
</tr>
<tr>
<td></td>
<td>High Control Delays</td>
<td>159</td>
</tr>
</tbody>
</table>
Unbalanced Lane Utilization or Bottlenecks at Lane Drops

7.3.3 Check Count Data for Consistency .................................................. 160
7.3.3.1 Analyzing data from multiple days .................................................. 162
7.3.4 Calculate Goodness of Fit ................................................................. 162
7.3.4.1 Calibration: How to Compare Segment and Turning Volumes to Counts .................................................. 162
7.3.4.2 Validation: How to Produce Simulated Travel Time Outputs ............ 165
7.3.4.3 Calibration Parameters by Facility Type ............................................. 166
7.3.5 Addressing Problems in Visual Audit or Goodness of Fit .................... 167
7.3.5.1 Revisit and Review the Demand ....................................................... 167
7.3.5.2 Driver Behavior Parameters You May Consider Adjusting ............... 167
7.3.6 Conduct Sensitivity Testing ............................................................... 169
7.3.7 Validate the Model ........................................................................ 169

7.4 Output and Performance Measures .................................................... 170
7.4.1 Preparing to Collect Output .............................................................. 170
7.4.1.1 Selection Sets for Output Reporting ................................................. 170
7.4.1.2 Superlinks for Output Reporting ..................................................... 171
7.4.1.3 Choosing Which Output to Collect .................................................. 171
7.4.1.4 Fixing Random Seeds - What You Should Know ............................ 172
7.4.2 System Performance Measures ....................................................... 173
7.4.2.1 System Performance from Trip Statistics ...................................... 173
7.4.2.2 System Performance from Segment Statistics ............................... 174
7.4.3 Travel Time Performance Measures ................................................. 174
7.4.3.1 Origin-Destination Travel Times by Trip ....................................... 174
7.4.3.2 End-to-End Travel Times by Corridor ........................................... 175
7.4.4 Queue Length Performance Measures ............................................. 176
7.4.5 Level of Service Performance Measures ......................................... 177
7.4.5.1 Intersections and Roundabouts ...................................................... 177
7.4.5.2 Interchanges ................................................................................ 179
7.4.5.3 Freeways ..................................................................................... 180
7.4.5.4 Urban Streets .............................................................................. 183
7.4.6 Presentation Requirements .............................................................. 184
7.4.6.1 Customizing Reports and Report Layout .................................... 184
7.4.6.2 Graphical Representation of Performance Measures ..................... 185
Maps ..................................................................................................... 185
Heat Charts ......................................................................................... 186
7.4.6.3 Project Submittal Requirements .................................................... 188

7.5 Appendix ......................................................................................... 188
7.5.1 Factors to Consider During Scoping ............................................... 188
What does the ODME approach entail specifically? .................................. 189
Are operations of adjacent facilities in the study area a significant concern? ... 189
Are there five or more intersections or four or more interchanges? ............. 189
Are O-D volumes available or trivially derived from TMCS? ...................... 190

8 Chapter 8. Presentation of Results ....................................................... 191
8.1 Presentation of Results ..................................................................... 191
## Table of Contents

8.1.1 Tabular Summaries ................................................................. 191  
8.1.2 Graphical Presentation ......................................................... 195  
8.1.3 Animation .......................................................................... 196  

9 Chapter 9. Documentation ................................................................. 201  
  9.1 Analysis Documentation .......................................................... 201  
    9.1.1 Project Specific Data .......................................................... 201  
    9.1.2 Base Model Development .................................................. 201  
    9.1.3 Base Model Calibration and Validation ................................. 201  
    9.1.4 Error Checking ................................................................. 201  
    9.1.5 Alternatives Model Development ...................................... 201  
  9.2 Reviewers Checklist ................................................................. 202
# List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1</td>
<td>Tool Selection Flow Chart</td>
<td>9</td>
</tr>
<tr>
<td>3-2</td>
<td>TransModeler Weave Analysis</td>
<td>11</td>
</tr>
<tr>
<td>4-1</td>
<td>Adjustment of Turning Movement Counts to Demand Volumes</td>
<td>13</td>
</tr>
<tr>
<td>6-1</td>
<td>Highway Capacity Software (HCS) Opening Window (source: McTrans)</td>
<td>46</td>
</tr>
<tr>
<td>6-2</td>
<td>HCS Freeways Analysis Selection Menu (source: McTrans)</td>
<td>47</td>
</tr>
<tr>
<td>6-3</td>
<td>Influence Areas of Merge, Diverge and Weaving Segments (source: HCM 6th Ed., Ex. 10-1)</td>
<td>48</td>
</tr>
<tr>
<td>6-4</td>
<td>Freeway Facilities Example File Showing Weaving, Merge, Diverge and Overlap Segments (source: McTrans)</td>
<td>49</td>
</tr>
<tr>
<td>6-5</td>
<td>HCS Freeway Facilities General Input Window (source: McTrans)</td>
<td>50</td>
</tr>
<tr>
<td>6-6</td>
<td>HCS Freeway Facilities Segments Input Window (source: McTrans)</td>
<td>51</td>
</tr>
<tr>
<td>6-7</td>
<td>HCS Freeway Facilities Segment Data Window (source: McTrans)</td>
<td>52</td>
</tr>
<tr>
<td>6-8</td>
<td>HCS Multilane Highway Input Window (source: McTrans)</td>
<td>53</td>
</tr>
<tr>
<td>6-9</td>
<td>HCS Two-Lane Segments Window (source: McTrans)</td>
<td>55</td>
</tr>
<tr>
<td>6-10</td>
<td>HCS Two-Lane Highways Details Window (source: McTrans)</td>
<td>56</td>
</tr>
<tr>
<td>6-11</td>
<td>HCS Streets Module Quick Start Dialog Box (source: McTrans)</td>
<td>58</td>
</tr>
<tr>
<td>6-12</td>
<td>Base Saturation Flow Rate by Lane Group in HCS Streets (source: McTrans)</td>
<td>59</td>
</tr>
<tr>
<td>6-13</td>
<td>Intersection Traffic Movements and Numbering Scheme</td>
<td>62</td>
</tr>
<tr>
<td>6-14</td>
<td>Dual-Ring Structure with Movement Assignments</td>
<td>63</td>
</tr>
<tr>
<td>6-15</td>
<td>HCS Signal Phasing (source: McTrans)</td>
<td>63</td>
</tr>
<tr>
<td>6-16</td>
<td>Signalized Intersection Phasing Wizard Tool (source: McTrans)</td>
<td>64</td>
</tr>
<tr>
<td>6-17</td>
<td>Phase Duration Diagram (source: McTrans)</td>
<td>65</td>
</tr>
<tr>
<td>6-18</td>
<td>HCS Signal Timing Settings (source: McTrans)</td>
<td>66</td>
</tr>
<tr>
<td>6-19</td>
<td>HCS Full Optimization Screen (source: McTrans)</td>
<td>68</td>
</tr>
<tr>
<td>6-20</td>
<td>AWSC Lanes Window (source: McTrans)</td>
<td>72</td>
</tr>
<tr>
<td>6-21</td>
<td>TWSC General Window (source: McTrans)</td>
<td>73</td>
</tr>
<tr>
<td>6-22</td>
<td>TWSC Lanes Window (McTrans)</td>
<td>74</td>
</tr>
<tr>
<td>6-23</td>
<td>TWSC Traffic Window (source: McTrans)</td>
<td>75</td>
</tr>
<tr>
<td>6-24</td>
<td>Roundabout Geometry Window (source: McTrans)</td>
<td>76</td>
</tr>
<tr>
<td>6-25</td>
<td>Roundabout Traffic Window (source: McTrans)</td>
<td>77</td>
</tr>
<tr>
<td>6-26</td>
<td>Facilities and Points defined by the HCM</td>
<td>78</td>
</tr>
<tr>
<td>6-27</td>
<td>HCM Signalized Intersection LOS Scale</td>
<td>80</td>
</tr>
<tr>
<td>6-28</td>
<td>Comparison of Urban Street LOS Scales – HCM 2010 vs. HCM 6th Edition</td>
<td>82</td>
</tr>
<tr>
<td>6-29</td>
<td>HCS Critical Headway and Follow-Up Headway Window (source: McTrans)</td>
<td>89</td>
</tr>
<tr>
<td>6-30</td>
<td>HCS Freeway Facilities Example Problem Density Distribution (source: McTrans)</td>
<td>91</td>
</tr>
<tr>
<td>6-31</td>
<td>HCS Freeway Facilities Example Problem Heat Map (source: McTrans)</td>
<td>91</td>
</tr>
<tr>
<td>6-32</td>
<td>HCS Freeway Facilities Example Problem Geometry Themed Schematic Diagram (source: McTrans)</td>
<td>92</td>
</tr>
<tr>
<td>6-33</td>
<td>HCS Signalized Intersection Analysis Graphical Summary (source: McTrans)</td>
<td>92</td>
</tr>
<tr>
<td>7-1</td>
<td>Introduction to the TransModeler SE Interface</td>
<td>95</td>
</tr>
<tr>
<td>7-2</td>
<td>Simulation Project Setup Process in TransModeler SE</td>
<td>96</td>
</tr>
<tr>
<td>7-3</td>
<td>Project File Organization Schematic</td>
<td>97</td>
</tr>
<tr>
<td>7-4</td>
<td>Folders for Scenario-Specific Outputs</td>
<td>98</td>
</tr>
<tr>
<td>7-5</td>
<td>Project Copy Summary of Files in Project Settings</td>
<td>99</td>
</tr>
<tr>
<td>7-6</td>
<td>The Create-a-Map Wizard for Creating New Networks</td>
<td>103</td>
</tr>
</tbody>
</table>
Table of Contents

Figure 7-7. Importing a Network, Signal Timings, and Turning Volumes from Synchro ............................................. 104
Figure 7-8. Adding New Links .......................................................................................................................................... 107
Figure 7-9. Road Editing Based on Engineering Judgement ................................................................................................ 108
Figure 7-10. Splitting Segments for Accurate Curvature .................................................................................................... 109
Figure 7-11. Editing Segment Elevation ............................................................................................................................... 110
Figure 7-12. Links on Approaches without Stop Bars ......................................................................................................... 111
Figure 7-13. Approaches with Staggered Stop Bars ................................................................................................................ 112
Figure 7-14. Roundabout Stop Bar Positioning ...................................................................................................................... 113
Figure 7-15. Freeways as Separate One-Way Links ................................................................................................................ 114
Figure 7-16. Freeway Merge and Diverge Segment Configurations ........................................................................................... 115
Figure 7-17. Lane Connectors Representing Permitted Movements Inside a Median U-Turn Intersection .................................................. 116
Figure 7-18. Lane Connectors at a Segment Joint .................................................................................................................. 117
Figure 7-19. Centroids Representing Specific Land Uses and Traffic Analysis Zones .............................................................. 118
Figure 7-20. Error-Checking with Selection Sets ................................................................................................................... 119
Figure 7-21. Defining a New Signal Timing Plan with the Intersection Control Editor ............................................................... 121
Figure 7-22. Specifying Phasing and Timing in the Intersection Control Editor ................................................................. 121
Figure 7-23. Specifying Ring-and-Barrier Design in the Intersection Control Editor ............................................................. 122
Figure 7-24. Phase Detector Default Settings ...................................................................................................................... 123
Figure 7-25. Corridor Signal Optimization Window .............................................................................................................. 124
Figure 7-26. Performance Index (PI) for Corridor Optimization ................................................................................................. 125
Figure 7-27. Application of Speed Limit Signs in a School Zone ............................................................................................ 127
Figure 7-28. Example Road Classes at a Roundabout ........................................................................................................ 128
Figure 7-29. Info Dataview for a Link ....................................................................................................................................... 129
Figure 7-30. Naming Multiple Streets with a Selection Set .................................................................................................... 130
Figure 7-31. An O-D Matrix Labeled with Centroid Descriptions ............................................................................................. 131
Figure 7-32. Superlink Example ................................................................................................................................................ 131
Figure 7-33. Superlinks at a Channelized Right Turn Lane .................................................................................................... 132
Figure 7-34. Superlinks at Roundabouts with Splitter Islands ................................................................................................ 133
Figure 7-35. Superlinks at Closely-Spaced Signalized Intersections ......................................................................................... 134
Figure 7-36. Example of a Turn Prohibition .......................................................................................................................... 143
Figure 7-37. Single-Period Movement Table Settings Example .............................................................................................. 144
Figure 7-38. Turning Volume Adjustments Needed to Evaluate an MUT .................................................................................. 148
Figure 7-39. Example of O-D Matrix Curve ............................................................................................................................ 149
Figure 7-40. Example of a Curve-Based Multi-Period O-D Matrix .......................................................................................... 155
Figure 7-41. Fundamental Diagram of Traffic and Speed-Flow Curve .................................................................................... 156
Figure 7-42. A General Calibration and Validation Process ................................................................................................ 157
Figure 7-43. Reporting of Numbers of Queued Trips Outside the Network in TransModeler ........................................................ 159
Figure 7-44. Spot Checking for Consistency Between Counts ................................................................................................. 162
Figure 7-45. Mapped Field Counts and Simulated Segment Volumes Example ........................................................................ 164
Figure 7-46. Mapped Field Counts and Simulated Turning Movement Volumes Example ......................................................... 164
Figure 7-47. Origin-Destination Travel Times in a Trip Statistics O-D Matrix ............................................................................ 175
Figure 7-48. Example of Upstream Queue Spillback in Multiple Direction ................................................................................ 177
Figure 7-49. Intersection LOS Report Labeled by Street Names ............................................................................................... 178
Figure 7-50. Components of Simulation-Based Delay ............................................................................................................ 179
Figure 7-51. Example of a Selection Set for Interchange LOS .................................................................................................. 180
Figure 7-52. Freeway Density Measurement Boundaries ....................................................................................................... 181
Figure 7-53. Example of Freeway Segments for HCM Analyses ............................................................................................... 182
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-54</td>
<td>Freeway LOS Report, Organized by Street Name and Segment Type</td>
<td>183</td>
</tr>
<tr>
<td>7-55</td>
<td>Selection Sets for Urban Street LOS Reporting</td>
<td>184</td>
</tr>
<tr>
<td>7-56</td>
<td>Example of a Network Map for Reporting MOE’s</td>
<td>186</td>
</tr>
<tr>
<td>7-57</td>
<td>Heat Chart displaying Freeway Density over Time</td>
<td>187</td>
</tr>
<tr>
<td>8-1</td>
<td>Example Operational Results 1</td>
<td>197</td>
</tr>
<tr>
<td>8-2</td>
<td>Example Operational Results 2</td>
<td>198</td>
</tr>
<tr>
<td>8-3</td>
<td>Example Geometric Data 1</td>
<td>199</td>
</tr>
<tr>
<td>8-4</td>
<td>Example Geometric Data 2</td>
<td>200</td>
</tr>
</tbody>
</table>
List of Tables

Table 4-1. Data Needs Summary ........................................................................................................ 18
Table 5-1. Default Base Saturation Flow Rates .................................................................................. 21
Table 5-2. Calibration and Targets .................................................................................................... 26
Table 6-1. Performance Measures ...................................................................................................... 81
Table 6-2. HCS Calibration Parameters .............................................................................................. 84
Table 7-1. Description of Inputs ........................................................................................................ 98
Table 7-2. Summary of Actions in Project Settings .......................................................................... 101
Table 7-3. Road Editing Tools in TransModeler ................................................................................... 102
Table 7-4. Project Types and Corresponding Demand Specification .................................................... 137
Table 7-5. Drawbacks of Turning Volumes as Demand Input for Simulation ..................................... 138
Table 7-6. Tools for Managing Turning Volumes in TransModeler ..................................................... 139
Table 7-7. Causes and Treatments for Unbalanced Turning Volumes .................................................. 141
Table 7-8. O-D Matrix Curve Data for Various PHF .......................................................................... 150
Table 7-9. Traffic Analysis Zone Connectivity for O-D Matrix Development .................................... 151
Table 7-10. Steps to Adjust Demand Inputs for the Warmup Period ................................................... 154
Table 7-11. Recommended TransModeler Calibration Parameters .................................................... 166
Table 7-12. Summary of Potential Driver Behavior Parameter Adjustments ..................................... 169
Table 7-13. Output Groups ................................................................................................................ 172
Table 7-14. Tools for Creating Output Reports in TransModeler ....................................................... 185
Table 8-1. Sample Intersection Traffic Analysis Results Table ............................................................ 192
Table 8-2. Sample Alternatives Comparison Table ............................................................................. 193
Table 8-3. Sample Freeway Facility Operational Results .................................................................. 194
Chapter 1. Traffic Analysis Scoping

The scoping process is an important first step for any project involving traffic analysis. The traffic analysis scope will document assumptions and methodologies for each project and provide the base for the entire analysis project, as well as the corresponding man hour estimate from the consultant. The traffic analysis scope should be prepared by the ODOT District project manager. The traffic analysis scope should be reviewed and approved by the Office of Roadway Engineering (ORE) for projects that will involve ORE. These projects include:

- Interchange Studies (IJS/IMS/IOS)
- Feasibility Studies involving interchanges
- Alternatives Evaluation Reports involving interchanges

A properly prepared scope provides the base for the entire analysis process by identifying the issues to be solved, data requirements, performance measures, schedule, and analysis deliverables. The content of the analysis methodology should be tailored to the context and complexity of the project. The elements discussed in this chapter can also be used by project managers to prepare the scope of traffic analysis. The reviewers of the traffic analysis report may use the scope development process as an opportunity to raise critical issues and concerns, so they can be resolved and incorporated in the analysis early in the study process.

It is critical that the scoping checklist form be completed in advance of the Early Coordination Meeting with Modeling and Forecasting.

1.1 Scoping Elements

The scoping of the traffic analysis effort should address the following elements:

- Traffic analysis type
- Project description
- Traffic analysis objective
- Analysis boundary limits
- Study periods and analysis years
- Traffic analysis tool selection
- Data requirements and data collection plan
- Project traffic forecasting
- Project alternatives
- Performance measures of effectiveness (MOEs)
- Analysis report and documentation

1.1.1 Traffic Analysis Type

Traffic analysis for projects will be one of two types, Standard Type and Complex Type. These types are defined as:

**Standard Type** - This will be the type of analysis used on the majority of projects. Data inputs for these types of projects will typically use default values or other easily obtainable real-world data and have minimal calibration and validation. Standard Type projects will
include nearly all analysis conducted primarily in Highway Capacity Software (HCS) and most TransModeler analysis for small networks.

**Complex Type** - This type of analysis will be more involved than the Standard Type. It will include the analysis of existing conditions as well as the calibration and validation of the existing analysis to match real life conditions including average speeds, travel times, and queue lengths. Complex Type analysis will be more labor intensive for both data collection needs as well as traffic analysis. Complex Type projects will typically be large freeway corridor studies containing multiple interchanges and other potential high-risk projects.

Elements and requirements described throughout this manual will apply to both Standard Type and Complex Type analysis. Any elements or requirements that are different depending on analysis type will be identified.

1.1.2 Project Description

The project description is used to introduce the project. It includes general context and background information. Both vicinity map and project location map are included in the project description.

1.1.3 Traffic Analysis Objective

Traffic analysis objective(s) should clearly identify the following:

- The performance problem or goal which the analysis seeks to answer.
- The intended use and decision-makers of the traffic analysis results.

An example objective could be: “This analysis seeks to identify the causes of the safety and congestion concerns along I-670 between I-71 and I-270. The results of the analysis will be used to determine and justify a solution at this location.”

1.1.4 Analysis Boundary Limits

The analysis boundary limits should include all locations that could be affected by a proposed improvement (i.e., an adjacent signalized intersection if the study intersection is proposed to be converted to only provide right-in/right-out access). While arguably, several intersections could be impacted by an improvement at one location, the boundaries should be logically drawn at the locations with the most impact to traffic flows and/or the closest proximity to the study location.

The analysis boundary limits for common types of studies are described below:

- Interchange Justification Studies (IJS) / Interchange Modification Studies (IMS) / Interchange Operations Studies (IOS) - IJS/IMS/IOS analysis limits can be found in the ODOT Traffic Academy course material for Interchange Studies (found [here](#)).
- Corridor Studies not involving an interchange - these studies will typically include the study intersections along the corridor plus the first adjacent signalized intersection on either side of the study intersections.
Furthermore, model limits should be extended so that all entry links operate in under-saturated conditions. If it is impractical that the study limits be expanded so the network is free of queueing that extends beyond study limits, TransModeler should be used for the analysis.

The scoping document should include a scaled map showing all study interchanges and intersections.

For more information regarding analysis limits, please refer to Chapter 2.

1.1.5 Study Periods and Analysis Years

The scoping document should clearly define the study periods and analysis years included in the study. Typically, the weekday AM and PM peak periods are being analyzed. For locations with specific traffic generators, weekend, school arrival/release, and/or off-peak periods may be analyzed. The justification for using analysis periods other than the weekday AM and PM peaks should be clearly identified in the scoping document.

The design year (typically 20 years after the opening year) should be analyzed on most projects. Depending on the project type, the analysis could include existing conditions and/or additional interim design years. These additional analysis years need to be clearly identified in the scoping document. Instances when an interim year may be included are:

- Traffic Impact Studies where the analysis typically includes the opening year and a 10-year design year.
- Corridor and Feasibility Studies where the existing conditions are useful for determining the Purpose and Need of the project and gaining Stakeholder/Public buy-in for the analysis.
- Ramp Clear projects that are trying to address existing congestion with simple, low-cost countermeasures and as concerned with design years.
- Safety Studies that typically focus just on the existing traffic volumes.
- Sensitivity analysis where the analyst is trying to determine what year different improvements will be needed.
- Phased solutions where only part of the improvement is being constructed initially. For this situation it may be desirable to know how the initial improvement will operate in an interim year. For example, 10 years after construction.
- Locations where the design year will operate at LOS F and you want to compare how alternatives will work for an interim year, so that all alternatives are not LOS F.
- Complex Type projects which will require the calibration and validation of the existing conditions.

1.1.6 Traffic Analysis Tool Selection

For ODOT projects, two analysis tools are available - Highway Capacity Software (HCS) and TransModeler. HCS is a deterministic (equation-based) tool that implements the methodologies in the Highway Capacity Manual (HCM). TransModeler is a microsimulation tool that can model most roadway and intersection types. As a stochastic tool, TransModeler employs randomness in the computational methods to model real world traffic conditions.

It is the requirement of ODOT to use HCS for all analyses when possible. TransModeler may be required to evaluate heavily congested conditions, complex geometric configurations (i.e., complex weaves), and system-level impacts of the improvements that are beyond the limitations of HCS.
With approval from ODOT, additional analysis tools may be used on a project-by-project basis. These include the *Synchro/SimTraffic* software package and *Sidra*. ODOT guidance on the use of *Synchro/SimTraffic* can be found in Figures 401-14a and 401-14c of the *Location and Design Manual (L&D), Volume 1*. ODOT guidance on the use of *Sidra* can be found in Section 401.2.3 and Figure 401-14b of the *L&D, Volume 1*. While the OATS Manual is written specifically for the use of HCS and TransModeler, many of the HCS elements in this manual are applicable to *Synchro* and *Sidra* analysis. Likewise, many of the TransModeler elements in the OATS Manual are applicable to *SimTraffic* analysis. The analyst should apply these elements whenever possible.

The tool selection and reasoning shall be justified and stated clearly in the scoping document. For more information regarding analysis tool selection, please refer to Chapter 3.

1.1.7 Data Requirements and Data Collection Plan

Data is crucial for accurate analyses. In addition to using it for critical analysis inputs, data is used for calibration and validation to ensure accurate analysis. Chapter 4 details the data needs as well as the collection methods to be used when obtaining the data. Some data can be obtained from existing sources while other information will require field measurements. On the scoping form, the data collection needs and locations shall be explicitly stated.

1.1.8 Project Traffic Forecasting

The analysis scoping document should include the demand forecasting procedure for future year analysis. Future years include opening, design, and any interim years as defined by the analysis period. Traffic forecasts used in HCS are typically turning movements. However, TransModeler can use turning movements or origin and destination (O-D) tables. O-D tables may be especially beneficial when new connections are constructed or when route choices may be altered because of the improvement being analyzed.

For ODOT projects, there are four primary ways to develop traffic forecasts:

- **Certified Traffic** - Traffic forecasts are developed in accordance with the methodologies outlined in ODOT’s *Ohio Traffic Forecasting Manual*. The Office of Statewide Planning, Modeling and Forecasting (M&F) will either complete or review and approve these forecasts.
- **Simplified Highway Forecasting Tool (SHIFT)** - Growth rates for State roadways using historic trend line analysis and travel demand Model of Record. SHIFT growth rates can be obtained from District Certified Traffic Coordinator.
- **Simulation Demand Estimator (SDE) Tool** - When using the SDE Tool, analysts should coordinate with ODOT Modeling and Forecasting as early as possible in the project. SDE will typically only be used for very large corridor studies where the diversion of traffic to alternate routes are anticipated.
- **Planning level forecasts** - Planning level forecasts should be developed per ODOT’s *Ohio Traffic Forecasting Manual, Volume 3*.

1.1.9 Project Alternatives

The project alternatives should be detailed in the scoping process. It is the requirement of ODOT to perform design year No-Build conditions analyses of the roadway network for all projects. The No-Build analysis is used as a baseline to compare Build alternatives. The No-Build condition should
include not only existing projects under development, but also committed improvements with programmed funding expected to be completed by the design year.

For Complex Type projects, the Existing conditions analysis is required and will be used for calibration and validation of the analysis.

While the specific configurations being analyzed as Build conditions may not be known at the time of scoping, the number of alternatives being analyzed should be identified in the scoping document.

1.1.10 Performance Measures of Effectiveness (MOEs)

Numerical outputs from the traffic analysis are the measures of effectiveness (MOEs) which are metrics used to assess the performance of an isolated location or system. MOEs are also used to compare the performance under various design or improvement alternates.

Level-of-Service (LOS) is a readily recognizable indicator of traffic operations and has been widely used by different agencies when evaluating the traffic operations performance of facilities. However, LOS alone does not necessarily give insight about the overall performance of the facility. Thus, additional quantifiable measures should be included in the analysis to better assess the performance of the location or network being analyzed.

At a minimum, the outputs of LOS, delay or density, 95th percentile queue lengths, volume-to-capacity (v/c) ratios, and queue-storage ratios (QSR) should be reported for all analyses.

Additional MOEs can be reported based on the project being analyzed. Analysts should work with the ODOT project manager during the scoping process to determine if additional MOEs are required. Such MOEs could include average speed for the corridor or study area, travel times, vehicle-hours delay, and density for the facility.

Additional guidance on the MOEs are provided in Chapter 8.

1.1.11 Analysis Report and Documentation

Documentation requirements for a traffic analysis should be established as part of the traffic analysis scoping. The scope of the traffic analysis should describe how the results will be presented to the intended audience such as policy makers and the public. Documentation is also necessary to enable a reviewer to independently confirm analysis assumptions, analysis methodology, input data, outputs, and if necessary, reproduce the same results presented by the analyst. The documentation necessary to support traffic analysis should be proportional to the size of the project and complexity of the analysis. Specific documentation requirements for traffic operational analyses are provided in Chapter 9.

1.2 Traffic Analysis Scoping Checklist

A traffic analysis scoping checklist must be completed for each project. This checklist found here is a guidance that should be used by the analyst when preparing the scoping documents and fee estimates.
Chapter 2. Traffic Analysis Limits

This chapter provides guidance on establishing traffic analysis limits.

2.1 Spatial Boundary Limit

The analysis boundary depends on the operational influence area of the surrounding traffic network. The influence area is the project area (the roadway network that is being improved) plus the surrounding traffic network that has an impact on the operations in the project area. This area could range from one intersection from the end of the project to over two miles outside the project. Proper identification of the influence area increases the level of accuracy of the traffic analysis in replicating real world traffic characteristics. The analyst should initially conduct a field inspection to determine the extent of any existing congestion and identify any hidden bottlenecks. Hidden bottlenecks are formed when the existing demand at a segment or point is constrained by upstream bottlenecks. In such conditions, correction of the upstream bottleneck by the improvement would normally shift the bottleneck to a downstream capacity constrained location.

The minimum study boundary for analyses performed in urban areas are stated in the SHAMM for traffic impact studies and the Traffic Academy training material for interchange studies (IJS/IMS/IOS). Analysis boundaries for corridor studies that do not include an interchange will include at least the first adjacent signalized intersection on either side of the study intersections.

There are several instances in which the spatial boundary expands past the minimum limits:

- Bottlenecks that affect traffic flows into or out of the study area. To the extent possible, the analysis boundary should be free of congestion. Bottlenecks outside the minimum analysis limits should be included to determine the impacts within the study area when the bottleneck is removed.
- Queues at study intersections that extend past the minimum limits. Similar to bottlenecks, the analysis area should encompass the queueing to determine the impacts when the queueing is alleviated.
- Major system/service interchanges just outside the minimum boundary limits. These large interchanges could affect the lane changing behavior in the study area and should be included in the model limits.
- Existing undersaturated condition that could become oversaturated by the design year. Expansion of the analysis boundary should be considered to ensure the model limits will be undersaturated in the design year.
- Adjacent intersections (because of being part of a coordinated system) may affect the formation of vehicle platoons along the arterial. If the project is within an arterial with signal coordinated system, the analysis boundary should be extended, to the extent possible, to include the effect of coordinated signals.

If it is impractical to extend the analysis limits to an area free from congestion, microsimulation with TransModeler should be used to complete the analysis.
It is critical that the analysis limits be consistent across all alternatives (Existing, No-Build, Build) so that system metrics such as vehicle-hours travel, vehicle-hours delay, travel time, etc. can be compared.

2.2 Temporal Boundary Limits

Temporal boundary limit is the duration of the traffic analysis period. The duration of the model should allow for the build-up of congestion and the dissipation of congestion and depends on if the project area has undersaturated or oversaturated conditions.

Per the *Highway Capacity Manual, 6th Edition* (HCM), traffic flow during an analysis period (e.g., 15 minutes) is specified as being undersaturated when the following conditions are satisfied: (a) the arrival flow rate is lower than the capacity of a point or segment (i.e., drivers can choose their desired speed), (b) no residual queue remains from a prior breakdown of the facility, and (c) traffic flow is unaffected by downstream conditions. For uninterrupted-flow facilities, travel speeds are usually within 10% to 20% of the facility’s free-flow speed. On interrupted-flow facilities, queues form as a natural consequence of the interruptions to traffic flow at intersections. Therefore, travel speeds on undersaturated interrupted-flow facilities are typically 30% to 65% below the free-flow speed of the facility. At intersections, if all the demand on an approach is served within a 15-minute analysis period, including any residual demand from the previous period, the approach is considered to be undersaturated.

Similarly, traffic flow during an analysis period (e.g., 15 minutes) is characterized as being oversaturated when any of the following conditions are satisfied: (a) the arrival flow rate exceeds the capacity of the facility, (b) a queue created from a prior breakdown of the facility has not yet dissipated, or (c) traffic flow is affected by downstream conditions. On uninterrupted-flow facilities, oversaturated conditions result from a bottleneck on the facility. During periods of oversaturation, queues form and extend upstream while traffic speeds and flows drop significantly because of the turbulence. Even after the demand at the back of queue drops, some time is required for the queue to dissipate because vehicles discharge from the queue at a slower rate than they do under free-flow conditions. On interrupted-flow facilities, oversaturated conditions generate a queue that grows faster than can be processed at an intersection over the analysis period.

For locations where traffic flow is oversaturated, a single 15-minute traffic analysis period is typically not sufficient to quantify the total delay and queue length on the corridor. A multi-period analysis would be used to capture the effect of demand that is not served by the facility from one 15-minute interval to the next. The multi-period analysis should account for the residual queues (unmet demand) from one period by using them as the initial queue in the subsequent period. It is important to note that in this type of analysis, the first and last periods of the multi-period analysis should be undersaturated.

While ODOT recognizes the potential benefits of multi-period analysis, our requirement is that all traffic analysis be conducted as a single analysis period. The use of multi-period analysis may be required in a future update to this manual.
Chapter 3. Analysis Tool Selection

ODOT has adopted the use of HCS and TransModeler software to perform capacity analyses on ODOT projects. Each tool provides different benefits to the analyst. To obtain cost-effective, yet reasonable analysis results at a desired level of confidence, guidance for selecting the proper analysis tool is provided in this chapter.

3.1 Traffic Analysis Tools

3.1.1 Highway Capacity Manual (HCM)/Highway Capacity Software (HCS)

The *Highway Capacity Manual* (HCM) is the most widely used document in the transportation industry that contains a set of methodologies and application procedures for evaluating the capacity and quality of service of various transportation facilities. It is a tool for analyzing existing facilities and for the planning and design of future systems. HCM is built from more than 60 years of research work and represents a body of expert transportation consensus.

*Highway Capacity Software* (HCS) is a computer program that implements the HCM methodologies. Both HCM and HCS analyze capacity and LOS for uninterrupted-flow and interrupted-flow roadways. Other travel modes covered by HCM and HCS are pedestrian, bicycle, and transit. Results from arterial traffic models created by HCS can be directly exported to TransModeler software.

3.1.2 TransModeler

Unlike the equation-based methods of HCS, TransModeler uses microsimulation to analyze all types of roadway networks. TransModeler uses car-following and driver behavior logic to simulate the traffic operational behavior of various geometric conditions as traffic volumes and speeds fluctuate. Several measures of effectiveness (MOEs) can be obtained from the analysis, including some comparable to the methodologies in the HCM.

3.2 Which Tool is Appropriate?

While HCS and TransModeler are both great tools for analysis, there are benefits to using one tool over the other. **Figure 3-1** provides a flow chart for selecting the appropriate tool.

*HCS is required for all analyses except for conditions where HCS cannot adequately analyze project elements.*
Figure 3-1. Tool Selection Flow Chart

TransModeler is needed for the following analysis types/reasons:

- **Weaving areas** - While HCS can evaluate weaving sections, TransModeler should be used to supplement the HCS results whenever HCS results in LOS F. When used just to supplement weaving sections, only the freeway direction containing the weaving segment and the weave itself should be analyzed in TransModeler. It is not necessary to model the entire traffic analysis area in TransModeler. See Figure 3-2 for the limits of a sample TransModeler weave.

- **Interstate and arterial intersections** - HCS cannot analyze the interactions between freeway facilities and arterials. If the analysis of this interaction is critical (i.e., to measure queue spillback onto the mainline freeway), TransModeler should be used.

- **Closely spaced intersections** - TransModeler should be used to evaluate the queues between the intersections to ensure that they do not impact upstream signals.
▪ **Uneven lane distribution** - While HCS can account for uneven lane distribution, TransModeler can measure the effects upstream of vehicles favoring one lane over another because of a downstream turn or lane drop. These situations include dual turn lanes, a lane drop a short distance downstream of an intersection, and interchange types such as a cloverleaf where a large portion of the traffic will be in the right-most lanes.

▪ **Alternative intersections** - The results from TransModeler for complex intersections are more reliable than those from HCS. Such intersection types include diverging diamond interchanges, continuous flow intersections, R-cut intersections, five-legged intersections, and three-lane roundabouts.

▪ **Mix of intersection traffic control types** - For intersections that have a mix of traffic control types that will have significant influence on each other. An example could be a signal metering traffic approaching a nearby stop-controlled intersection. Additionally, mixing roundabouts and signals on a corridor could result in queueing through the roundabout. In such situations, TransModeler can be used to evaluate these effects.

▪ **Active Transportation and Demand Management (ATDM) applications** - HCS cannot accurately analyze ATDM strategies such as ramp metering and should be analyzed using TransModeler.

▪ **Reviewing system-wide measures of effectiveness** - When system-wide metrics, such as travel times, average speeds for the corridor/study area, and vehicle-hours delay are being evaluated, TransModeler should be used.

▪ **Oversaturated areas that are impractical to expand** - When project areas are oversaturated, and it is impractical to expand the analysis limits to undersaturated areas, TransModeler should be used. Lengthening the project area by several miles or multiple interchanges/intersections is considered impractical.

▪ **Traffic rerouting** - Using the Origin-Destination (O-D) matrix in TransModeler, traffic can dynamically be rerouted through the roadway network. This application is especially critical when improvement options close or change accesses to freeway segments or add new connectors that may shorten the travel time or distance for some drivers. While these traffic volumes can be manually rerouted, it is time intensive when multiple alternatives are being evaluated and it requires the analyst to make several assumptions to estimate the new paths.

▪ **ODOT PDP Path 5 Projects or other high-profile projects** - For projects under public scrutiny or where public involvement is critical to the success of the project, visualization may be helpful. With the analysis in TransModeler, public-ready graphics and videos can be created to help the public and other stakeholders understand the proposed improvements and how they will affect traffic flow within the study area.

▪ **Interaction between vehicular traffic and transit** - The effects of transit stopping in travel lanes or receiving priority at signals can be accurately evaluated using TransModeler.

▪ **Other conditions on a project by project basis** - Other project conditions not listed here may require TransModeler analysis. Coordination between ODOT and the analyst should begin early in the scoping process to discuss the advantages and disadvantages of using TransModeler over HCS.
There are several things to keep in mind for ODOT projects:

- If TransModeler is used for one alternative, it should be used for all alternatives (including No-Build conditions) to provide an equal comparison between alternatives.
- If TransModeler has been selected as the appropriate analysis tool and the entire project area is modeled in TransModeler, HCS analysis is not required.
- Both HCS and TransModeler can be used on the same project. If, for example, the project involved a freeway section with multiple interchanges but had one weave, the entire freeway network analysis could be done using HCS. TransModeler can then be used to verify and supplement the results from HCS for the weave segment.

3.3 Comparing Results

The selection for MOEs for any analysis is critical, especially as the FHWA Traffic Analysis Toolbox cautions against the use of comparing simulation results to the HCM derived results. It notes that the analyst needs to review the software documentation to understand the differences and to be sure that the microsimulation software is calculating LOS properly. Based on discussions with the software developer, Caliper, it was determined that TransModeler appropriately presents the LOS results in a manner that is consistent with the HCM methodologies.

For basic analysis (i.e., those situations not listed in Section 3.2) of mainline freeways, merges, diverges, and arterial intersections and segments, the results between HCS and TransModeler have been noted to be consistent. For weaving segments, results have been shown to vary greatly between HCS and TransModeler. One such reason for this analysis is that the HCM freeway merge and diverge methods are much different than the HCM weaving methods. They have different density equations - the weaving density includes all lanes in the cross section while the merge and diverge density only includes the two lanes closest to the ramp.

- All weaving analyses from HCS resulting in LOS F should be supplemented with TransModeler.
Chapter 4. Data Collection

This chapter details the data requirements, data resources, and data collection procedures for obtaining necessary data to conduct the traffic analysis and simulation.

4.1 Field Observation

Field observations are critical to obtain accurate results for both HCS and TransModeler analyses. During the field review, the analyst becomes familiar with the general traffic flow characteristics within the study area. Desktop review of the study area through aerial photographs, video logs, or online street view databases should not replace physical field observations.

The field observations should be conducted during the AM and PM peak periods to identify:

- Areas of congestion
- Queues
- Unequal lane utilization
- Driver behavior characteristics (i.e., aggressiveness)
- General operating characteristics of the study roadways

The information gathered during the field observations will be used to calibrate the analysis to match existing operating conditions for all Complex Type projects as well as verify the analysis whenever an existing analysis is done.

4.2 Traffic Counts

Traffic counts should be collected irrespective of the traffic analysis software being used. For projects where certified traffic is being developed, traffic counts are typically part of the certified traffic request, so it would not be necessary to collect them twice.

Existing count data, if available, may be used. Data may be obtained from the ODOT TMMS site (http://odot.ms2soft.com) or through a local agency. Many MPOs have a count database which can be used to obtain the count data. Counts older than three years should not be used.

Traffic count collection should follow the methodology detailed in Appendix A of the Ohio Traffic Forecasting Manual, Volume 2.

4.2.1 Turning Movement Counts

Turning movement counts should be collected on a Tuesday, Wednesday, or Thursday on weeks that do not contain a holiday. Consideration should be given to a study area where peaked traffic is expected. For example, near schools or where shift changes occur (i.e. warehouses, factories, hospitals, etc.). Counts should be conducted in 15-minute intervals typically between 6:00 AM and 7:00 PM. Additional count periods (such as weekend, evening, holiday, etc.) may be required on a project by project basis. For all collected counts, vehicle classifications should be included.

If the study intersection is in a downtown area or other high pedestrian location, pedestrian counts should be collected as part of the intersection turning movement count.
4.2.2 Demand vs. Capacity

Where existing demand exceeds capacity, traffic counters will only capture the capacity. Counts that only represent the capacity are underreported and will result in an inaccurate analysis. The study roadways will be shown to perform better than reality. Where traffic counts are being used, they should be adjusted to reflect actual demand. This is done in one of two ways. The first method would be collecting queue counts as defined in the Ohio Traffic Forecasting Manual, Volume 2. The second method is collecting additional traffic counts at a location upstream of the congested location. If the congested location is the approach to an intersection, it can be assumed that the intended turning movements within the traffic stream at the upstream, uncongested location will have the same directional proportion (left turns, throughs, right turns and U-turns) as those observed at the stop line. This is illustrated in Figure 4-1.

![Figure 4-1](image)

\[
\text{Adjusted Demand Factor} = \frac{1,200}{1,000} = 1.2
\]

Adjusted Demand Volumes = Count x Demand Adjustment Factor

- Left Turn: \(200 \times 1.2 = 240\)
- Through: \(700 \times 1.2 = 840\)
- Right Turn: \(100 \times 1.2 = 120\)
- Total: \(1,200\)

Figure 4-1. Adjustment of Turning Movement Counts to Demand Volumes

4.2.3 Mainline and Arterial Segment Counts

Segment counts are not needed for every study as usually turning movement counts can provide adequate count information. Segment counts should be considered at locations where the demand is likely to exceed capacity. Additionally, segment counts should be collected along mainline freeway segments. Provided turning movement counts at all the ramp terminal intersections within the study area have been collected, only one mainline count would be required. The turning movement counts in conjunction with the ramp terminal intersection counts can be used to calculate the volumes of all the ramps and other freeway segments in the study area.
When needed, segment counts, including vehicle classifications, should be collected for 24 to 48 hours in 15-minute intervals. For arterials, when segment counts are collected, the counts should be collected upstream of the back of the queue so that demand, rather than just capacity, is counted.

### 4.2.4 Volume Balancing and Smoothing

According to the *Ohio Traffic Forecasting Manual, Volume 2*, balancing and smoothing are two processes by which differences between traffic volume data at new nearby locations are reduced or eliminated completely. These two terms are defined as follows:

- **Balancing** refers to the process of eliminating the traffic volume difference between two points completely.
- **Smoothing** is used to reduce the traffic volume differences to reasonable levels as determined by the forecasters.

The need to balance or smooth volumes is reduced or mitigated when counts are collected on the same day.

Refer to the information provided in Section 2.6 in the *Ohio Traffic Forecasting Manual, Volume 2* for when balancing or smoothing is appropriate, methods for balancing or smoothing, and factors to consider while balancing or smoothing volumes.

### 4.2.5 SDE Tool Count Collection

For projects that will include the Simulation Demand Estimator (SDE) Tool (see 7.2.2), check with ODOT Modeling and Forecasting prior to the collection of the traffic counts to ensure that all data needs are collected. The SDE Tool may require count data outside of the parameters described herein. These needs will be discussed at the Early Coordination Meeting.

### 4.3 Average Speed/Travel Time

- **For Standard Type projects**, average speeds and travel time data are not required.

- **For Complex Type projects**, average speeds and travel time data is required for calibration and validation of HCS and TransModeler analysis for existing conditions.

Average speeds (and resulting travel times), can typically be obtained from INRIX data using the Congestion Scan feature under the Probe Data Analytics Suite. Within the INRIX website portal, tutorials are available to demonstrate how to pull speed data. *StreetLight InSight* can also be used to obtain speeds. The average travel speeds should be obtained in 15-minute intervals on a Tuesday, Wednesday, and Thursday over the course of a one-year period.

Speed information in INRIX is provided for most Interstate, US, and state routes in Ohio. If INRIX or *StreetLight InSight* speed data is not available, travel times and speeds should be collected using a GPS based automated device using Tru-Traffic. The decision to collect travel time information should be made during the scoping process. It is recommended that travel times be collected on arterial (not for single intersection analyses) or freeway projects where INRIX data is not available.
and demand is known to exceed capacity (i.e., significant queueing is observed) so that the analysis can be properly calibrated.

At least five passes in each direction during each analysis time period is required. More passes are preferred in the event that some runs need to be thrown out. Data should be collected on a Tuesday, Wednesday, or Thursday during a week without a holiday. Consideration should be given to the schedules of the schools in or adjacent to the study area. The floating-car technique is the preferred collection method. For this technique, the driver “floats” with traffic by attempting to safely pass as many vehicles as pass the test vehicle.

4.4 Queue Lengths

Queue lengths are an important metric in the calibration process for both HCS and TransModeler. As defined in the HCM, the back of queue is the position of the vehicle stopped farthest from the stop line during the cycle because of the red signal indication. Queue size is defined to include only vehicles that are fully stopped (traveling 5 mph or less per the HCM).

For Standard Type projects, collecting queue lengths is not required.

For Complex Type projects, queue lengths should be field measured at intersections where demand is known to exceed capacity. During the analysis periods, observers in the field or using video recordings note the number of vehicles stopped on the approach at the start of the green signal for each cycle. For unsignalized intersections, observations are recorded in equal intervals of every minute.

4.5 Existing Signal Timings

For Complex Type projects and any other projects analyzing existing conditions, existing signal timings are required for the analysis of all signalized intersections regardless of the software being used. If possible, the existing signal timings should be provided by the maintaining agency. If those timings are not available, they can be field measured. Over the course of five signal cycles, the splits for all movements should be recorded and averaged to determine the existing cycle length, splits, and signal phasing. When measuring timings in the field, four seconds of yellow clearance and two seconds of all-red intervals can be assumed. Based on the measured cycle length and splits, it can be determined if the signal is actuated/coordinated (same cycle length but different split lengths), actuated/uncoordinated (different cycle lengths and different split lengths) or pretimed (same cycle length and same split lengths) which is another important factor when analyzing signalized intersections.

Pedestrian timings should be included in the analysis at locations where there is heavy pedestrian activity such as near schools, an event center, or a downtown area. In these locations, the pedestrian clearance intervals should be included in the existing signal timings and incorporated into the existing analysis.
4.6 Free-Flow Speed

The HCM defines free-flow speed as the average running speed of through vehicles traveling along a segment under low-volume conditions and not delayed by traffic control devices or other vehicles. Free-flow speeds are required for both HCS and TransModeler analyses.

There are two possible ways to obtain free-flow speed data:

i. INRIX or StreetLight data - Similar to obtaining average travel speeds, the free-flow speeds can be obtained from INRIX using the Congestion Scan feature under the Probe Data Analytics Suite or through Streetlight InSight. The 50th percentile speeds on the study corridor between 6:00 AM and 10:00 AM averaged on Saturdays and Sundays between April and October (to ensure during daylight hours) should be considered as free-flow speeds. Days with known external factors (i.e., construction periods, incidents, weather conditions, etc.) should be excluded from the collection if possible. INRIX is the preferred method for obtaining free-flow speeds in Ohio.

ii. Posted speed limit + 5 mph - The posted speed limit plus 5 mph should be used to determine the free-flow speed. For example, a freeway with a posted speed limit of 65 mph will have a free-flow speed of 70 mph.

Free-flow speed used for all HCS and TransModeler analysis shall be the posted speed limit plus 5 mph.

4.7 Lane Utilization

Per the HCM, the lane utilization adjustment factor accounts for the unequal distribution of traffic among the lanes in those movement groups with more than one lane such as dual left turn lanes or two or more through lanes. Another case could be an exclusive left turn lane plus a shared left through lane. At some locations, drivers may favor one lane over another in anticipation of a downstream turn. Additionally, some intersections have a through lane that drops just downstream of the intersection. This type of lane can be underutilized if it is relatively short. In both cases, the lane utilization should be field measured for analyses using both HCS and TransModeler.

On freeways, vehicles may favor a particular lane in preparation of a downstream exit. In the weaving analysis and the consideration of upstream and downstream ramps for merge/diverge analysis, HCS will account for this in most situations. However, unequal lane distribution can often be ignored in the analysis for boundary links. If the chosen boundary link has a heavy weaving volume or other factors causing an unequal lane utilization, the limits for the analysis should be expanded. If the limits cannot be expanded past this segment, TransModeler should be used.

Most locations will have even lane utilization and lane utilization data will not need to be collected. At the scoping of the project, the determination needs to be made on when lane utilization will be required. One example when it may be needed is the situation where there are two through lanes, but immediately after the intersection, the two lanes merge into one. At this location there is typically an imbalance in number of vehicles in each lane. The through lane that merges in may only have 20% of the total through volume while the lane that doesn’t end may have 80% of the total through volume. Without adjusting the lane utilization adjustment factor, the delay and queue length for this movement may be underestimated.
Where an unequal lane distribution occurs, the lane utilization factor must be field measured. The field measurement should be obtained during a 15-minute period during each analysis period. From this measurement, the lane utilization for the entire hour can be extrapolated. If the traffic counts were collected using Miovision, the video can be reviewed to obtain this measurement without being in the field.
### 4.8 Data Needs Summary

*Table 4-1* summarizes the data needs for conducting traffic analyses for ODOT Projects.

**Table 4-1. Data Needs Summary**

<table>
<thead>
<tr>
<th>Facility Type</th>
<th>Data Type</th>
<th>Notes and Potential Data Needs/Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Signalized Intersection</strong></td>
<td><strong>Intersection Geometry and Configuration</strong></td>
<td>▪ Number of lanes on each approach, lane markings, and turn lane lengths  &lt;br&gt;▪ Aerial maps/photography  &lt;br&gt;▪ Photolog/Google Streetview  &lt;br&gt;▪ Confirm with field reviews as appropriate</td>
</tr>
<tr>
<td><strong>Turning Movement Counts</strong></td>
<td></td>
<td>▪ Historical counts not older than 3 years can be used (from ODOT TMMS or other local sources)  &lt;br&gt;▪ Collected on Tuesday, Wednesday, or Thursday on weeks that do not contain a holiday  &lt;br&gt;▪ 15-minute intervals typically between 6:00 AM and 7:00 PM  &lt;br&gt;▪ Vehicle classification included  &lt;br&gt;▪ Collect segment counts to determine demand  &lt;br&gt;▪ Pedestrian counts for high pedestrian areas</td>
</tr>
<tr>
<td><strong>Queue Lengths (Complex Type)</strong></td>
<td></td>
<td>▪ Field measured when demand is known to exceed capacity</td>
</tr>
<tr>
<td><strong>Existing Signal Timings</strong></td>
<td></td>
<td>▪ Obtained from maintaining agency  &lt;br&gt;▪ Field measured when timings are not available</td>
</tr>
<tr>
<td><strong>Lane Utilization</strong></td>
<td></td>
<td>▪ Field measured for a 15-minute period during the analysis period at locations where lanes are not equally utilized.</td>
</tr>
<tr>
<td><strong>Unsignalized Intersection</strong></td>
<td><strong>Intersection Geometry and Configuration</strong></td>
<td>▪ Number of lanes on each approach  &lt;br&gt;▪ Aerial maps/photography  &lt;br&gt;▪ Photolog/Google Streetview  &lt;br&gt;▪ Confirm with field reviews as appropriate</td>
</tr>
<tr>
<td><strong>Turning Movement Counts</strong></td>
<td></td>
<td>▪ Historical counts not older than 3 years can be used (from ODOT TMMS or other local sources)  &lt;br&gt;▪ Collected on Tuesday, Wednesday, or Thursday on weeks that do not contain a holiday  &lt;br&gt;▪ 15-minute intervals typically between 6:00 AM and 7:00 PM  &lt;br&gt;▪ Vehicle classification included  &lt;br&gt;▪ Collect segment counts to determine demand  &lt;br&gt;▪ Pedestrian counts for high pedestrian areas</td>
</tr>
<tr>
<td><strong>Queue Lengths (Complex Type)</strong></td>
<td></td>
<td>▪ Field measured when demand is known to exceed capacity</td>
</tr>
<tr>
<td><strong>Lane Utilization</strong></td>
<td></td>
<td>▪ Field measured for a 15-minute period during the analysis period at locations where lanes are not equally utilized.</td>
</tr>
<tr>
<td>Facility Type</td>
<td>Data Type</td>
<td>Notes and Potential Data Needs/Sources</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------</td>
<td>----------------------------------------</td>
</tr>
</tbody>
</table>
| Urban/Rural Corridor | Roadway Geometry and Configuration | • Speed Limit, number of lanes  
• Aerial maps/photography  
• Photolog/Google Streetview  
• Confirm with field reviews as appropriate |
|                | Intersection Data | • Assemble signalized and unsignalized intersection data shown above at all intersections |
| Freeway (Facilities, Basic, Merge, Diverge, Weave) | Average Speed/Travel Time (Complex Type) | • Obtained from INRIX or StreetLight data  
• Field measured if INRIX or StreetLight data is not available |
|                | Free-Flow Speed | • Posted Speed Limit + 5 mph |
|                | Highway Geometry and Configuration | • Speed limit, number of lanes, auxiliary lanes, and merge/diverge/weave locations, acceleration/deceleration lengths  
• Aerial maps/photography  
• Photolog/Google Streetview  
• Confirm with field reviews as appropriate |
|                | Ramp Terminal Intersection Data | • Assemble signalized and unsignalized intersection data shown above at all intersections |
|                | Mainline Traffic Counts | • Can be obtained from ODOT continuous counters if located within study area and ramp volume and/or ramp terminal intersection volumes are known  
• If collected, must be collected for 24-48 hours in 15-minute intervals on a Tuesday, Wednesday, or Thursday during a week that does not contain a holiday |
|                | Average Speed/Travel Time (Complex Type) | • Obtained from INRIX or StreetLight data  
• Field measured if INRIX or StreetLight data is not available |
|                | Free-Flow Speed | • Posted Speed Limit + 5 mph |
Chapter 5. General Traffic Analysis

This chapter details the typical inputs that go into the traffic analyses for ODOT projects. ODOT preferences are also described.

5.1 Grade

The grade of a roadway segment can have an impact on the capacity and operations of the facility. Grade should be considered whenever it exceeds 3 percent for longer than a half-mile. For most cases, the default grade should be “level”. For locations where the grade exceeds 3 percent for longer than a half-mile, the actual grade should be used for the analysis. If grades cannot be field measured, they can be estimated using Google Earth. Grade for ramps shall be assumed to be zero.

5.2 Peak Hour Factor

Traffic flow rates typically vary over the course of an hour. The Peak Hour Factor (PHF) is a measure of the traffic demand fluctuations within the analysis hour. The following equation is used to calculate the PHF:

\[
PHF = \frac{V}{4 \times V_{15}}
\]

Where
- \(V\) = peak hour volume (veh/h)
- \(V_{15}\) = volume during the peak 15 minutes of the peak hour (veh/15 minutes)

A PHF of 1 indicates that the traffic volume in every 15-minute interval is the same and therefore the traffic flow is consistent throughout the hour. Lower PHF values indicate more variable traffic flows and that the traffic volume has a spike during the peak 15-minute interval. PHFs in urban areas generally range from 0.80 to 0.98. PHFs over 0.95 are often indicative of high traffic volumes, sometimes with capacity constraints on flow during the peak hour. PHFs under 0.80 occur in locations with highly peaked demands, such as schools and factories during shift changes.

The existing year PHF should be calculated for all intersections from traffic counts collected for the project. When calculating the PHF, it should be calculated for the intersection as a whole and not individual approaches or movements. The minimum PHF should be 0.80 unless it is justified by highly peaked demands such as schools and factories during shift changes. It is assumed that the PHF for the design year is the same as the calculated PHF for the existing year.

PHF for freeway mainlines shall be the default value of 0.94. Ramp PHF will be the PHF calculated for the ramp terminal intersection.

If project specific traffic counts are not available, the following default values for Peak Hour Factor may be used:
- 0.94 for ramps
- 0.92 for arterials
The use of PHF in HCS will include entering the hourly volume and PHF.

PHF in TransModeler is accounted for by one of the following methods:

- The volumes are entered in four 15-minute periods.
- When entering the volumes using turning movements, select single period and enter the appropriate PHF in the Turning Movement Table Settings. Hourly volumes are used for turning movements.
- When entering the volumes using an O-D matrix, create a curve-based time distribution based on the calculated PHF. Table 7-8. O-D Matrix Curve Data for Various PHF shows the curve distribution data for PHFs from 0.80 to 1.00. See Section 7.2.2.5 for how to enter a curve-based time distribution.

Only one PHF can be used for the project in TransModeler. A critical study intersection or high-volume intersection should be selected to represent the study area. If the majority of the study area is freeway, a value of 0.94 shall be used.

Calculations used to determine the intersection PHF shall be included as an appendix to the report developed for the study.

5.3 Saturation Flow Rate

Default saturation flow rates should be used for the analysis. Table 5-1 provides the default rates to be used for different areas. Urban areas are defined using the Census Urban Areas boundary layer in the Transportation Information Mapping System (TIMS). An attribute for UATYP10 of “U” will be an urban area.

Table 5-1. Default Base Saturation Flow Rates

<table>
<thead>
<tr>
<th>Area Type</th>
<th>Base Saturation Flow Rate (pc/h/ln)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urban Area</td>
<td>1,900</td>
</tr>
<tr>
<td>Otherwise</td>
<td>1,750</td>
</tr>
</tbody>
</table>

Saturation flow rate is a direct input into HCS. While HCS allows for different saturation flow rates for each intersection movement, unless there is a specific reason to use different rates for different movements (which should be documented in the Model Documentation Form), the same saturation flow rate should be used for all movements at the intersection.

In TransModeler, direct entry of the saturation flow rate is not available. Refer to Section 7.3.5.2 to determine how to make the necessary model changes to reflect the field measured saturation flow rate.
5.4 Right Turn Treatments

The treatment of vehicles turning right during the red signal or from yield-controlled or free-flow lanes affects the capacity calculations for both HCS and TransModeler.

When using HCS, right turns on red (RTOR) are not allowed and a zero value should be used for RTOR flow rate. At locations where RTOR movements are a significant component in intersection operations, TransModeler may be a more appropriate tool.

For channelized right turn movements that are yield-controlled or free-flowing and are not affected by queueing at the signal (i.e., a channelized exclusive right turn lane), the right turn demand should be included in the analysis and the “Unsignalized Movement” box checked. The value for “Unsignalized Delay” should be zero. If the right turning analysis is critical to the results, microsimulation should be used.

The car following and gap acceptance algorithms in TransModeler allow the software to accurately simulate the RTOR flow rates and the channelized right turn movements. Visual inspection should be performed to ensure that the simulation matches existing field conditions.

5.5 Heavy Vehicle Percentages

ODOT defines a heavy vehicle as single unit trucks, busses, RV’s and tractor/trailers (Type B&C). The percentage of heavy vehicles represents the count of heavy vehicles that arrived during the analysis period divided by the total vehicle count for the same period.

The existing heavy vehicle percentages should be calculated based on existing counts. When calculating the heavy vehicle percentages for intersections, it should be calculated by approach and not for individual movements. In almost all analyses for ODOT, the existing heavy vehicle percentages will be the same in the future. If there is reason to believe that the heavy vehicle traffic will be increasing or decreasing at a different rate than passenger cars, the future heavy vehicle traffic percentages should be calculated. Justification should be submitted to the ODOT Project Manager for approval when heavy vehicle percentages change between existing and future conditions.

For HCS analyses, the heavy vehicle percentages should be calculated from the existing counts and entered directly into HCS.

In TransModeler, vehicle fleet characteristics can be adjusted based on heavy vehicle percentages from existing counts. Refer to Section 7.2.3.2 for information on how to adjust vehicle fleet characteristics.

5.6 Lane Utilization

As detailed in Section 4.7, the lane utilization adjustment factor accounts for the unequal distribution of traffic among the lanes in those movement groups with more than one exclusive lane.

The existing lane utilization factors should be calculated from video or field observations. Lane utilization factors apply at locations with dual turn lanes or where a through lane drops
a short distance downstream of an intersection. Another case would be an exclusive left turn lane plus a shared left-through lane. For example, an off-ramp has a 3-lane approach with a Left - Left/Through/Right - Right lane configuration. By default, HCS will view the off-ramp as a Left - Through - Right configuration unless values are entered on the Percent Turns in Shared Lane input box. If the lane configurations do not change between existing and future conditions, the existing lane utilization factor can be assumed for future conditions. If one alternative changes the lane configuration such that the lanes will be more evenly utilized, the default lane utilization factors can be used for future conditions. If the future condition involves a drop lane downstream of an intersection where the existing does not, the lane utilization for future conditions should be estimated. Calculations and justifications for the lane utilization estimation should be provided to the ODOT Project Manager for approval. Very few projects are expected to need lane utilization factors estimated.

For HCS analyses, the lane utilization data can be entered in the Heaviest Lane Volume box of the DETAILED INPUT DATA window in HCS. For the case of exclusive plus shared turn lanes, the percent of turns in the shared lane must be entered in the Percent Turns in Shared Lane box of the DETAILED INPUT DATA window.

The driver behavior parameters in TransModeler and a properly coded roadway network will most likely reflect accurate lane utilization characteristics. Visual inspection should be performed to ensure that the simulation model matches field conditions. If the model needs to be adjusted, the lane connector connectivity bias can be modified in TransModeler. Refer to Section 7.3.5.2 for information on how to adjust these parameters.

Calculations for lane utilizations that differ from default values shall be included as an appendix to the report developed for the study.

5.7 Signal Timing

Signal timings at signalized intersections drastically impact intersection capacity operations.

For ODOT projects, the existing signal timings should be used whenever existing signal analyses is performed. Refer to Section 4.5 for more information on obtaining or measuring existing signal timings. Future year analyses should be conducted using optimized signal timings using the general guidance provided below. Refer to Section 6.2.2.1 (HCS) and Section 7.1.4.1 (TransModeler) for how to input the signal timings into the respective software.

The following general guidelines should be followed when optimizing signal timings for future year analyses. While they are just guidelines and not standards, deviations from these guidelines should be approved by ODOT on a project by project basis.

- Signal timing optimization may be performed in Synchro, HCS, or TransModeler. No matter what software is used for optimization, the resulting signal timings should be entered into the software being used to conduct the analysis.
- If the existing traffic signals are coordinated, they should be modeled as coordinated in future year analyses.
Cycle lengths in the future year analysis can differ from existing conditions but should typically be between 60 and 120 seconds. Cycle lengths longer than 120 may be required for intersections that are oversaturated. Cycle lengths at all intersections along a coordinated corridor must be the same.

Half or double cycle lengths (i.e., 60 second cycle length at one intersection in a corridor of intersections with 120 second cycle lengths) are not permitted.

If the intersection geometry changes between the existing and future conditions or if the clearance intervals or minimum timings are not known (i.e., if signal timings are measured from field conditions) the following values should be used:
- Yellow clearance - 4 seconds
- All-red clearance - 2 seconds
- Minimum green time for major street through movements - 20 seconds
- Minimum green time for minor street through movements - 10 seconds
- Minimum green time for protected left turn phases - 7 seconds

Alternative intersections such as Single-Point Urban Interchanges and Diverging Diamond Interchanges can have a much wider intersection than traditional intersections. In this case, the All-red time may need to be longer than 2 seconds to allow additional time for a vehicle to clear the intersection.

If pedestrian crossing times are to be accommodated within coordinated signal timings (see Scoping Document), the minimum green times should be extended to accommodate Walk and Flashing Don’t Walk intervals.
- If the Walk and Flashing Don’t Walk intervals are not known, assume 7 seconds for the Walk interval and 10 seconds for the Flashing Don’t Walk interval.

Typically, left turn phases should be leading. However, sometimes the lagging left turn phase can reduce vehicle delays. This phasing is permissible, only if the opposing left turn lanes are protected only phasing and the queues for the lagging left do not impact the adjacent through lane.
- Protected-permitted left turn phases cannot be lagging due to yellow trap. Based on the Manual on Uniform Traffic Control Devices (MUTCD), the yellow trap is a potentially adverse safety situation inherent in some signal phasing sequences involving lagging left turns in one direction. A left-turning driver, in the intersection waiting for gaps in oncoming traffic in order to turn left on a permissive green signal indication, sees the signals change from green to yellow and mistakenly assumes that oncoming through traffic also has yellow signals at the same time and will be soon coming to a stop. This mistaken assumption “traps” the permissive left turner into thinking it is OK to safely complete the turn when in reality it is not safe, because the opposing traffic continues to move on a green indication along with a lagging left turn, and a severe crash can be the result.

The operational goal for the intersection analysis is an overall intersection LOS of D or better for locations within the boundaries of a metropolitan planning organization (MPO) and LOS C or better for locations outside of an MPO boundary. LOS for each approach at E better, and no individual movement with a volume-to-capacity (v/c) ratio greater 0.93. In addition, the Queue-Storage-Ratio (QSR) from HCS analysis should be <1.0 for all movements. If the QSR goal cannot be met, TransModeler may be needed to determine if queuing impacts upstream intersections.

When evaluating optimized signal timings, the minor street will often have more delay than the major street. This is acceptable but the volume-to-capacity (v/c) ratio for the minor street
should be checked to make sure that it is not significantly higher than the major street v/c ratio. In most cases, efforts should be made to ensure that the v/c ratios for the minor street are not over 1.0. A few minor tweaks in the signal timings can alter the v/c ratios so that no movements are over 1.0. It is understood that for oversaturated conditions, v/c ratios will be above 1.0 for both major and minor streets.

For HCS analyses, see Chapter 6 for signal timing optimization guidance.

For TransModeler analyses, see Chapter 7 for signal timing optimization guidance.

5.8 Calibration/Validation

Calibration is the process of identifying a full set of model inputs and parameters such that the model’s outputs match measured field data. This is a way of demonstrating that the model is a reasonably accurate representation of observed conditions.

Validation is the act of proving or corroborating, usually with a second data source or dataset, that the calibrated model can also provide realistic results under different input data/scenarios. This ensures a more robust model with realistic internal mechanics, that is less likely to be over-fit to just one dataset. The purpose of calibration and validation is to build confidence in the model as a useful predictor of operations that are likely to result from a condition that cannot be observed, such as after a capital improvement or a change in land use or demand pattern.

Potential pitfalls of poor model development or poor calibration include, but are not limited to:

- Discrepancies between field geometry and traffic control and those modeled
- Unrealistic driving behavior
- Discrepancies between field measured traffic volumes and the amount of traffic served in the microsimulation model
- Creation of false bottlenecks
- Unreasonable routings of vehicles through the network during dynamic assignment
- Improper accounting of the effects of (and on) non-motorized users

The measures selected for calibration and their targets for model calibration should be established based on the purpose and need of the project.

The following list provides outputs/metrics that should be used to compare against field measurements to determine if a model is properly calibrated:

- Volume throughput
- Speed
- Travel Time
- Queues

For HCS analyses, it is recommended that queue lengths be used to calibrate the analysis model.

At a minimum, it is suggested that volume throughput and speeds (or travel times) are used as metrics during TransModeler model calibration.
Based on guidance from other states and FHWA at the time of this manual, suggested calibration items and their targets are summarized in Table 5-2.

Table 5-2. Calibration and Targets

<table>
<thead>
<tr>
<th>Calibration Item</th>
<th>Calibration Target</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Volume Throughput</strong></td>
<td></td>
</tr>
<tr>
<td>Individual movement flows ≤ 700 veh/hr</td>
<td>Within 100 vehicles of field data for more than 85% of movements in model area</td>
</tr>
<tr>
<td>Individual movement flows between 700 and 2,700 veh/hr</td>
<td>Within 15% of field data for more than 85% of movements in model area</td>
</tr>
<tr>
<td>Individual movement flows &gt; 2,700 veh/hr</td>
<td>Within 400 vehicles of field data for more than 85% of movements in model area</td>
</tr>
<tr>
<td><strong>Speed</strong></td>
<td></td>
</tr>
<tr>
<td>Link Speed</td>
<td>Within 10 mph of field data for more than 85% of network links</td>
</tr>
<tr>
<td><strong>Travel Times</strong></td>
<td></td>
</tr>
<tr>
<td>Field travel times ≤ 7 minutes</td>
<td>Within 1 minute of field data for more than 85% of travel time segments</td>
</tr>
<tr>
<td>Field travel times &gt; 7 minutes</td>
<td>Within 15% of field data for more than 85% of travel time segments</td>
</tr>
<tr>
<td><strong>Queues</strong></td>
<td></td>
</tr>
<tr>
<td>Queues formed in free flow areas</td>
<td>All locations with formed queues are modeled</td>
</tr>
<tr>
<td>Queue length</td>
<td>Within 20% of field measured queue length</td>
</tr>
</tbody>
</table>
Chapter 6. Highway Capacity Software (HCS) and the Highway Capacity Manual (HCM)

The Highway Capacity Software, Release 7 (HCS7) is one of several software packages that implements the analytical methods in the Highway Capacity Manual (HCM), of which the HCM 6th Edition\(^1\) is the most current version. The Transportation Research Board (TRB) Committee on Highway Capacity and Quality of Service (AHB40) oversees the material contained in the HCM. The Committee does not formally endorse the HCS nor any other software, but the McTrans Center, developer of the HCS, purports to faithfully replicate the HCM methods within the HCS.

This section of the OATS Manual provides guidance on the development and calibration of HCS files and their application on ODOT projects as the software implementation of methods in the HCM. It is not a step-by-step guide on the use of the HCS itself, although certain aspects of the HCS are highlighted to point out their proper application. This guidance assumes that the analyst is already familiar with using the HCS, including data entry and generating output reports. Also, it is important to make the distinction between the HCM, which describes the methods and their applications, and the HCS that implements them.

Much of the guidance in this document directs the analyst to chapters in Volume 4 (i.e., Chapters 25 and higher) of the HCM 6th Edition. While the printed HCM (Volumes 1, 2, and 3) must be purchased from TRB, materials in the online Volume 4 (www.hcmvolume4.org) are freely available and require only a one-time registration.

This guidance also refers to several example files provided by HCS. While the exact location may vary depending on where the user chooses to install HCS, these files are most commonly installed on your C drive under Program Files in the HCS7\HCS\Example folder of your HCS install. The example files included with the HCS are the example problems contained in each chapter of the HCM.

6.1 HCS Quick Input Guides

The following pages provide a quick overview of the various HCS analysis types and the data entry required for each one. Items boxed in red are Project Specific Inputs and are unique to each project. Items boxed in green are Required Analysis Inputs that ODOT has provided guidance for. References to the appropriate section of this manual have been included for the Required Analysis Inputs. Analysis types contained in the Quick Input Guides are:

- Freeway Facilities
- Streets (signalized intersections)
- Roundabouts
- All-Way Stop Control
- Two-Way Stop Control

A detailed discussion of each of these analysis types is included later in this chapter.

---

**HCS Quick Input Guide**

**Freeway Facilities**
*(See Section 6.1.1.1)*

**General Input Tab**

<table>
<thead>
<tr>
<th>START</th>
<th>GENERAL</th>
<th>SEGMENTS</th>
<th>DETAILS</th>
<th>RESULTS</th>
<th>REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Project Properties</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Agency</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analysis Year</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Project Description</td>
</tr>
</tbody>
</table>

**Facility Global Inputs**

- Jam Density, pc/mi/ln: 190.0
- Queue Discharge Capacity Drop, %: 7
- Managed Lane: [ ]
- Systems Analysis: [ ]
- Area Type: Urban
- Demand Factor: 1.000
- Mixed Flow Model: [ ]

**Segments Global Inputs**

- Freeway Lanes: [ ] 3
- Freeway FFS, mi/h: [ ] 60.0
- Freeway Terrain Type: [ ] Level
- Freeway Peak Hour Factor: 0.94
- Freeway Total Trucks, %: 0.00
- Driver Population: [ ] All Familiar

*Select as needed. Note that the Facility must be built before values can be entered on this tab.*

- Project Specific Inputs

---

*July 2020*
HCS Quick Input Guide
Freeway Facilities
(See Section 6.2.1.1)
Segments Input Tab

Segment Facility as described in Section 6.2.1.1

- Required Analysis Inputs
Free-flow speed equal to posted speed + 5 mph
See Section 4.6

Grades greater than 3% / -3% should be entered
See Section 5.1

Use existing based on approach
See Section 5.5

Use 0.94 for basic freeway segment
See Section 5.2
Freeway length should be 1500 feet unless the adjacent segment is an Overlap. See Section 6.2.1.1.

Free-flow speed equal to posted speed - 5 mph. See Section 4.6.

Use existing based on approach. See Section 5.5.

Use 0.94 for freeway. Use existing PHF with a Minimum of 0.80 for ramp. If existing ramp PHF is unknown, use 0.94. See Section 5.2.
HCS Quick Input Guide
Freeway Facilities
(See Section 6.2.1.1)
Details Input Tab (Overlap Segment)

Free-flow speed equal to posted speed + 5 mph
See Section 4.6

Grades greater than 3% / -3% should be entered
See Section 5.1

Use existing based on approach
See Section 5.5

Use 0.94 for overlap segment
See Section 5.2

- Project Specific Inputs
- Required Analysis Inputs
## HCS Quick Input Guide

**Freeway Facilities**
(See Section 6.2.1.1)

Details Input Tab (Weaving Segment)

### Freeway Geometric Data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Lanes</td>
<td>4</td>
</tr>
<tr>
<td>Free Flow Speed, m/h</td>
<td>60.0</td>
</tr>
<tr>
<td>Ramp Type</td>
<td>One-Sided</td>
</tr>
<tr>
<td>Number of Maneuver Lanes</td>
<td>2</td>
</tr>
<tr>
<td>Short Length (LS), ft</td>
<td>1471</td>
</tr>
<tr>
<td>Interchange Density, int/mi</td>
<td>0.83</td>
</tr>
<tr>
<td>Managed Lane</td>
<td></td>
</tr>
</tbody>
</table>

### Ramp Geometric Data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Lanes</td>
<td>1</td>
</tr>
<tr>
<td>Free Flow Speed, m/h</td>
<td>35.0</td>
</tr>
<tr>
<td>Terrain Type</td>
<td></td>
</tr>
<tr>
<td>Grade, %</td>
<td></td>
</tr>
<tr>
<td>Grade Length, mi</td>
<td></td>
</tr>
</tbody>
</table>

### Demand Data

<table>
<thead>
<tr>
<th>Category</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeway-to-Freeway</td>
<td></td>
</tr>
<tr>
<td>Ramp-to-Freeway</td>
<td></td>
</tr>
<tr>
<td>Ramp-to-Ramp</td>
<td></td>
</tr>
<tr>
<td>Freeway-to-Ramp</td>
<td></td>
</tr>
<tr>
<td>Demand, veh/h</td>
<td></td>
</tr>
<tr>
<td>Demand Adjustment Factor</td>
<td>1.000</td>
</tr>
<tr>
<td>Peak Hour Factor</td>
<td>0.94</td>
</tr>
<tr>
<td>Total Trucks, %</td>
<td></td>
</tr>
<tr>
<td>Single Unit Trucks (SUT), %</td>
<td></td>
</tr>
<tr>
<td>Tractor-Trailer (TT), %</td>
<td></td>
</tr>
<tr>
<td>Use 0.94 for freeway to freeway.</td>
<td></td>
</tr>
</tbody>
</table>

### Notes
- **Project Specific Inputs**
  - Use existing based on approach
  - See Section 5.5
- **Required Analysis Inputs**
  - Use existing PHF with a Minimum of 0.80 for ramps.
  - If existing ramp PHF is unknown, use 0.94.
  - See Section 5.2

Grades greater than 3% / -3% should be entered
See Section 5.1

Free-flow speed equal to posted speed + 5 mph
See Section 4.6
HCS Quick Input Guide
Streets
(See Section 6.2.2.1)
Quick Start Table

- Project Specific Inputs
- Required Analysis Inputs
Use existing intersection PHF with a Minimum of 0.80. If existing PHF is unknown, use: 0.92 for arterials See Section 5.2

HCS Quick Input Guide Streets (See Section 6.2.2.1) Primary Input Data

- Project Specific Inputs
- Required Analysis Inputs

Use Existing or Typical Range: 60-120 seconds See Section 5.7

Urban Area: 1,900 Otherwise: 1,750 See Section 5.3

Use existing based on approach See Section 5.5

Grade Should be considered when it exceeds 3% for more than 0.5 miles See Section 5.1

ODOT Default Arrival Type: 3 See Section 6.2.2.1

ODOT Default RTOR: 0 See Section 5.4

Refer to Quick Start Table or See Section 5.7
HCS Quick Input Guide

Streets

(See Section 6.2.2.1)

Detailed Input Data

- Project Specific Inputs
- Required Analysis Inputs

ODOT Requires 95th percentile queues

Lane Utilization based on video or field observations
See Section 5.6
### HCS Quick Input Guide

**Roundabouts**

*(See Section 6.2.2.3)*

**General Input Tab**

<table>
<thead>
<tr>
<th>START</th>
<th>GENERAL</th>
<th>GEOMETRY</th>
<th>TRAFFIC REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Properties</td>
<td>Jurisdiction</td>
<td>District 6</td>
<td></td>
</tr>
<tr>
<td>Analyst</td>
<td>GLH</td>
<td>ODOT</td>
<td></td>
</tr>
<tr>
<td>Agency</td>
<td>ODOT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>1/21/2020</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Analyzed</td>
<td>AM Build</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intersection Data</td>
<td>Analysis Time Period</td>
<td>0.25 hours</td>
<td></td>
</tr>
<tr>
<td>Intersection</td>
<td>Peak Hour Factor</td>
<td>0.92</td>
<td></td>
</tr>
<tr>
<td>East/West Street Name</td>
<td>US-36</td>
<td></td>
<td></td>
</tr>
<tr>
<td>North/South Street Name</td>
<td>Main</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Project Specific Inputs**
- **Required Analysis Inputs**

Use existing intersection PHF with a Minimum of 0.80.
If existing PHF is unknown, use: 0.92 for arterials
See Section 5.2
HCS Quick Input Guide
Roundabouts
(See Section 6.2.2.3)
Geometry Input Tab

- Project Specific Inputs

<table>
<thead>
<tr>
<th>Lanes</th>
<th>Eastbound</th>
<th>Westbound</th>
<th>Northbound</th>
<th>Southbound</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflicting Lanes on Entry</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Conflicting Lanes on Bypass Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
HCS Quick Input Guide
Roundabouts
(See Section 6.2.2.3)
Traffic Input Tab

<table>
<thead>
<tr>
<th>START</th>
<th>GENERAL</th>
<th>GEOMETRY</th>
<th>TRAFFIC</th>
<th>REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Vehicle Volumes and Adjustments

<table>
<thead>
<tr>
<th></th>
<th>EastBound</th>
<th>WestBound</th>
<th>NorthBound</th>
<th>SouthBound</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume (veh/h)</td>
<td>Utturn</td>
<td>Left</td>
<td>Thru</td>
<td>Right</td>
</tr>
<tr>
<td>0</td>
<td>140</td>
<td>860</td>
<td>150</td>
<td>0</td>
</tr>
</tbody>
</table>

- Project Specific Inputs
- Required Analysis Inputs

Lane Utilization based on video or field observations
(See Section 5.6)

July 2020
HCS Quick Input Guide
All-Way Stop-Control Intersection
(See Section 6.2.2.2)
General Input Tab

<table>
<thead>
<tr>
<th>Project Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyst</strong></td>
</tr>
<tr>
<td><strong>Agency</strong></td>
</tr>
<tr>
<td><strong>Date</strong></td>
</tr>
<tr>
<td><strong>Time Analyzed</strong></td>
</tr>
<tr>
<td><strong>Jurisdiction</strong></td>
</tr>
<tr>
<td><strong>Analysis Year</strong></td>
</tr>
<tr>
<td><strong>Project Description</strong></td>
</tr>
<tr>
<td><strong>Units</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intersection Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intersection</strong></td>
</tr>
<tr>
<td><strong>East/West Street Name</strong></td>
</tr>
<tr>
<td><strong>North/South Street Name</strong></td>
</tr>
<tr>
<td><strong>Analysis Time Period</strong></td>
</tr>
<tr>
<td><strong>Peak Hour Factor</strong></td>
</tr>
</tbody>
</table>

- Project Specific Inputs
- Required Analysis Inputs

Use existing intersection PHF with a minimum of 0.80.
If existing PHF is unknown, use:
0.92 for arterials
See Section 5.2
HCS Quick Input Guide
All-Way Stop-Control Intersection
(See Section 6.2.2.2)
Lanes Input Tab

- Project Specific Inputs
- Required Analysis Inputs

Vehicle Volume and Adjustments

<table>
<thead>
<tr>
<th></th>
<th>Eastbound</th>
<th>Westbound</th>
<th>Northbound</th>
<th>Southbound</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
<td>Thru</td>
<td>Right</td>
<td>Left</td>
</tr>
<tr>
<td>Volume (vph)</td>
<td></td>
<td>60</td>
<td>270</td>
<td>90</td>
</tr>
<tr>
<td>Percent Thrus Using Shared Lane (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Heavy Vehicles (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use existing based on approach
See Section 5.5

Lane Utilization based on video or field observations
See Section 5.6
### HCS Quick Input Guide

**Two-Way Stop Control Intersection**  
(See Section 6.2.2.2)  
**General Input Tab**

<table>
<thead>
<tr>
<th>Project Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyst</strong></td>
</tr>
<tr>
<td><strong>Agency</strong></td>
</tr>
<tr>
<td><strong>Date</strong></td>
</tr>
<tr>
<td><strong>Time Analyzed</strong></td>
</tr>
<tr>
<td><strong>Jurisdiction</strong></td>
</tr>
<tr>
<td><strong>Analysis Year</strong></td>
</tr>
<tr>
<td><strong>Project Description</strong></td>
</tr>
<tr>
<td><strong>Units</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intersection Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intersection</strong></td>
</tr>
<tr>
<td><strong>Major Street Direction</strong></td>
</tr>
<tr>
<td><strong>East/West Street Name</strong></td>
</tr>
<tr>
<td><strong>Major Street Median Type</strong></td>
</tr>
<tr>
<td><strong>RCUT Alternative Intersection</strong></td>
</tr>
<tr>
<td><strong>MUT/RCUT Crossover Intersection</strong></td>
</tr>
<tr>
<td><strong>Analysis Time Period</strong></td>
</tr>
<tr>
<td><strong>Peak Hour Factor</strong></td>
</tr>
<tr>
<td><strong>North/South Street Name</strong></td>
</tr>
</tbody>
</table>

- **Project Specific Inputs**
- **Required Analysis Inputs**

Use existing intersection PHF with a Minimum of 0.80. If existing PHF is unknown, use: 0.92 for arterials  
See Section 5.2
HCS Quick Input Guide
Two-Way Stop Control Intersection
(See Section 6.2.2.2)
Lanes Input Tab

- Project Specific Inputs
- Required Analysis Inputs

Grade should be considered whenever it exceeds 3% for more than 0.5 miles
See Section 5.1

<table>
<thead>
<tr>
<th>Percent Grade (%)</th>
<th>Eastbound</th>
<th>Westbound</th>
<th>Northbound</th>
<th>Southbound</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Right Turn Channelized
- Yes
- Yes
- Yes
- Yes

Flared Minor-Street Approach
- Yes
- Yes
- Yes
- Yes

Flared Minor-Street Storage (veh)
- Yes
- Yes
- Yes
- Yes
HCS Quick Input Guide
Two-Way Stop Control Intersection
(See Section 6.2.2.2)
Traffic Input Tab

<table>
<thead>
<tr>
<th>Priority</th>
<th>UTurn</th>
<th>Left</th>
<th>Thru</th>
<th>Right</th>
<th>UTurn</th>
<th>Left</th>
<th>Thru</th>
<th>Right</th>
<th>UTurn</th>
<th>Left</th>
<th>Thru</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume (vph)</td>
<td>50</td>
<td>350</td>
<td>60</td>
<td>70</td>
<td>330</td>
<td>80</td>
<td>20</td>
<td>80</td>
<td>70</td>
<td>20</td>
<td>60</td>
<td>40</td>
</tr>
<tr>
<td>Percent Heavy Vehicles (%)</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short Left-Turn Pocket</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left-Turn Storage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturation Flow Rate (vph)</td>
<td>1800</td>
<td>1500</td>
<td>1800</td>
<td>1500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Thrus Using Shared Lane (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Project Specific Inputs
- Required Analysis Inputs

Lane Utilization based on video or field observations
(See Section 5.6)
**HCS Quick Input Guide**

*Two-Way Stop Control Intersection*  
*(See Section 6.2.2.2)*  
*Headway Input Tab*

<table>
<thead>
<tr>
<th></th>
<th>Eastbound</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>UTurn</td>
<td>Left</td>
<td>Thru</td>
<td>Right</td>
<td>UTurn</td>
<td>Left</td>
</tr>
<tr>
<td>Base Critical Headway (sec)</td>
<td>4.1</td>
<td></td>
<td></td>
<td></td>
<td>4.1</td>
<td></td>
</tr>
<tr>
<td>Stage One Base Critical Headway (sec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stage Two Base Critical Headway (sec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stage One Critical Headway (sec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stage Two Critical Headway (sec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Base Follow-Up Headway (sec)</td>
<td>2.2</td>
<td></td>
<td>2.2</td>
<td></td>
<td>3.5</td>
<td>4.0</td>
</tr>
<tr>
<td>Follow-Up Headway (sec)</td>
<td>2.22</td>
<td></td>
<td>2.22</td>
<td></td>
<td>3.53</td>
<td>4.03</td>
</tr>
</tbody>
</table>

- Required Analysis Inputs

Use HCS default values for all Headway Inputs

*July 2020*
6.2 HCS Applications

HCS applications fall under two basic types: Uninterrupted Flow and Interrupted Flow. Volume 2 of the HCM 6th Edition defines the methods for Uninterrupted Flow applications, while Volume 3 defines Interrupted Flow applications. Interrupted Flow applications are shown on the left-hand side of the HCS module selection menu (Figure 6-1) and include:

- **STREETS** - Signalized Intersections, Ramp Terminals and Alternative Intersections, and Urban Street Segments and Facilities
- **STOP** - All-way stop control (AWSC) and two-way stop control (TWSC) intersections
- **ROUNDABOUTS** - Roundabouts

Uninterrupted Flow applications are shown on the right-hand side and include:

- **FREEWAYS** - Freeway Facilities
- **HIGHWAYS** - Multilane Highways, Two-Lane Highways

![Figure 6-1. Highway Capacity Software (HCS) Opening Window (source: McTrans)](image)

Additional tools are included with the HCS, including a traffic signal warrant analysis tool and a software implementation of predictive methods in the Highway Safety Manual, but these are not addressed in this guidance.

As a general note, the HCS Help function includes a searchable index, User’s Guide, and online video tutorials. Help related to a particular input can be obtained by pressing the F1 key after placing the cursor in that field.

6.2.1 Uninterrupted Flow Applications

Uninterrupted Flow applications in the HCS include Freeway Facilities, Multilane Highways and Two-Lane Highways. With respect to Freeways, prior to the 2010 Edition of the HCM (and HCS 2010),
freeway elements were evaluated individually for Basic Freeway Segments, Merge and Diverge Segments, and Weaving Segments. These methods were applied in isolation; that is, the effects of a bottleneck and resulting spillback on one segment were not accounted for in the evaluation of adjacent segments, either upstream or downstream. Beginning with the HCM 2010 and later enhanced in the HCM 6th Edition, the Freeway Facilities method combines these isolated segment analyses and accounts for the effects of congestion-related spillback over space and time. The current method therefore facilitates the evaluation of a freeway as an inter-related system of elements.

6.2.1.1 Freeways

The Freeways module in the HCS implements the Freeway Facilities method as documented in Chapters 10 and 25 of the HCM 6th Edition. This module also includes analysis options for individual freeway elements - basic segments, merge segments, diverge segments, and weaving segments, along with Freeway Facility options for individual segments and for planning (Figure 6-2). In the context of this guidance, only the full Freeway Facility analysis option is discussed.

Figure 6-2. HCS Freeways Analysis Selection Menu (source: McTrans)
When conducting a Freeways analysis, the Freeway Facilities method should always be performed in lieu of an analysis of individual freeway elements (i.e. basic freeway segments, merge and diverge segments, weaving segments, and overlap segments).

Analysis of individual segments may fail to capture potential bottleneck impacts at one segment on adjacent upstream and downstream segments. The Freeway Facilities method computes performance measures for each of the individual segments within a study section, includes the inter-segment impacts of traffic congestion on all affected segments, and provides overall performance measures for the entire study section. As stated in the HCM, the methodology is consistent with individual segment methodologies if all demand volume-to-capacity ($v_\text{d}/c$) ratios are less than 1.00 and it properly accounts for the interaction of segments when any $v_\text{d}/c$ ratio is greater than 1.00.\(^2\)

It is helpful to provide clarification about weaving segments, merge and diverge segments, and overlap segments. See Figure 6-3 below, which is Exhibit 10-1 from the HCM 6th Edition. Freeway merge and diverge segments occur primarily at entrance ramp and exit ramp junctions with the freeway mainline (footnote). Operating conditions on ramps can affect operations on ramps and ramp junctions, and vice versa. The HCM methodology therefore establishes a defined influence area of 1,500 feet upstream of the junction with an off-ramp and downstream of the junction with on-ramp - where interactions with mainline traffic are affected. The junction is defined as the nose of the painted gore area, These influence areas by definition are limited to mainline Lanes 1 and 2; that is, the two mainline lanes closest to the ramp. For mainline cross-sections containing more than two lanes in on direction, it is assumed the merge and diverge operations do not influence the traffic flow beyond the two closest lanes.

As described in the HCM, weaving segments are formed when merge segments are followed closely by diverge segments such that there is insufficient distance between the merge and diverge segments for them to operate independently. The HCM provides further definition that a one-sided weaving section must include a continuous auxiliary lane connecting an on-ramp to an off-ramp. The influence area of a weaving segment is 500 feet both upstream of the on-ramp and downstream of the off-ramp. In these influence areas, through traffic on the mainline is more likely to move to the outside lanes and avoid entering and exiting traffic through the weaving section.

An overlap area occurs when there is no auxiliary lane between an on-ramp and off-ramp, but they are closely spaced, less than 3,000 feet (1,500 feet for the on-ramp and 1,500 feet for the off-ramp) so that the influence areas overlap. This is illustrated in Figure 6-4 below, which is the diagram of the oversaturated Freeway Facilities example (Facilities2_Oversaturated.xud) included with the HCS. The merge segment (Segment 8) is so close to the diverge segment (Segment 10) such that the influence areas overlap (Segment 9) by 360 feet.

Figure 6-4. Freeway Facilities Example File Showing Weaving, Merge, Diverge and Overlap Segments (source: McTrans)
Global input parameters are identified and entered in the *General* window (Figure 6-5). These default parameters can be applied to all study segments (using checkboxes) but also can be overridden for individual segments.

![Figure 6-5. HCS Freeway Facilities General Input Window (source: McTrans)](image)

The example file (*Facilities1-Undersaturated.xuf*) illustrates a freeway study section consisting of eleven individual segments that include basic segments, merge and diverge segments, an overlap segment, and a weaving segment. The *Segments* window (Figure 6-6) includes a schematic diagram of the study section. The input window for the first segment is subdivided into parts for *Segment Data*, *Geometric Data*, *Demand Data*, and *Adjustment Factors* (Figure 6-7). In the *Segment Data* frame, a color-coded theme can be employed to visualize segment-specific performance measures—flow (volume), speed, density and Level of Service. Regarding specific input values, the analysis should consult the HCM 6th Edition, Chapter 10/Freeway Facilities Methodology, for guidance.
Figure 6-6. HCS Freeway Facilities Segments Input Window (source: McTrans)
The analyst should be aware that all Freeway methods are directional analysis methods; that is, each direction of travel is evaluated independently. Additionally, HCS files are created for separate directions of travel. Further, the freeway methods do not address interactions between freeway operations and operations at the ramp terminals; if queues spill back onto the freeway or are at risk of doing so in future years, then simulation should be used.

Freeways performance measures and reporting/output are discussed in subsequent sections of this manual.

6.2.1.2 Multilane Highways

Multilane highway segments are similar to basic freeway segments. They generally have four to six lanes (in both directions) with posted speed limits between 40 mph and 55 mph, although speed limits may be as high as 60 or 65 mph for some facilities. They may be undivided, divided with a physical median, or may have a center two-way left-turn lane (TWLTL). Their analysis method is very similar to that for Basic Freeway segments.

Figure 6-7. HCS Freeway Facilities Segment Data Window (source: McTrans)
A multilane highway segment HCS analysis is essentially the same as a basic freeway segment analysis, with some subtle differences related to factors that affect travel speed (e.g., lane width, lateral clearance, median type, and access point density). The most significant difference is that one HCS file is created for a bi-directional analysis. Inputs (see example file FiveLaneHighwayTWLTL.xuf) are entered in the Multilane window, which is subdivided into Project Properties, Geometric Data, Demand Data, Adjustment Factors, and Bicycle LOS (Figure 6-8). The methodology is multimodal in that it includes an evaluation of bicycle quality/level of service based on geometric, operational, and demand conditions.

![Figure 6-8. HCS Multilane Highway Input Window (source: McTrans)](image)

Although multilane highway corridors may include one or more signalized intersections, the individual segments are evaluated and reported independently, as are the signalized intersections. As discussed in the HCM, the influence area of traffic signals on multilane highways is typically about one mile, which means that uninterrupted flow may exist if traffic signals are spaced two miles or more apart.\(^3\) The analyst should consult the HCM for further guidance regarding the segmentation of multilane highways when traffic signals are located along the route.

\(^3\) HCM 6\(^{th}\) Edition, p. 12-4
Multilane highways performance measures and reporting/output are discussed in subsequent sections of this manual.

6.2.1.3 Two-Lane Highways

A new Two-Lane Highways method and chapter was approved by the Highway Capacity and Quality of Service Committee (HCQSC) and adopted for inclusion in the HCM 6th Edition. The method was developed as part of NCHRP Project 17-65, Improved Analysis of Two-Lane Highway Capacity and Operational Performance. At the writing of this manual, the new Chapter 15 to the HCM has not been published and distributed to registered users of the 6th Edition, but the new method has been incorporated into the HCS (Version 7.8.5) on the basis that it has been approved and adopted by the HCQSC. The previous method, currently described in the HCM 6th Edition, is included with HCS7 as well, but as a stand-alone executable file (TwoLane.exe) that resides in the folder ‘\2016 TwoLane.’

The new two-lane highway method is a directional analysis and separate HCS files are created for each direction. A two-lane highway is divided into segments and breaks between segments are defined by any change in specific characteristics (e.g., ability to pass, geometry, grade, lane and shoulder width, speed limit). Segmentation may be different for each direction because passing zones and other characteristics begin and end in different locations. Thus, the analyst must exercise care when defining highway segments. The results of each segment analysis are then combined to form a facility-level analysis.

Segment characteristics are entered in the Segments window. The example shown in Figure 6-9 (TwoLane3-FacilityAnalysisLevelTerrain.xuf) depicts a two-lane highway in five segments, one of which includes a passing lane and another a passing zone.
Figure 6-9. HCS Two-Lane Segments Window (source: McTrans)

Details of each two-lane highway segment are specified on the Details window as shown in Figure 6-10. In this example, Segment 2, which contains a passing lane, is highlighted, and the corresponding characteristics are shown in the Geometric Data frame. As with the Freeways module, a color-coded theme can be employed to visualize segment-specific performance measures.
Two-lane highways performance measures and reporting/output are discussed in Section 6.4.

6.2.2 Interrupted Flow Applications

Interrupted Flow applications involve Signalized Intersections, Urban Street Segments and Facilities, Stop-controlled Intersections (All-Way Stop Control and Two-Way Stop-Control), Roundabouts, and Ramp Terminals and Alternative Intersections. The HCS Streets module contains Signalized Intersections, Urban Street Segments and Facilities, Ramp Terminals, and Alternative Intersections. Any of these analyses can be performed within the Streets module.

The HCM Interrupted Flow methodologies separate an urban roadway into individual elements that are physically adjacent and operate as a single entity. Two elements are commonly found: points and links. A point represents the boundary between two links and is represented by an intersection or ramp terminal. A link is a length of roadway between two points. An urban segment, therefore, is represented by a link and its two boundary points. An urban street facility as defined in the HCM is a length of roadway composed of contiguous urban street segments and is typically functionally classified as either an urban arterial or urban collector street.

An urban street segment may include one or more mid-block access points where traffic volumes enter and/or leave the urban street segment. Mid-block access points are two-way stop-controlled intersections with no control on the major street and stop-control on the minor street approach(es). Within the Urban Streets method, only major street through vehicle delay is computed at mid-block

---

5 HCM 6th Edition, p. 16-6
access points; no performance measures are computed for the minor, stop-controlled approaches. To fully evaluate a mid-block access point, the TWSC method should be applied.

Within the HCS Streets module, either a single signalized intersection or multiple signals along an urban street corridor can be evaluated. When an urban street facility is involved, the HCS evaluates the individual urban street segments and then aggregates those into an urban street facility analysis.

The Streets module also is used to evaluate interchange ramp terminals and alternative intersections, either in isolation or as part of an urban street facility. Various interchange and alternative intersection types include:

- Diamond
- Partial Cloverleaf (PARCLO)
- Single Point Urban Interchange (SPUI)
- Diverging Diamond Interchange (DDI)
- Displaced Left Turn (DLT)
- Restricted Crossing U-Turn (RCUT)
- Median U-Turn (MUT)

Further descriptions and schematic diagrams of these interchange and intersection types are presented in Chapter 23 of the HCM 6th Edition.

6.2.2.1 Signalized Intersections and Urban Streets

Signalized Intersections, Urban Street Segments, and Urban Street Facilities all are evaluated within HCS from the Streets module. When a new file is created, the analyst may choose either the Classic mode - with all of the required inputs presented in tabular style interface - or the Visual mode. The Visual mode presents a grid where the user may draw nodes (intersections) and the links connecting them. When the user selects a link or node and then right clicks, a series of dialog boxes appear that mimic sections of the Classic mode interface. In these dialog boxes the data can be entered and edited.

Choosing New from the toolbar will present a Quick Start dialog box, in which the analyst can specify the number of intersections to be evaluated, along with other global input parameters (Figure 6-11). For an isolated intersection analysis, a 1 is entered in the Number of Intersections box. For an urban street segment or facility, the total number of signalized intersections is entered in this box, where each intersection pair is connected by an urban street segment.

---

6 Also referred to as a Double Crossover Diamond (DCD)
The **Forward Direction** is assigned to the direction of major street through movement that corresponds to NEMA Movement 2 (where NEMA Movement 6 represents the opposite direction through movement for the major street).

The HCS defaults to a single-period analysis (Number of Periods = 1) and an Analysis Duration of 0.25 hours (15 minutes). This then employs use of the Peak Hour Factor (PHF) to adjust the total 60-minute demand volume to an equivalent hourly volume for the peak 15-minute period.

In **Classic Mode**, the input window is divided into three main sections: **Primary Input Data**, **Detailed Input Data**, and **Multimodal Input Data**. These areas can be collapsed or expanded as needed. The **Primary Input Data** window is divided into five sections: **General**, **Traffic**, **Phasing**, **Phase Duration** and **Timing**. Basic data needed for the analysis are entered in these sections.

### Traffic section

In the **Traffic section**, saturation flow is a key input parameter. It is applied globally through the **Quick Start** dialog box but can also be specified locally to each lane group, where the global default can be overridden. Saturation Flow (along with Lane Width, Heavy Vehicles and Detector Length) can be adjusted globally after a new project has been started using CTRL + UP/DOWN arrows, which increases or decreases the input values uniformly for all lane groups. As defined in the HCM, **base** saturation flow rate is the equivalent hourly flow rate at which vehicles discharging from a queued state can traverse an intersection approach stop line if the signal was green 100 percent of the time and if no lost time was experienced. The base saturation flow rate can be thought of as an ideal flow rate with exceptionally favorable geometric and traffic conditions. The **adjusted** saturation flow rate represents the saturation flow rate for prevailing conditions (e.g., accounting for grades, trucks, etc.). Thus, the corresponding saturation flow adjustment factors based on prevailing conditions.

---

geometric and traffic conditions typically result in the *adjusted* saturation flow rate being smaller than the *base* saturation flow rate.

In general, one representative base saturation flow rate *should* be used for all lane groups. However, HCS allows the user to apply a different base saturation flow rate to any particular lane group where calibration difficulties are encountered due to other factors that are not easily quantified. Unless the analyst has a specific reason to use a different base saturation flow rate for one of the lane groups (in which case the justification for doing so shall be documented), the same value should be used for all lane groups.

Figure 6-12 shows the location of the base saturation flow rate in the Streets module.

Default saturation flow rates to be used are shown in Table 5-1.
Figure 6-12. Base Saturation Flow Rate by Lane Group in HCS Streets (source: McTrans)

Other inputs in the Traffic section that may have a significant effect on the outcome and of which the analyst should be acutely aware include Arrival Type, Upstream Filtering Adjustment Factor ("I" Factor), Initial Queue, and Right-Turn-On-Red (RTOR) volume.

The Arrival Type is a factor applied to the Platoon Ratio to describe the quality of signal progression for a corresponding movement group; ultimately the Platoon Ratio is used in the computation of the uniform delay ($d_1$) component of control delay ($d$) for each lane group. An Arrival Type 3 correlates to a Platoon Ratio of 1.00, where the Platoon Ratio is defined to be demand flow rate during a green cycle phase divided by the average demand flow rate during the whole analysis period. In other words, Arrival Type 3 has no effect, positive or negative, on the quality of signal progression. Arrival Type is used for isolated intersections only as the method produces an estimate for the Platoon Ratio.
An Arrival Type 3 should be used for all intersection analyses. The use of an Arrival Type other than 3 must be approved by ODOT and documented in the project analysis documentation.

The Upstream Filtering Adjustment Factor “I” accounts for the effect on vehicle arrivals from an upstream signal. It is a part of the incremental delay ($d_2$) component of the control delay ($d$) calculation. It is a function of the weighted volume-to-capacity ratio ($X$) for each contributing upstream movement. The upstream filtering adjustment factor ranges from 0.09 to 1.00 and a value of 1.00 is appropriate for an isolated intersection. The analyst must enter this value in HCS when evaluating a single intersection, but the value is computed automatically by the software within an urban street analysis involving multiple intersections. If signal spacing is greater than 3,200 feet, the intersection is considered to be operating in isolation and a value of 1.00 is used. Guidance on use of the upstream filtering adjustment factor is provided in Chapter 19 of the HCM.⁹

An Upstream Filtering Adjustment Factor (I) of 1.00 should be used for all isolated intersection analyses (i.e. analysis of a single intersection). When multiple intersections are evaluated in a single Streets file, the analyst should allow the I factor to calculate automatically based on the v/c ratio of the upstream signals.

The initial queue (expressed in number of vehicles for the lane group) “specifies the queue at the beginning of the analysis period, either observed in the field or carried over from the computations of a previous period. It represents the number of vehicles present in the movement group at the start of the analysis period and should not include vehicles in queue due to random, cycle-by-cycle fluctuations. When demand exceeds capacity for a given analysis period, the incremental unmet demand is carried over as the initial queue for the following period” (HCS Help: Initial Queue Length). Existence of an initial queue implies that demand exceeded capacity for that lane or movement group in the previous period. When this condition exists, the analyst may need to use TransModeler instead of the HCS and should consult with ODOT early in the study process.

Initial queue should be entered as zero for all intersection analyses.

The RTOR flow rate is a difficult parameter to estimate and can have a quantifiable impact on the analysis results. The RTOR is expressed as an hourly flow and should be measured in the field when possible. The HCM methodology subtracts the RTOR demand from the initial demand input before the adjusted flow rate is computed.

RTOR value should be 0 for all intersection analyses. At locations where RTOR movements are a significant component in intersection operations, TransModeler may be a more appropriate tool.

The methodology allows the analyst to include an unsignalized movement (e.g. a channelized right turn) in the signalized intersection analysis. This is done by selecting the ‘Unsignalized Movement’ checkbox for the qualifying movement. When unsignalized movement volumes are low, any delay associated with them will be low and typically can be ignored. If unsignalized movement volumes are high, it may be more appropriate to analyze the intersection using TransModeler.

---

The “Unsignalized Movement” checkbox should be checked, and the right turn volume entered for all free/yield right turn movements. “Unsignalized Delay” field will be zero.

**Phasing section**

The Phasing section is where the basic signal timing phasing scheme is set up for analysis. The vehicular and pedestrian traffic movements are defined by unique movement numbers in the HCM (Figure 6-13). (Note: Figure 11 is a re-creation of Exhibit 19-1 in the HCM 6th Edition.) Each movement is assigned a number and the letter “P” denotes a pedestrian movement. The numbers for each through and left-turn movement are the same numbers used in the scheme established by the National Electrical Manufacturers Association (NEMA). It is important to note that the orientation of the NEMA phasing scheme can be rotated to any orientation (e.g., Movement 2 becomes northbound for a north-south major street), but the relationship among all movements must be retained.

![Figure 6-13. Intersection Traffic Movements and Numbering Scheme](image)

Regarding signal phase sequencing, the HCM Signalized Intersections method employs an eight-phase dual ring structure (Figure 6-14) that allows for the concurrent presentation of a green display to two phases. As explained in the HCM, the dual ring structure is more efficient because it allows the controller to adapt phase duration and sequencing to individual phases. (Note: Figure 12 is a recreation of Exhibit 19-2 in the HCM 6th Edition.) Phases 1 through 4 occupy the top row of the dual ring structure and Phases 5 through 8 occupy the bottom row.

The direction of the major street (east/west or north/south) is established when the HCS project is created, with NEMA phases (movements) 2 and 6 being assigned to the major street approaches. In the standard NEMA scheme, the order of through movement and left turn phase numbers (2-4-6-8 and 1-3-5-7, respectively) increases in a clockwise direction. Modern controllers allow the minor street phase numbers to be “flipped” to the other side of Phases 2 and 6 (i.e., the numbers then would increase in a counterclockwise direction). While this practice is not recommended, it does occur. As seen in the Phasing section of the Classic Mode interface (Figure 6-15), HCS defaults to the standard NEMA orientation, although Phase 4 can be assigned to either minor street approach.

Cycle lengths of signalized intersections are interpreted as an explicit input (for coordinated operations) or an implicit output based on the green interval inputs (for uncoordinated operations). For coordinated signals, this input specifies the background cycle length applied to all signals in the corridor.
Other entries in this section include the offset, reference phase for progression in a coordinated system, and reference point in the cycle (i.e., either at the beginning or the end of the green phase). A fundamental assumption of the HCM Urban Streets method (as implemented in the HCS) is that the urban street facility being evaluated is composed of contiguous urban street segments, where NEMA phases (movements) 2 and 6 represent the through movements along that facility.

The Side Street Split Phasing checkbox specifies whether or not split phasing is in effect for the side street phases 4 and 8, meaning that phases 4 and 8 are displayed sequentially instead of concurrently” (HCS Help: Side Street Split Phasing).

The Uncoordinated Intersection checkbox flags an intersection to be analyzed as an isolated intersection instead of as part of an urban street facility.

The Phasing Wizard can be used by the analyst to define the phasing scheme in the NEMA dual ring format (Figure 6-16). This is an optional tool to assist; the analyst may choose to define the phasing manually by clicking in the individual sections of the dual ring graphic in the Phasing area of the input window.

![Phasing Wizard](source: McTrans)

The Field-Measured Phase Times checkbox is tied to the Phase Duration area of the input window. The HCM methodology for estimating control delay at a signalized intersection is based on pretimed operation in that the duration for each signal phase is constant. Under actuated control, individual
phase durations may vary as a function of the traffic demand. The HCM methodology includes a procedure to estimate an equivalent, average phase duration for the analysis period at an actuated signal as though it were a pretimed phase. The diagram in the Phase Duration section of the HCS input window is a reflection of those estimated average phase durations and sequences, as if the signal were operating in a sequential fashion in a pretimed mode. Actuated phases are indicated by gray arrows, while pretimed or maximum recall phases are indicated by blue arrows (Figure 6-17). The phase duration model is documented in the online Volume 4 of the HCM 6th Edition\textsuperscript{12} in Chapter 31. It is stressed that the values in - Pretimed/Maximum Recall Signal Phases

- Actuated Signal Phases

Figure 6-17 are outputs from the Phase Duration model and not user inputs.

\begin{center}
\includegraphics[width=0.5\textwidth]{phase_duration.png}
\end{center}

- Pretimed/Maximum Recall Signal Phases
- Actuated Signal Phases

Figure 6-17. Phase Duration Diagram (source: McTrans)

\textbf{Timing section}

In the Timing area of the Primary Input Data window, signal parameters for each of the movements are entered (Figure 6-18). The corresponding NEMA movement (i.e., Assigned Phase) is associated with each lane group based upon the dual ring scheme shown in the Phasing area. It should be noted that phase splits are entered for each lane group, where “a phase split represents the sum of the green, yellow change, and red clearance intervals for the phase” (HCS Help: Phase Split). For actuated movements, the Minimum Green entry “specifies the shortest amount of time that a green signal indication will be displayed” (HCS Help: Minimum Green). Checking the Lag Phase box changes the order of the subject left turn in the Phase Duration diagram above. The analyst should be thoroughly familiar with the functionalities of Recall Mode, Dual Entry, Dallas/FYA Phasing, and Simultaneous Gap (see the HCS Help file or Users Guide for details).

\textsuperscript{12} HCM 6th Edition, Ch. 31, pp. 31-2 – 31-21.
The **Detailed Input Data** window contains a wealth of information about signalized intersections, the urban street segments that connect them, and parameters that are applied globally. Because this window is collapsible (as is the subsequent **Multimodal Input Data** window), it is often overlooked or ignored. Each of the individual items on this window will not be discussed in this guide; it is the responsibility of the analyst to be familiar with all of them. However, key items are mentioned here. Many of these items address default values that are applied in the analysis. A number of these items affect the calibration of HCS analyses. Also, those parameters that apply only to a Streets analysis (i.e., multiple connected, signalized intersections) are not active when only a single intersection is being evaluated.

**General section**
- Default values for Stored Vehicle Length, Length of Detected Vehicle, and Stored Heavy Vehicle Length are located here.
- The calculated Queue Length Percentile can be selected - 50th, 85th, 90th, or 95th percentile queue lengths. **ODOT requires the 95th-percentile queue to be selected.**
- The Speed Limit to Base Free-Flow Speed (FFS) Ratio “specifies the assumed ratio of the posted speed limit to the free-flow speed” ([HCS Help: Ratio of Average Speed to Free-Flow Speed](https://www.wm.siu.edu/mtans/HCS/)). This is used in the computation of a number of parameters, including the maximum allowable headway (MAH) for each actuated movement, which is used in the calculation of actuated phase times and control delays. “Speed limits also are used in the computation of uniform stops and uniform queues” ([HCS Help: Ratio of Average Speed to Free-Flow Speed](https://www.wm.siu.edu/mtans/HCS/)).

**Intersection section**
- Designated shared lanes and the percent of turns occurring from a shared lane (for example, dual left turn lanes where one of those is a shared through/left turn) can be indicated here for individual lane groups.
- For two or more lanes in a lane group, Heaviest Lane Volume can be entered to compute the corresponding lane utilization factor.
- A specific Turn Radius can be entered for all left- and right-turning intersection movements.
These values are used primarily when the urban street includes Ramp Terminals and/or Alternative Intersections.

- An average Bus Blockage Time can be entered to “account for the impact of local transit buses that stop to discharge or pick up passengers at a near-side or far-side bus stop within 250 feet of the stop line (upstream or downstream)” (HCS Help: Bus Blockage Time). Similarly, an average Parking Maneuver Time “specifies the amount of time needed by a driver to execute a parking maneuver” (HCS Help: Working with Scenarios). Both of these parameters affect saturation flow rates on intersection approaches.

- Field-measured values for Proportion Arriving on Green can be used in lieu of default values. The proportion of arrivals on green impacts many aspects of the overall model, including queue service times, actuated phase times, and control delays.

**Segment section**

These items are used when conducting a *Streets* analysis involving two or more signals along an arterial or urban collector and connected sequentially by urban street segments.

- **Mid-Segment Delay** “specifies the average extra vehicle delay caused by “other” mid-segment sources, such as parking” (HCS Help: Segment “Other” Delays) beyond 250 feet of the downstream intersection stop line, and not quantifiable by other parameters in the HCS analysis.

- **Field Travel Speed** is a value that can be measured and used to override the parameter computed in the procedure. Similarly, the **Field Free-Flow Speed** can be measured and applied in a similar fashion. The measured **Field Travel Speed** is assumed to be lower than an estimated or measured **Field Free-Flow Speed** and affected by factors such as mid-block parking maneuvers or delays caused by mid-block ingress/egress movements.

- **On-Street Parking** reflects the percentage of the segment length with on-street parking, which is converted to a proportion for calculations.

**Signals section**

Default values for *Exclusive Pedestrian Phase Times* (if applicable), **Deceleration Rate** in response to a red signal indication, Critical Headway and Follow-Up Headway for permitted left turns are contained here. In most cases, these defaults will be sufficient for ODOT analyses. Under unique circumstances, it may be determined at the outset of the study that actual field data will be needed to either support the use of these default values or replace them with values that more accurately represent localized conditions.

**Access Point and Access Points sections**

Multiple mid-block access points can exist along a segment. For each access point, in the Access Points section, the analyst can enter movement-specific demand volumes, a PHF, and number of lanes for each movement at each approach. The **Location** parameter “specifies the distance from the active (i.e., more than 10 vph) unsignalized access point to the upstream signalized intersection” (HCS Help: Access Point Location) (where upstream is in the Reverse Direction that is served by Phase 6 direction according to the NEMA configuration).

These two areas both address mid-block access points that are part of a *Streets* analysis. The Access Point area includes default values for major street left turn Critical Headway and Follow-Up Headway parameters, a **Right-Turn Equivalency Factor**, **Maximum Turn Bay Length**, **Deceleration**
Rate, and Right-Turn Speed. These parameters apply to all mid-block access points in all segments of the urban street facility.

**Optimization section**

The HCS contains a robust traffic signal timing optimization toolset that includes optimization of cycle lengths, phase splits, and offsets, for a variety of objective functions. The analyst may choose between Quick Optimization and Full Optimization:

- **Quick Optimization** uses TRANSYT 7-F, the macroscopic simulation tool that is included in HCS. While this approach is faster, it does not always find a global solution (that is, the best solution within the defined parameters).

- **Full Optimization** is fully HCM-compliant as its Genetic Algorithm uses HCM procedures to optimize the selected objective function. While the run time is longer, it does find the global solution.

The HCS Full Optimization screen is shown in **Figure 6-19**. The analyst may choose to include all intersections along an arterial for optimization or may selectively omit one or more. The analyst also may choose to include or exclude cycle length, splits, offsets, and phasing sequence from the optimization.

![Figure 6-19. HCS Full Optimization Screen (source: McTrans)](image)

An important decision in any signal timing optimization is selecting the right objective function. Perhaps the proper approach to beginning any optimization should be to ask the question, “What are we trying to achieve through optimization?” This is the purpose of the objective function.

Objective functions generally fall within two categories:

1. **Throughput Maximization** - also referred to as “bandwidth maximization,” timing settings are adjusted to maximize traffic flow along an arterial. The tradeoff is that side street
delays are typically higher as the priority is given to arterial through traffic. Depending on the situation, major street left turns can be affected as well.

2. Delay Minimization - cycle lengths, phase splits and offsets are adjusted so that delay is minimized for all intersection approaches. For arterial streets, the tradeoff is that progression opportunities along the arterial are reduced, sometimes adversely.

The HCS offers a number of optimization objective function choices and these can be selected from the drop-down window on the optimization screen. The options are:

**Throughput Maximization**
- Percent Base FFS (that is, find the best LOS for the arterial using the service measure Percent Base Free-Flow Speed)
- Travel Time
- Travel Speed
- Arterial Stops

**Delay Minimization**
- Arterial Delay
- Overall Delay
- Balanced Delay

Within each group, the different objective functions all try to accomplish the same basic goal (either throughput maximization or delay minimization) but through slightly different ways. Balanced Delay is the approach that has been used by ODOT in the past. On the basis of average control delay in seconds per vehicle, it attempts to minimize delay for all approaches at an intersection. While this is thought to allow for an equitable comparison among intersection improvement alternatives, it severely penalizes through traffic movement along an arterial.

Within HCS, there is one other group of objective functions related to safety and environmental factors:
- Delay & Safety
- Delay & Emissions
- Delay & Safety & Emissions

These were added to HCS by McTrans at the request of public agencies and basically are combinations of throughput maximization and delay minimization objective functions.

The principles and fundamentals of signal timing optimization should be well understood by the analyst before they are applied to an HCS analysis and the analyst should consult the HCS User’s Guide for more details. The McTrans website also includes a short tutorial video ([https://mctrans.ce.ufl.edu/mct/index.php/hcs/tutorials/](https://mctrans.ce.ufl.edu/mct/index.php/hcs/tutorials/)) on HCS signal. Although it is based on the HCM 2010, the tool has remained unchanged with the HCM 6th Edition.
Signals should be optimized in HCS using the following process:

- Full Optimization
- Delay Minimization function with the objective of Balanced Delay
- Minimum of 50 generations
- Cycle length = 60 seconds (minimum), 120 seconds (maximum)

**Origin-Destination section**

This section supports evaluation of level of service by origin-destination (O-D) pair rather than by movement and is not used unless more than one intersection is being analyzed in a Streets analysis. As noted in the Help, “Changing the O-D seeds could affect the proportion of arrivals on green throughout the urban street system. The proportion of arrivals on green impacts many aspects of the overall model; including queue service times, actuated phase times, and control delays” (HCS Help: O-D Seeds). The analyst should consult Chapter 30 of the HCM 6th Edition (located in online Volume 4) for more information. Of note, the M row/column heading in the HCS O-D seed matrix correlates with Access Point movements in Chapter 30.

**Interchanges and Alternative Intersections section**

The Interchange Intersection checkbox is used to indicate whether an intersection represents a ramp terminal within a service interchange and the analyst then selects the type of interchange to be evaluated: Diamond, one of six partial cloverleaf (“Parclo”) types, a Single-Point Urban Interchange (SPUI), or Diverging Diamond Interchange (DDI). When the analyst clicks on EDTT Data, a box is opened in which the diverted distance traveled, and design speed can be entered to compute the extra distance travel time (EDTT) for each O-D movement. For a DDI, an additional Diverging Diamond Data dialog box appears into which further information related to the DDI is to be entered. The analyst should consult Chapter 23 – Ramp Terminals and Alternative Intersections, and Chapter 34 – Interchange Ramp Terminals: Supplemental of the HCM 6th Edition for more details.

The analyst should check the interchange Intersection checkbox, select the interchange type and enter the EDTT data for all interchange intersections. However, ODOT does not need the Interchange Results Report submitted. Results should be reported as individual signalized intersections.

Similarly, the Alternative Intersection checkbox is used to designate whether the intersection represents part of an alternative intersection; for example, Median U-turn (MUT), Restricted Crossing U-turn (RCUT), or Displaced Left Turn (DLT). The Upstream and Downstream buttons are used to locate/select HCS files for stop-controlled intersections representing the U-turn crossover junctions located upstream and downstream of the “main” junction of the alternative intersection being evaluated. For Alternative Intersections, a Segment section also appears in which free-flow speeds and lengths of adjacent segments are entered for the purpose of computing EDTT incurred by “displaced” movements.

6.2.2.2 Stop-Controlled Intersections

There are two basic types of stop-controlled intersections: All-Way Stop-Control (AWSC) and Two-Way Stop-Control (TWSC). The AWSC method computes control delay and a resulting LOS for each movement and approach leg, and then computes a weighted average control delay and LOS for the intersection as a whole. For TWSC intersections, control delay and LOS are computed for those approaches on the stop-controlled minor street approaches and for the major street left turns that must yield to opposing through traffic movements. Major street through and/or right-turn movements can incur control delay if served by the same lane as the major street left-turn movement. Control delay is computed for the major street approaches and whole intersection as part of the method, but a corresponding LOS is not reported for those values. For TWSC intersections, there is no weighted average control delay computed for the entire intersection, as the uncontrolled major street approaches would “wash out” the minor street stop-controlled and major street left-turn yielding approach values.

For AWSC analyses in the HCS, there is very little data entry involved. In the General window, aside from street names (which are optional), the analyst only needs to enter the analysis time period, which is typically 0.25 hours (15 minutes), and the PHF. As stated previously, HCM analyses typically are 15-minute analyses and the PHF is used to adjust the hourly demand volumes to a peak 15-minute period flow rate (in vehicles per hour).

As shown in the Lanes window for the example file AWSC2-MultilaneFourLeg.xaw (Figure 6-20), the graphic data entry tool is used to specify the intersection approach geometry in the top half of window. In the bottom half, hourly turning volumes are entered by the analyst, along with heavy vehicle (medium trucks plus heavy trucks) percentages for each approach. Also, where shared lanes exist and/or multiple through lanes exist at an approach, the analyst can specify the lane utilization split among multiple lanes as a percentage if supported by observed behavior in the field (also see the HCS Help).
Aside from the demand volumes and intersection geometry, the analyst has no control over any other parameters of the AWSC model.

![AWSC Lanes Window](image)

**Figure 6-20. AWSC Lanes Window (source: McTrans)**

The analysis for TWSC intersections is much more detailed, as reflected in the *General* input window (Figure 6-21), where the major street direction (either East-West or North-South) and median type are specified. If the major street is median-divided, then a value is entered in the *Major Street Median Storage* box. This value, expressed as number of vehicles (with a default value of 25 feet per vehicle assumed), indicates the number of vehicles that can be stored in the median. Additionally, a two-stage gap acceptance model is employed for minor street through or left-turning vehicles (crossing the near traffic lanes first and staging in the median until an acceptable gap in the far side traffic lanes becomes available second). Finally, if the intersection being evaluated represents part of a Restricted Crossing U-turn (RCUT) or Median U-turn (MUT), the appropriate box is checked here. For more information on the two-stage gap acceptance model, the analyst should consult Chapter 20 of the HCM 6th Edition.
The TWSC General Window allows the user to enter the intersection geometry, as well as the grade for the stop-controlled approaches (Figure 6-21).

Additionally, lanes serving stop-controlled right-turn movements can be specified as flared, and a storage value (in number of vehicles) can be entered here. Similarly, a channelized right-turn lane (also referred to as a “pork chop”) can be identified on this window (as in the example file TWSC3-FlaredApproachesMedStorage.xtw).
Traffic demand for a TWSC analysis is entered in the Traffic window (Figure 6-23) and includes an entry for heavy vehicle percentage. Also, major street approaches can have a short left-turn pocket and those are specified here. For major street approaches at TWSC intersections, an adjusted saturation flow rate is specified for shared through and right-turning movements.
Figure 6-23. TWSC Traffic Window (source: McTrans)

The TWSC Headway window allows the user to override the default values for Critical Headway and Follow-up Headway. These will be discussed in more detail in Section 6.5.2. Finally, adjustments for pedestrian volumes at all approaches and upstream traffic signals at the major street approaches (which affect downstream arrival patterns at TWSC intersections) are made on the Adjustment window.

6.2.2.3 Roundabouts

The HCS can be used to evaluate roundabouts with one or two approach lanes plus one bypass lane and one or two circulating lanes. Similar to Stop-controlled intersections, the duration of the analysis time period (typically 0.25 hours) and the PHF are entered on the General window. As shown in the example problem (Roundabouts1-SingleLaneRbtWithBypass.xro), configurations for the approach lanes and circulating lanes are specified on the Geometry window (Figure 6-24), including specifying whether bypass lanes exist. The number of conflicting circulating lanes for each section of the roundabout is determined by clicking within the roundabout. The number of approach lanes and lane use is determined in a similar manner. The yellow and green arrows are used to designate right-turn bypass lanes as yielding or non-yielding, respectively.
Figure 6-24. Roundabout Geometry Window (source: McTrans)

Entering traffic volumes and vehicle adjustments are entered in the Traffic window (Figure 6-25). Pedestrian crossing volumes are entered here as well. The critical headway and follow-up headway parameters that are used in the roundabout capacity calculations are specified here, either based on field-measured data or the suggested default values.

The methodology computes control delay and LOS for each entering lane, as well as a weighted average control delay and LOS for each approach and the roundabout as a whole. The method also computes a 95th-percentile queue for each entering lane.
6.3 When to Apply HCS Methods

6.3.1 Facilities vs. Points

The HCM defines a facility as a length of roadway, bicycle path or pedestrian walkway composed of a connected series of points and segments. Points are boundaries between links and are usually represented by intersections or ramp terminals. Within the HCM and as implemented in the HCS, there are two types of facilities analyses: Freeway Facilities (Section 6.2.1) and Urban Street Facilities (Section 6.2.2.1) (Figure 6-26).

When conducting a Freeways analysis, the Freeway Facilities method should always be performed in lieu of an analysis of individual freeway elements (i.e. basic freeway segments, merge and diverge segments, weaving segments, and overlap segments).

---

Figure 6-26. Facilities and Points defined by the HCM

As referenced in the HCM, an urban street is separated into individual elements that are physically adjacent and operate as a single entity in serving travelers.\(^\text{14}\) A link and its boundary intersections comprise a segment. An urban street facility is defined to be a length of roadway composed of contiguous urban street segments and is typically functionally classified as an arterial or collector street.

Within the HCS, the Urban Street Facilities methodology is applied when the analysis consists of one or more segments (i.e., at least two signalized intersections joined by a street segment). The HCM provides guidance on when signals should be evaluated as an urban street and when they can be analyzed as isolated intersections. If intersections are part of a coordinated signal system, they should be evaluated as an urban street.\(^\text{15}\) If signal spacing is greater than 3,200 feet, they can be analyzed as isolated intersections.\(^\text{16}\)

Signalized intersections spaced at least 3200 feet apart should be analyzed as isolated intersections. Use Arrival Type 3 and Upstream Filtering Adjustment Factor of 1.00.

6.3.2 Under-Saturation vs. Over-Saturation

Historically the application of HCM methods have been limited to under-saturated conditions; that is, when demand volume is less than capacity. Due to their deterministic nature, many of the methods were incapable of providing an accurate assessment when demand exceeded capacity, particularly when bottlenecks resulted in queue spillback that affected traffic flow upstream and downstream of the bottleneck. This is true for both uninterrupted flow and interrupted flow.

\(^\text{14}\) HCM 6th Edition, p. 16-6
Modern HCM methods (those contained within the 6th Edition) are better equipped to handle oversaturated conditions, especially the Freeway Facilities method. On the interrupted flow side, the Urban Street Facilities continues to be limited in its ability to consider effects of oversaturation, especially when queues propagate upstream to the point where they impede discharge flow from neighboring intersections. Where left-turn pockets spill back into through lanes due to demand exceeding capacity, the method does not account for a diminished saturation flow rate of the through lanes in advance of the turn bay entrance.

When QSR is greater than 1.0, the use of TransModeler should be considered.

6.3.3 HCS vs. TransModeler

Chapter 6 of the HCM 6th Edition is dedicated to the HCM and use of alternative analysis tools. Alternative tools are defined as all analysis procedures outside the HCM that may be used to compute measures of transportation performance for analysis and decision support. For the sake of this document, TransModeler will be the singular alternative analysis tool to the HCM methods as implemented through the HCS.

The HCS and TransModeler seek to accomplish the same objectives, albeit in different fashion. The HCM methods are macroscopic in that they deal with traffic flow in its entirety over an analysis period. The HCM methods are deterministic; that is, not subject to randomness and, with the same inputs, will produce the same answer every time.

TransModeler is a microscopic traffic simulation tool - it simulates the movements and trajectories of individual vehicles traveling through a network and, subject to constraints, incorporates the randomness (stochasticity), variability and uncertainty that reflects day-to-day traffic situations. Traffic simulation tools utilize random number seeds and multiple runs to account for this randomness. For more information on the conceptual differences between analytical methods like those in the HCM and simulation tools, consult Chapter 6 of the HCM 6th Edition, pp. 6-9 and 6-10.

ODOT provides specific guidance on when HCS is to be used and when TransModeler is to be used. Consult Chapter 3 for more information.

6.4 Performance Measures

A performance measure is a quantitative or qualitative characterization of some aspect of the service provided to a specific road user group. The HCM produces numerous performance measures for each method. Every method has one service measure, which is defined to be the performance measure upon which the LOS scale is based. In addition to the service measure, other performance measures generated by each of the methods typically are used in the evaluation of facility performance and in the decision-making process for transportation improvements.

---

17 HCM 6th Edition, p. 6-1
For each of the HCM methods (as implemented through the HCS) used by ODOT, the service measure dictating LOS and other key performance measures are listed in Table 6-1. For a facilities analysis, a single element having a d/c greater than 1.00 results in a facility-wide LOS F.

In the past it has been possible within some HCM methods to achieve LOS F when the demand is less than capacity, or to have d/c greater than 1.00 but not achieve LOS F. Beginning with the HCM 2010 and applied consistently across all methods in the HCM 6th Edition, LOS F is achieved when the service measure exceeds the LOS E/F threshold or when d/c is greater than 1.00. An example is shown in Figure 6-27, which is the LOS scale for signalized intersections from the HCM. The reason for this change is that the historical user perception has been that demand greater than capacity should equate to LOS F. For each method, a second LOS F criterion has been added where either the service measure exceeds the LOS E/F threshold or d/c is greater than 1.00. For a facilities analysis, a single element having a d/c greater than 1.00 results in a facility-wide LOS F.

<table>
<thead>
<tr>
<th>Control Delay (s/veh)</th>
<th>LOS by Volume-to-Capacity Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 10</td>
<td>A</td>
</tr>
<tr>
<td>&gt; 10 - 20</td>
<td>B</td>
</tr>
<tr>
<td>&gt; 20 - 35</td>
<td>C</td>
</tr>
<tr>
<td>&gt; 35 - 55</td>
<td>D</td>
</tr>
<tr>
<td>&gt; 55 - 80</td>
<td>E</td>
</tr>
<tr>
<td>&gt; 80</td>
<td>F</td>
</tr>
</tbody>
</table>

Source: Exhibit 19-8, HCM 6th Edition

Figure 6-27. HCM Signalized Intersection LOS Scale
Table 6-1. Performance Measures

<table>
<thead>
<tr>
<th>Method</th>
<th>Service Measure</th>
<th>Other Key Performance Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Uninterrupted Flow</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freeway Facilities (includes Basic Freeway Segments, Weaving Segments, Merge/Diverge and Overlap Segments)</td>
<td>Density</td>
<td>▪ Average Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Demand-to-Capacity (d/c) ratio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Space Mean Speed*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Average Travel Time*</td>
</tr>
<tr>
<td>Multilane Highways</td>
<td>Density</td>
<td>▪ Average Speed</td>
</tr>
<tr>
<td>Two-Lane Highways**</td>
<td>Follower Density</td>
<td>▪ Average Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Percent Followers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Travel Time</td>
</tr>
<tr>
<td><strong>Interrupted Flow</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Urban Streets</td>
<td>Travel Speed***</td>
<td>▪ Travel Time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Travel Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Base Free-Flow Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Auto Traveler Perception Score</td>
</tr>
<tr>
<td>Signalized Intersections</td>
<td>Control Delay</td>
<td>▪ Capacity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Demand Volume-to-Capacity (X) Ratio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Back of Queue (ODOT Requires 95th-Percentile)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Queue Storage Ratio</td>
</tr>
<tr>
<td>Unsignalized Intersections and Roundabouts</td>
<td>Control Delay</td>
<td>▪ Capacity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Demand Volume-to-Capacity (X) Ratio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ 95th-Percentile Queue Length</td>
</tr>
<tr>
<td>Interchange Ramp Terminals and Alternative Intersections</td>
<td>Experienced Travel Time (ETT)</td>
<td>▪ Control Delay</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Extra Distance Travel Time (EDTT)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Signalized Intersection Performance Measures (see above)</td>
</tr>
</tbody>
</table>

*Facility overall performance measure

**The research project NCHRP 17-65 resulted in a new Two-Lane Highways method. A new Ch. 15 has been approved for the HCM 6th Edition but has not been distributed yet by TRB. The HCS reflects the new method.

***The Urban Streets service measure is Travel Speed as a proportion of Base Free-Flow Speed.

An apparent discrepancy between the HCS and HCM 6th Edition is addressed here. In the HCM, one of the two performance measures used to characterize vehicular LOS for an urban street segment is average travel speed for through vehicles (volume-to-capacity is the other). The HCS uses travel speed as a percentage of base free-flow speed, which seems to contradict the current edition of the HCM. However, according to the LOS scale as presented in the 6th Edition, they are technically the same, as LOS thresholds are stratified according to base free-flow speed. The intent behind the change between the HCM 2010 (which is still used by the HCS) and the 6th Edition was to simplify the service measure so that it could be measured in the field. Figure 6-28 shows the difference in how this scale is organized between the HCM 2010 and 6th Edition. The results are the same, except the LOS A/B threshold changed from 85% in the HCM 2010 to 80% in the 6th Edition.
Calibration of HCS Uninterrupted and Interrupted analysis to field-measured local traffic conditions will only be used for Complex Type projects.

Calibration is defined in the HCM as the process by which the analyst selects the model parameters that result in the best reproduction of field-measured local traffic conditions by the model. In other words, with regard to HCS applications, data that measure existing traffic conditions should be collected and used to create HCS analyses of existing traffic conditions for which these calculated measures are in agreement with the collected data. As stated in the FHWA Traffic Analysis Toolbox: Volume 3, the objective of calibration therefore is to find the set of parameter values for the model that best reproduces observed measures of system performance.

The HCS modules contain many default values, where a default value is an average or representative value for a parameter to be used in the absence of actual data. The most common misapplication of the HCS is the acceptance of the default values that populate certain inputs; without some value present, computations cannot be completed. Wherever possible, values derived from actual data or refined estimates should be used in lieu of default values, especially as the calibration process involves the comparison of computed measures with those based on field observations.

Within the HCM (and as implemented through the HCS), calibration for facilities computational methods occurs at the component level. For example, for Freeway Facilities, calibration is applied to the Basic Freeway Segments, Ramp Merge and Diverge Segments, and Weaving Segments methods. For Urban Street Facilities, calibration is applied to the Urban Street Segments and Signalized Intersection methods.

For each HCM computational method there are numerous parameters which are based on collected or estimated data and for which default values are commonly used. Some parameters have a major effect on the computational analysis and results; thus, their accuracy is paramount. In general, calibration efforts should focus on these key parameters early in the model development process.

---

before then considering additional (and sometimes less influential) parameters. The practicality and feasibility of collecting data for some of these parameters should be recognized as well. What is the cost of collecting data for these factors? Is the benefit in line with the cost? Are there other issues such as safety that must be considered?
Table 6-2 lists the key calibration parameters associated with each of the HCM 6th Edition procedural methods and chapters. Primary parameters are those where initial calibration factors should be focused, followed by secondary parameters if needed and/or if resources are available. On a case-by-case basis, calibration efforts can include other additional parameters not listed in this table.
Table 6-2. HCS Calibration Parameters

<table>
<thead>
<tr>
<th>HCM Chapter</th>
<th>Method</th>
<th>Reference</th>
<th>Calibration Parameters&lt;sup&gt;2&lt;/sup&gt;</th>
<th>Primary</th>
<th>Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uninterrupted Flow Facilities</td>
<td>Freeway Facilities</td>
<td>Ex. 10-7, p. 10-20</td>
<td>- Free-flow speed</td>
<td>- Jam density</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Basic Freeway Segments and Multilane Highway Segments</td>
<td>Ex. 12-18, p. 12-25</td>
<td>- Free-flow speed</td>
<td>- Queue discharge capacity</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Freeway Weaving Segments&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Ex. 13-7, p. 13-13</td>
<td>- Free-flow speed</td>
<td>- Speed and capacity adjustment factors for weather and incidents</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Freeway Merge and Diverge Segments&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Ex. 14-4, p. 14-10</td>
<td>- Free-flow speed</td>
<td>- Speed and capacity adjustment factors for weather and incidents</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Two-Lane Highways&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Ex. 15-5, p. 15-12</td>
<td>- Free-flow speed</td>
<td>- Mid-segment delay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interrupted Flow Facilities</td>
<td>Urban Street Segments</td>
<td>Ex. 18-5, p. 18-15</td>
<td>- Free-flow speed&lt;sup&gt;4&lt;/sup&gt;</td>
<td>- Mid-segment stops</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td>- Average travel speed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Signalized Intersections (Auto)</td>
<td>Ex. 19-11, p. 19-23</td>
<td>- Saturation flow rate</td>
<td>- Initial queue</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Lane utilization</td>
<td>- Control delay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Average back of queue size&lt;sup&gt;3&lt;/sup&gt;</td>
<td>- Platoon ratio --&gt; proportion arriving on green</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Actuated phase average duration</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Start-up lost time</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Two-Way STOP-Controlled Intersections</td>
<td>Ex. 20-5, p. 20-10</td>
<td>- Saturation flow rate</td>
<td>- Critical headway</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Major street through movements</td>
<td>- Follow-up headway</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Major street right-turn movements</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>All-Way STOP-Controlled Intersections</td>
<td>Ex. 21-9, p. 21-11</td>
<td>- Saturation flow rate</td>
<td>- Critical headway&lt;sup&gt;2&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Departure headway</td>
<td>- Follow-up headway&lt;sup&gt;2&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Roundabouts</td>
<td>Ex. 22-9, p. 22-14</td>
<td>- Lane utilization&lt;sup&gt;6&lt;/sup&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Interchange Ramp Terminals and Alternative Intersections</td>
<td>Ex. 23-21, p. 23-29</td>
<td>- Origin-Destination traffic demand</td>
<td>- Actuated phase average duration</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Saturation flow rate</td>
<td>- Startup lost time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Lane utilization</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Free-flow speed</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Left-turn-on-red flow rate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes
1. NCHRP Research Project 07-26 is currently underway and is anticipated to provide an update to this method when complete
2. This method recently has been updated as a result of NCHRP Research Project 17-65 and has been incorporated into the HCS
3. Calibration parameters may be selected field data or performance measures
4. In the HCS, free-flow speed (FFS) is computed as an adjustment to the posted speed limit through the Speed Limit-to-Base FFS Ratio
5. Back of queue represents the maximum backward extent of queued vehicles during a typical cycle, as measured from the stop line to the last queued vehicle
6. Applies primarily to multilane roundabouts
7. Used for calibrating roundabout capacity model
6.5.1 Calibration of Uninterrupted Flow HCS Models

HCM Uninterrupted Flow methods contain adjustment factors that are available for calibrating related models:

- Capacity Adjustment Factor (CAF)
- Speed Adjustment Factor (SAF)
- Demand Adjustment Factor (DAF)

These factors are used primarily for reliability analyses where variation in traffic demands plus impacts on speeds and capacities due to weather and incidents are included. The adjustment factors also can be used at the to account for these impacts when data are collected for existing or base condition analyses. The analyst is advised to develop these parameters to adjust for local conditions or other effects (e.g., weather, work zones, incidents, etc.) that result in reduced capacity, free-flow speed, and demand, if deemed necessary. In most cases, use of the adjustment factors will not be necessary (and therefore they are equal to 1.00) but they provide the analyst with another tool if calibration efforts do not produce results within desired ranges.

CAF, SAF and DAF adjustment factors should be 1.00. ODOT approval is required for any other value and justification must be documented in the final project documentation.

For Freeway Facilities, a comprehensive list of capacity, speed and adjustment factors is provided in Chapter 11, Freeway Reliability Analysis. The Multilane Highway and Two-Lane Highway methods do not include an adjustment factor for demand.

The HCM 6th Edition online Volume 4 contains additional information on calibration of uninterrupted flow facilities. These include:

- Chapter 25 - Freeway Facilities: Supplemental,
- Chapter 26 - Freeway and Highway Segments: Supplemental,
- Chapter 27 - Freeway Weaving: Supplemental,
- Chapter 28 - Freeway Merges and Diverges: Supplemental.

6.5.2 Calibration of HCS Interrupted Flow Models

Calibration of HCS Interrupted Flow models occurs in two areas: 1) calibration of the Base Free-Flow Speed model in the Urban Street Segments model (HCM 6th Edition Chapter 18) and calibration of methods for individual point facilities such as Signalized Intersections and Unsignalized Intersections. In the Urban Street Segments method, the Base Free-Flow Speed equation contains a speed calibration factor ($S_{calib}$) that has a default value of 0.0 mi/h. The base free-flow speed prediction equation was calibrated by using data for many urban street segments located throughout the United States and is believed to be relatively representative of driver behavior in most urban areas. However, a locally representative value derived from field-measured estimates of base free-flow speed can be applied. A procedure for estimating base free-flow speed from field data is described in Volume 4, Chapter 30 - Urban Street Segments - Supplemental. Within the HCS, the speed calibration factor can be found in the Segment section of the DETAILED INPUT DATA menu in the Classic Mode or in the Segment Data tab of Segment Properties in the Visual Mode.

---

6.5.2.1 Signalized Intersections

The Signalized Intersection method is the most complex of all HCM methods and requires the most data inputs. Exhibit 19-11 in the HCM 6th Edition\(^{22}\) lists all of the required input data, potential data sources, and default values. Regarding model calibration, each of these data inputs can be considered as a potential calibration parameter, especially if the default value is used.

The analyst first must make the correct decision about how the analysis should be performed. Is the facility oversaturated? If so, then TransModeler should be considered. Is the signal part of a coordinated system and/or is it within 3,200 feet of another intersection? If so, it should be evaluated as a system using the Urban Streets method and not as an isolated intersection. Making the correct decision is an important first step in the calibration process.

If the signal operates under actuated control, the analyst must recognize that the HCM method uses a phase prediction model to estimate average green times for each phase as if the signal were operating in a pretimed mode. The HCS allows the user to insert actual field data in lieu of using the phase duration model; where practical, it is advisable to collect these data to check against the results of the phase duration model within the HCS or to use in lieu of the model. For more information, the analyst should consult Chapter 31 - Signalized Intersections: Supplemental of the HCM 6th Edition.

Queue length is another important calibration performance measure, as the Signalized Intersection methodology produces a back of queue parameter that is used in the calculation of the Queue Storage Ratio. As defined in the HCM, the back of queue is the position of the vehicle stopped farthest from the stop line during the cycle due to the red signal indication.\(^{23}\) Queue size is defined to include only vehicles that are fully stopped, for which the HCM considers 5 mph as a threshold.\(^{24}\) Data collection efforts involve counting the number of stopped vehicles in each lane at the end of the red phase (onset of green) in the subject lane group for each cycle. From these data, a cumulative distribution should be developed from which queue length percentiles (50\(^{th}\), 85\(^{th}\), 90\(^{th}\), and 95\(^{th}\)) can be computed. These values should be compared with the back of queue estimates produced by the HCM method. The HCM does not provide specific guidance as to which back of queue percentile should be used for calibration, but ODOT uses the 95\(^{th}\)-percentile and the analyst is advised to use that calibration metric for all lane groups. The methodology for estimating back of queue is described in Chapter 31 of the HCM.\(^{25}\)

It is important to distinguish between performance measures, targets and parameters in the context of model calibration. Refer to Table 5-2 for Calibration Targets. As an example,

- Queue length is a calibration performance measure by which a model can be compared to field observations to determine how well (or poorly) the model reflects those field observations.

\(^{24}\) HCM 6th Edition, Eq. 31-131, p. 31-67
\(^{25}\) HCM 6th Edition, pp. 31-70 – 31-77
- If the difference between the model’s estimation of queue length and the observed queue length exceeds a calibration target of a +/- 20% acceptable error threshold, the model is deemed not to adequately reflect field observations.

- The average vehicle headway (3,600 / Base Saturation Flow Rate) is a calibration parameter that can be adjusted by the analyst to invoke a change in the model’s estimation of queue length to better reflect observed field conditions.

An additional primary calibration parameter for signalized intersection analyses for which data should be collected is lane utilization. If multiple lanes exist in a lane group, lane-by-lane volumes should be collected. Lane utilization is a significant factor at interchange ramp terminals and other closely spaced intersections where drivers position themselves at the external approach of the upstream intersection in anticipation of a turning movement at an internal approach of a downstream intersection. Lane utilization data are entered in the Heaviest Lane Volume box of the DETAILED INPUT DATA window in the HCS. In the absence of field data, suggested default lane utilization factors are presented in Exhibit 19-15 of the HCM 6th Edition.

The HCM 6th Edition, Chapter 31 also includes a discussion on field measurement techniques for control delay. While this is listed in

---

Table 6-2 as a secondary calibration parameter, it is advisable for the analyst to perform a control delay study for undersaturated lane groups where feasible. Exhibit 31-43 in Chapter 31 includes an example worksheet for field control delay measurement and the methodology itself is relatively simple. While there are no known published targets for control delay as a calibration parameter, it is logical to assume that control delay estimates generated by the HCS should be within one Level of Service of control delay if it has been measured in the field.

For actuated signal control, the traffic signal phase duration is one other calibration parameter that can be considered. As explained in Phasing Section, the HCS phase duration model estimates equivalent green times for actuated phases as an approximation if they behaved as pretimed phases. This is because the HCM delay model is based on pretimed signal control. Where feasible, field observations should be conducted in which average green times are observed in the field for actuated signal phases and these should be compared to the results produced by the phase duration model.

Refer back to Figure 6-15 and Figure 6-16. The green phase lengths shown in Figure 6-15 are the estimated average phase times over the course of the peak hour for the actuated signal settings shown in Figure 6-16. The values in Figure 6-15 should be compared to field data if they are available. If the results are not reasonably comparable, then the signal timings as they were entered into the HCS should be checked closely with the signal timing plans as provided.

6.5.2.2 Stop Control Intersections

For All-Way Stop-Control (AWSC) analyses, there are no calibration parameters available in the HCS, aside from accurately quantifying the percent of through-traffic volume using a shared lane when multiple lanes serving the through movement exist at an approach.

For Two-Way Stop-Control (TWSC) analyses, saturation flow rate is a calibration parameter that should be considered. The HCM 6th Edition provides suggested default values for 1,800 veh/h for the major-street through movement and 1,500 veh/h for the major street right-turn movement. If field-measured saturation flow data are collected, they must be collected at signalized intersections (not stop-controlled intersections). If such data have been collected within the area of the subject TWSC intersection and conditions are representative of the site at-hand, then the analyst may choose to override the default saturation flow values if a better match between predicted and observed performance measures can be made.

Critical headway and follow-up headway for minor-street movements are additional calibration parameters that can be adjusted. These headway values are used to compute potential capacity, which in turn is used to compute control delay. The Signalized Intersections control delay field computational method (see HCM 6th Edition Chapter 31) can be applied to major-street left-turn and minor street movements; the analyst chooses a count interval of 10 to 20 seconds (this value should be applied consistently) and records the number of queued vehicles at each interval, from which the method defined in HCM 6th Edition Chapter 31 are applied to compute control delay. The Base Critical Headway and Base Follow-Up Headway values in the Headway window (Figure 6-29) can then be modified until the predicted control delay values provide an acceptable comparison.

---

with the field-measured control delay. It should be noted that control delay is more sensitive to adjustments to *Base Critical Headway* relative to adjustments to the *Base Follow-Up Headway*.

The default values for *Base Critical Headway* and *Base Follow-Up Headway* should be used. ODOT approval is required for any other value and justification must be documented in the final project documentation.

![Figure 6-29. HCS Critical Headway and Follow-Up Headway Window (source: McTrans)](image)

6.5.2.3 Roundabouts

Guidance for calibration of roundabout capacity models is provided in HCM 6th Edition Chapter 22. The roundabout capacity model is expressed as follows:

\[ c_{pe} = A e^{(-Bv_c)} \]

where calibration parameters A and B are a function of critical headway \( (t_c) \) and follow-up headway \( (t_f) \). More information on these calibration procedures is provided in Chapter 33 - Roundabouts: Supplemental.\(^{29}\)

6.5.2.4 Interchange Ramp Terminals and Alternative Intersections

Interchange ramp terminals and alternative intersections are discussed in detail in Chapter 23 of the HCM 6th Edition. The methods defined incorporate principles from other analytical methods (e.g., signalized intersections) but also consider the unique nature of these facilities and additional operational considerations such as experienced travel time (ETT) and extra distance travel time (EDDT) that must be considered. For these types of facilities, interrupted flow operational

\(^{29}\) HCM 6th Edition, pp. 33-6, 33-7
parameters like saturation flow and lane utilization have an even more significant impact. Calibration of these methods, therefore, must not be overlooked.

For the ramp terminals method, as stated in the HCM, both intersection turning movements and origin-destination (O-D) demands are needed. The reader is advised to consult Section 4.2.2 of this document for guidance on estimating intersection turning movement demand. The analyst also must include an estimation of O-D demand for the analysis, which will be developed by the ODOT Modeling & Forecasting group.

The ramp terminal methodology also makes additional adjustments to saturation flow rates to account for factors such as traffic pressure, lane utilization, and turning radii, depending on the interchange type. The analyst is directed to HCM 6th Edition Chapter 23 for more specific information on adjustments to saturation flow rate and other calibration parameters at ramp terminals. Additional information on these methods is provided in HCM 6th Edition Chapter 34 - Interchange Ramp Terminals: Supplemental.

6.6 Reporting/Output

Each module within the HCS provides a detailed, formatted result of the analyses. These reports are of professional quality and visually appealing; oftentimes they are sufficient as standalone reports to document the results of the analyses. Depending on the project, the type of analysis and the conclusion(s), the analyst may choose to use an alternative format to include a combination of tabular and/or graphical results.

While most modules only contain one formatted report, the Streets module contains several options. The Full Report option should be used for signalized intersection analysis.

6.6.1 Performance Measures

Regardless of analysis type, key performance measures should be presented. Those will vary depending on the method(s) applied and the information necessary for decision-making. At a minimum, the service measure and corresponding LOS should be reported. Additional key performance measures should be reported, especially in the case where Levels of Service E or F are computed.

6.6.2 Tables vs. Graphics

At a minimum, a tabular summary of performance measures should be provided, but graphics can be used to supplement the performance measure reporting. This may or may not require going beyond the HCS to generate the necessary graphics.

For example, the Freeway Facilities module in the HCS produces a themed graphic schematic to show certain performance measures for each segment (Figure 6-30). The computed segment-by-segment density for each time period (denoted TP1, TP2, etc.) using one of the example problems provided with the software.

This same information is presented in a heat map table (Figure 6-31). However, the results lack a schematic diagram of the study section geometry (Figure 6-32). The analyst is advised to amend this information so that such a schematic diagram is included with the graphical presentation of the results. The HCS does provide a color theme for various performance measures in this scheme, but only for a particular analysis period and not for multiple periods. When a heat map is developed, a schematic diagram of the study facility should accompany it. The heat map in

Figure 6-31 represents a multiple-period analysis (for five time periods), but ODOT has determined than only single-period analyses will be required. Thus, a single-period analysis heat map will contain only one row of results.

Figure 6-31. HCS Freeway Facilities Example Problem Heat Map (source: McTrans)
The Signalized Intersections module within the HCS provides a graphical report of results that includes average control delay, LOS, and queue length based on the percentile selected by the analyst (ODOT requires use of the 95th-percentile) (Figure 6-33). A color scheme for LOS is applied. Also, a color scheme is applied for the Queue Storage Ratio as a function of the percentile queue that is being reported. For a Queue Storage Ratio ($R_Q$) >1.00, a red line is shown instead of a black line, indicating queue spillback beyond the entered storage length. The results presented in this graphical summary are for a single analysis period. The ODOT position is to choose the full report option so that all text, tables and graphics are included.
Chapter 7. Traffic Simulation with TransModeler

7.1 Model Development

More than anything else, good traffic simulation practice, from calibration and validation to analysis of model outputs, begins with well-specified, well-organized model inputs. Care and attention to detail in the model’s development will help to avoid many problems that can arise later in the calibration and validation stage. The following sections provide guidance and best practices for developing a simulation model for various project applications in TransModeler.

7.1.1 About this TransModeler Guidance

The guidance provided in this section of the OATS, unlike other sections, will refer specifically to TransModeler SE and how it should be used to perform microsimulation analyses effectively, efficiently, and in accordance with ODOT’s broader project development objectives. This guidance includes both a high-level outline of the process one should follow to develop and calibrate a microsimulation model in TransModeler SE and specific step-by-step instruction regarding the various tasks in that process.

In this section of the guidance, reference will be made to tools, features, and help topics in TransModeler SE, a version of TransModeler designed specifically for simulation studies that are confined enough in scale and scope that they avoid more complex questions of routing, dynamic traffic assignment, tolling, advanced traffic management systems (e.g., ramp metering, variable speed limits, etc.), and detailed public transportation operations. TransModeler can be used to analyze these and other more advanced transportation systems, but this guidance will not cover those applications.

Either TransModeler or TransModeler SE can be used to perform all the same tasks described in this guidance. However, references to where certain tools or features are found in the software may vary between the two products. Please seek technical support directly from Caliper Corporation (TransModelerSupport@caliper.com) if you encounter any difficulty with applying the guidance found in this document with TransModeler.

An effort has been made to limit the breadth and depth of the guidance to support simulation work performed for ODOT. Where additional information may be useful, references to the titles of Help topics in TransModeler SE are provided in parentheses. Additional help in TransModeler can be found in the menu system at Help > TransModeler Help.

7.1.1.1 About TransModeler SE

Before reading this guidance, there are a few things to know about TransModeler SE. First, because TransModeler SE is a geographic information system (GIS), most of your work will be performed in a map - your window to a specific geographic location on the earth and where you will have immediate access to web-based satellite imagery and other geographic data and tools that will make model development easier and more efficient. Models of road networks are geographic files. Underlying the visual representation in a map window, features of the road network (e.g., lanes) can be viewed, sorted, queried, and edited as records, or rows, in a tabular dataview window with attributes of those features (e.g., lane widths) stored in fields, or columns, in the dataview.
This guidance will refer to layers in a simulation database or in a map. Road features, such as links and lanes, each make up a layer in the simulation database, and these layers, together with other geographic data such as satellite imagery, will make up an assortment of layers in a map. A working layer is often chosen in order to open a dataview of its records and fields or in order to label its features in the map. However, you do not have to be a GIS expert to use TransModeler SE. Only a quick, superficial recognition of its basic design will help you to use it more effectively. In using the software and this guidance, model development actions will broadly fall into two kinds:

1. Use of visual, interactive editing tools, most of which are organized by project workflow in a TransModeler Sidebar docked to the side of the application window, in a map (Section 7.1.3), and
2. Data entry in a dataview.

If you are comfortable in Google Earth or any other GIS, you will be comfortable in a TransModeler map, and if you can sort or filter data and use formulas in Excel, then you will quickly become proficient in a TransModeler dataview.
Figure 7-1. Introduction to the TransModeler SE Interface

7.1.1.2 Simulation Project Setup Process

The TransModeler Sidebar contains all the tools needed to create a network, enter traffic control and demand inputs, run simulations, and summarize simulation output in reports. These four broad steps to completing a successful simulation project are summarized in Figure 7-2 and are reflected in the organization of tools into four tabs on the TransModeler Sidebar: Streets, Intersections, Simulation and Output. While the process of setting up any simulation project should follow the order depicted in Figure 7-2, the process in practice is iterative, with network geometry and signal timings revisited and revised based on peer review and feedback and as new information becomes available well after the project’s development has begun. However, it is highly recommended that network geometry be largely and substantially completed using the tools on the Streets tab before entering signal timing and turning movement data with tools on the Intersections tab. Substantive changes to network geometry risk introducing errors in signal timing and turning volume inputs, though those errors can be subsequently detected with the help of error-checking tools (Section 7.1.3.5) and corrected.
7.1.2 File Organization

A simulation project in TransModeler is made from a collection of input files that can be shared across projects so that a minimum of input data is duplicated or maintained across scenarios. Though there is no single correct way to organize the input files associated with a TransModeler project, this section provides guidance on a recommended system that will make working with the project, including archiving and copying the project, easier.

7.1.2.1 Organizing Project Files

The simulation project file (.smp) is the “master” file for any project. It stores settings and the references to other files needed to run the project in the Project Settings, including signal timings, demand, and the simulation database (.dbd), which stores the model representation of streets and geometry.

Good file organization can make working with and sharing a project simpler. It is easiest when all files referenced by the simulation project are located within the same folder (or subfolders within that folder). That way, when a project is archived or copied, all the relative file paths will be local and will travel with the project.

The tutorials that come with the software (C:\Users\[user name]\Documents\Caliper \TransModeler SE 5.0\Tutorial) can serve as examples of how to organize files.

The recommended file organization structure is shown in Figure 7-3. The simulation project file (.smp) should be saved in the top-level folder (the Scenario Folder) and two subfolders should be created (the third is created automatically by TransModeler):

1. Inputs,
2. Simulation Database, and
3. Output (this folder is created automatically when the project is opened)
To run a simple model with no traffic signals, only two inputs are required: the simulation database and a source of demand. However, as models become more complex, there may be use for additional input files that are recommended to be saved inside the Inputs folder (Table 7-1).

Figure 7-3. Project File Organization Schematic
Table 7-1. Description of Inputs

<table>
<thead>
<tr>
<th>Input File</th>
<th>Extension</th>
<th>Function</th>
<th>Help Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial State</td>
<td>.ist</td>
<td>A saved loaded state of the network from which to start the simulation.</td>
<td>Setup</td>
</tr>
<tr>
<td>Signal Timings</td>
<td>.tms</td>
<td>Signal timings. Note, multiple time-of-day plans can be stored in the same .tms file. Stop signs/yield signs are part of the simulation database, not the signal timing file.</td>
<td>Creating Traffic Signal Timing Plans</td>
</tr>
<tr>
<td>Origin-Destination (O-D) Matrix</td>
<td>.mtx</td>
<td>Demand in the form of an origin-destination (O-D) matrix</td>
<td>Trip Matrices</td>
</tr>
<tr>
<td>Turning Movement Table</td>
<td>.bin, .dcb</td>
<td>Demand in the form of turning movement volumes at an intersection</td>
<td>Turning Movement Volumes</td>
</tr>
<tr>
<td>Incidents</td>
<td>.inc</td>
<td>Locations and properties of work zones and incidents</td>
<td>Editing Incidents and Work Zones</td>
</tr>
<tr>
<td>Pedestrians</td>
<td>.ped</td>
<td>Pedestrian crossing volumes</td>
<td>Pedestrian Crossing Volumes</td>
</tr>
<tr>
<td>Turn Prohibitions</td>
<td>.bin, .dcb</td>
<td>Sequences of links that vehicles are prohibited from traveling</td>
<td>Prohibiting Sequences of Links on a Path (Turn Prohibitions)</td>
</tr>
<tr>
<td>Parameters</td>
<td>.xml</td>
<td>Parameters values that differ from the default values</td>
<td>Parameters</td>
</tr>
</tbody>
</table>

The simulation database is a collection of several files with a variety of extensions but is commonly referred to by the .dbd extension. The simulation database is the first building block in a simulation project. A simulation project and its underlying simulation database can never be separated, though other input files can readily be added or removed from a project.

The Output folder is automatically created when you open an .smp so it does not need to be manually created. The location of the Output folder is defined in Project Settings on the Output tab. If the project has multiple scenarios, the Folder location should be modified to add the scenario name after Output so that scenario-specific outputs are saved in scenario-specific subfolders (Figure 7-4).

7.1.2.2 Defining Scenarios

Each simulation project can store any number of scenarios (e.g., AM Peak, PM Peak) that do not require a different underlying simulation database. To define different scenarios, simply change the Start Time and End Time of the Simulation Period and adjust the inputs as needed. Adjusting inputs may include defining a different set of fields for TransModeler to read from the same file already loaded or loading a different file. Some files can be shared among all scenarios, such as the signal timing file, which may have time-of-day plans that span the entire day. This reduces the need to
maintain multiple simulation project files and should make project and file management less prone to error.

A different underlying simulation database is required if there are changes to the network, such as an alternative interchange configuration or intersection geometry in a proposed build scenario. If such is the case, a copy of the simulation project should be made (which will also copy the simulation database), and scenarios of the alternative should be made in the new simulation project.

7.1.2.3 Copying Projects

As mentioned in Section 7.1.2.2, if changes in geometry are required to model a build alternative, then the simulation project should be copied. Copying a project copies all the input files in the original project, including the simulation database. Some input files contain references to features of the road network and hence may also require updating when the road network is modified to represent the build condition. However, a copy of every input file is not needed. The copies of input files that are not needed can be replaced with the originals in the new project’s Project Settings. This way, extraneous files and duplicate data can be minimized. After copying the project, the new simulation database should be edited to represent the geometric changes, and new scenarios should be made in the new simulation project.

To copy a project, choose File > Copy > Copy Project. Note that only input files referenced in the Project Settings are copied. Other files such as geographic layers displayed in the map are not copied. A Project Copy Summary will list which files were successfully copied, which files were copied but were located outside of the Scenario Folder, and which files were not copied (Figure 7-5) (Help: Working with Scenarios).

![Figure 7-5: Project Copy Summary of Files in Project Settings](image)

As a general rule, copies of turning movement tables and signal timing files are needed for build alternatives if the geometric changes involve changes to the way links and nodes intersect or to the movements that are allowed by lane connectors at an intersection. Simple geometric changes in segment geometry, such as addition of turn bays, do not require copies of turning movement tables.
or signal timing files. Typically, O-D matrices can be shared across all project alternatives, no-build and build, because they reference only boundary nodes or centroids where trips begin and end.

Copying a project works best when the project is organized as described in Section 7.1.2.1 because the relative path references to all input files will be preserved. If project files are in folders other than within the Scenario Folder (or subfolders within the Scenario Folder), a copy of the file will be placed in the Scenario Folder where the project is copied.

7.1.2.4 Archiving Projects

When you want to back up a project, send it to ODOT or another colleague working on the project, or to send it to Caliper Technical Support, the project can be archived. Like copying a project (Section 7.1.2.3), archiving a project collects all input files referenced in the Project Settings, preserving their folder locations relative to the Scenario Folder, and compresses them in a WinZip archive file (.zip).

To archive a project, choose File > Archive > Archive Project. Like copying a project, only input files in the Project Settings are archived, and a Project Archive Summary will list the files included in the archive (Help: Working with Scenarios).

7.1.2.5 Summary of Project Settings

Project Settings are the collection of inputs, options, and parameters that define a scenario. The settings include simulation start and end times, options for handling initial conditions at the start of a simulation, references to input files containing signal timings and traffic volumes, model parameters, and more. To add or remove scenarios or to review or change Project Settings, click the Simulation tab on the TransModeler Sidebar. Many settings are optional or assume reasonable default values that rarely need changing. Refer to Table 7-2 for a summary of the changes most commonly made in the Project Settings.
Table 7-2. Summary of Actions in Project Settings

<table>
<thead>
<tr>
<th>Action (&quot;Where do I...&quot;)</th>
<th>Tab</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the current scenario, add a new scenario, or rename or remove a scenario</td>
<td>Any</td>
<td>7.1.2.2</td>
</tr>
<tr>
<td>Change the start and end times of the analysis period</td>
<td>Setup</td>
<td>7.1.2.2</td>
</tr>
<tr>
<td>Change whether the simulation will begin with a warm-up period (and if so, the length of</td>
<td>Setup</td>
<td>7.2.4.2</td>
</tr>
<tr>
<td>the warm-up period) or with trips preloaded in the network</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename the simulation database (.dbd)</td>
<td>Setup</td>
<td>7.1.2.1</td>
</tr>
<tr>
<td>Change the traffic demand input files (i.e., turning movement volumes or O-D matrices)</td>
<td>Input</td>
<td>7.2.1</td>
</tr>
<tr>
<td>Indicate the start and end times of the period(s) to which the demand input files apply</td>
<td>Input</td>
<td>7.1.2.2</td>
</tr>
<tr>
<td>Add or remove signal timing inputs (.tms)</td>
<td>Input</td>
<td>7.1.4.1</td>
</tr>
<tr>
<td>Add or remove incident inputs (.inc)</td>
<td>Input</td>
<td>7.3.6</td>
</tr>
<tr>
<td>Add or remove pedestrian crossing volumes (.ped)</td>
<td>Input</td>
<td>7.1.3.2</td>
</tr>
<tr>
<td>Add or remove turning movement prohibitions (.bin)</td>
<td>Input</td>
<td>7.2.1.6</td>
</tr>
<tr>
<td>Choose the folder where all outputs will be created when simulations are run</td>
<td>Output</td>
<td>7.1.2.1</td>
</tr>
<tr>
<td>Choose which types of outputs to report before running a simulation</td>
<td>Output</td>
<td>7.4.1.3</td>
</tr>
<tr>
<td>Add a field in the simulation database where optional local parameters can be input</td>
<td>Parameters</td>
<td>7.3.5.2</td>
</tr>
<tr>
<td>Change the desired unit system for inputs and outputs (e.g., mi, ft, mph vs. km, m, km/h)</td>
<td>Parameters</td>
<td>7.1.4.3</td>
</tr>
</tbody>
</table>

7.1.3  Network Coding

This section provides guidance on how to create a road network, which is stored in the simulation database, and check for common coding errors. Network editing tasks, whether to create a brand-new network from scratch or to edit an existing network, are performed using the road editing tools on the Streets tab on the TransModeler Sidebar. The list of tools is available in the Help topic, “Editing Simulation Databases,” and is also copied below in Table 7-3. There are also step-by-step instructions on how to use each tool in the help topics that follow “Editing Simulation Databases.”

Changes to a road network are made in an “editing buffer” where they are pending edits until you click Commit , at which point the changes are saved to the simulation database. To undo all changes made in an editing buffer, click the Cancel . There is no undo option for road edits after changes in a buffer are committed, but every change that can be made with the road editing tools can be reversed. A link that has been split into two can be rejoined, a lane connector that has been deleted can be re-added, a turn bay that has been added can be removed by deleting the lane and rejoining segments, etc. Actions using the road editing tools will be described later in this section, but note that those actions are not complete until the editing buffer in which they are taken is committed.
## Table 7-3. Road Editing Tools in TransModeler

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select</td>
<td>Select a feature for editing</td>
</tr>
<tr>
<td></td>
<td>Info</td>
<td>Edit the properties of a feature</td>
</tr>
<tr>
<td></td>
<td>One-Way/Two-Way</td>
<td>Convert a two-way street to one-way or a one-way street to two-way</td>
</tr>
<tr>
<td></td>
<td>Separate</td>
<td>Delete the two sides of a two-way street into separate one-way links</td>
</tr>
<tr>
<td></td>
<td>Shared Center Lane</td>
<td>Convert an existing lane into a shared center two-way left turn lane (TWLTL)</td>
</tr>
<tr>
<td></td>
<td>Add Roundabout</td>
<td>Create a roundabout</td>
</tr>
<tr>
<td></td>
<td>Add Link</td>
<td>Add a new link to the network</td>
</tr>
<tr>
<td></td>
<td>Delete Segment</td>
<td>Delete a link or segment from the network</td>
</tr>
<tr>
<td></td>
<td>Join</td>
<td>Join two links or two segments together</td>
</tr>
<tr>
<td></td>
<td>Split</td>
<td>Split a single link into two links, or a single segment into two segments</td>
</tr>
<tr>
<td></td>
<td>Reverse</td>
<td>Reverse the direction of a one-way street</td>
</tr>
<tr>
<td></td>
<td>Smooth</td>
<td>Smooth the curvature of a segment (add or move shape points along a smooth curve)</td>
</tr>
<tr>
<td></td>
<td>Add Lane</td>
<td>Add a new lane to a segment</td>
</tr>
<tr>
<td></td>
<td>Delete Lane</td>
<td>Delete a lane from a segment</td>
</tr>
<tr>
<td></td>
<td>Add Turn Bay</td>
<td>Add a left (or right) turn bay at an intersection</td>
</tr>
<tr>
<td></td>
<td>Add Channelized Turn</td>
<td>Add a channelized right (or left) turn link at an intersection</td>
</tr>
<tr>
<td></td>
<td>Add Acceleration Lane</td>
<td>Add an acceleration lane at an on-ramp junction</td>
</tr>
<tr>
<td></td>
<td>Add Deceleration Lane</td>
<td>Add a deceleration lane at an off-ramp junction</td>
</tr>
<tr>
<td></td>
<td>Add Lane Connector</td>
<td>Add a new lane connector between two lanes</td>
</tr>
<tr>
<td></td>
<td>Delete Lane Connector</td>
<td>Delete a lane connector</td>
</tr>
<tr>
<td></td>
<td>Drag Stop Bar</td>
<td>Move the position of the stop bar along the connector</td>
</tr>
<tr>
<td></td>
<td>Drag Yield Position</td>
<td>Move the position where vehicles yield to opposing through movements</td>
</tr>
<tr>
<td></td>
<td>Drag Bend Points</td>
<td>Move bend points on a connector to change its shape</td>
</tr>
<tr>
<td></td>
<td>Add Sensor</td>
<td>Add a new sensor</td>
</tr>
<tr>
<td></td>
<td>Delete Sensor</td>
<td>Delete a sensor</td>
</tr>
<tr>
<td></td>
<td>Add Centroid Connector</td>
<td>Add a new centroid connector</td>
</tr>
<tr>
<td></td>
<td>Delete Centroid Connector</td>
<td>Delete a centroid connector</td>
</tr>
<tr>
<td></td>
<td>Add Crosswalk</td>
<td>Click in the map to add a pedestrian crosswalk</td>
</tr>
<tr>
<td></td>
<td>Delete Crosswalk</td>
<td>Click on a pedestrian crosswalk to delete it</td>
</tr>
<tr>
<td></td>
<td>Edit Pedestrian Volumes</td>
<td>Click on a pedestrian crosswalk to edit pedestrian volumes</td>
</tr>
<tr>
<td></td>
<td>Elevation</td>
<td>Edit the elevation profile of a link or segment</td>
</tr>
<tr>
<td></td>
<td>Label Elevation</td>
<td>Label the elevations of a segment’s shape points in the map</td>
</tr>
<tr>
<td></td>
<td>Cancel</td>
<td>Abandon the changes made in the current edit buffer</td>
</tr>
<tr>
<td></td>
<td>Commit</td>
<td>Save the changes in the current edit buffer to the simulation database</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Change the settings of the editing tools</td>
</tr>
</tbody>
</table>

### 7.1.3.1 Creating a New Network

There are four primary options for creating a new road network:

1. Coding from Scratch based on Satellite Imagery
2. Importing from Synchro
3. Importing from HCS
4. Exporting from Freely Available Statewide Simulation Databases

**Coding from Scratch based on Satellite Imagery**

For smaller and medium-sized study areas, it will often be simplest and most cost-effective to simply create the network from scratch using the road editing tools listed in Table 7-3 while using high-resolution satellite imagery as a reference. To create a new, empty network, make sure no project is open in TransModeler, and then do the following:

1. Choose **File > New**.
2. Choose **With a New Simulation Database**.
3. Click **Create a Map**. Note, this step will require an internet connection.
4. Choose U.S. Address, and enter the address information in the **Create-a-Map Wizard** (Figure 7-6). Alternatively, choose Canada/USA/Mexico, and enter a City and State.
5. Choose a web map layer to be included in the map from the **Map Layer** drop-down list.
6. Click **Finish**. TransModeler will open a map with the web map layer and return to the **New Simulation Project** dialog box.
7. Click **OK**. TransModeler will prompt for a file name for the simulation database.
8. Taking account of the file organization guidance provided (Section 7.1.2.1), enter a file name, and click **Save**.
9. Click the **Streets** tab on the **TransModeler Sidebar** to begin working with the road editing tools.

![Create-a-Map Wizard](image)

**Figure 7-6. The Create-a-Map Wizard for Creating New Networks**

When creating a new network, web map layers such as OpenStreetMap and Google Map are helpful resources for establishing location. Before drawing streets with the road editing tools, it will be most useful to use a satellite image layer such as Virtual Earth Map or Google...
Section 7.1.3.2 provides further guidance for developing road networks with the road editing tools and satellite imagery.

**Importing from Synchro**

A TransModeler network can be imported from a Synchro combined data file in universal traffic data format (UTDF). To import from a Synchro combined data file (.csv), choose *File > Import Traffic Data > Synchro Network* (Help: Importing Synchro Networks, Signal Timings, and Volumes). TransModeler will import the streets and geometry, turning volumes, and signal timings in formats that are simulation-ready. Road geometry, however, should be reviewed and can be revised with the road editing tools on the *TransModeler Sidebar*. TransModeler will not create roundabouts or channelized right turn islands when importing from Synchro, but dedicated road editing tools for roundabouts and channelized turns can be used to create them.

When you import from Synchro, you will have the option of specifying the coordinate system in which the node XY coordinates are defined, identifying the geographic location by clicking common points in a map, or disregarding geographic location. If the coordinate system in the Synchro model is not known or is not a geographic coordinate system (e.g., NAD83 or UTM), then choose the option to identify the geographic location by clicking in a map. Upon doing so, TransModeler will open a schematic representation of the Synchro links labeled with street names in a map on the left, a map of a specific geographic location of your choosing in a map on the right, and a toolbox for clicking common locations in the two maps (*Figure 7-7*). When the import is completed, TransModeler will open the project, and you may use the tools on the *TransModeler Sidebar* to review and refine the geometry, signal timings, and turning volume inputs.

![Figure 7-7. Importing a Network, Signal Timings, and Turning Volumes from Synchro](image)

**Importing from HCS**

A simulation project can also be imported from a Highway Capacity Software (HCS) file for urban streets. To import an HCS urban streets file, choose *File > Import Traffic Data > HCS File* (Help: Importing HCS Networks, Signal Timings, and Volumes).
Importing HCS Files). TransModeler will import the streets and geometry, turning volumes, and signal timings in formats that are simulation-ready.

**Exporting from Freely Available Statewide Simulation Databases**

Caliper has already created simulation databases for all freeways in the entire United States. Caliper has also developed significant road network coverage, including lower-class facilities such as collectors in some cases, in Ohio for Columbus, Cincinnati, Cleveland, Akron, Toledo, and Lima. These simulation databases are free to all users and can be requested directly from ODOT. A project can be created from these simulation databases by doing the following:

1. Choose **File > Open**.
2. Choose **All TransModeler Files or Geographic File** from the file type drop-down list and locate the geographic file with the .dbd extension.
3. Click **No** when prompted whether to open the simulation database in a new simulation project. TransModeler will open the Links geography and display their centerlines in a map. The centerlines can be labeled with street names by clicking **Labels** on the main toolbar and choose **Name** from the **Field** drop-down list.
4. Click **Selection** to show the **Selection** toolbar and use the tools on the toolbar to select the links you want to export in the map. Make sure you select fewer than 100 links and 20 intersections. By default, the links will be added to the selection set named “Selection.”
5. Choose **File > Export** to export to a new simulation database (**Help: Exporting Geographic Files**).
6. Choose the selection set (i.e., “Selection”) from the **Export** drop-down list and **Traffic Database** from the **To** drop-down list.
7. Click **OK**.
8. Enter a file name for the new simulation database in the **Save As** dialog box and click **OK**. TransModeler will export the selected links to a new simulation database.
9. Choose **File > Close** to close the map.
10. Repeat steps 1 and 2 above, and then click Yes to the prompt whether to open the simulation database in a new simulation project.

**7.1.3.2 Geometrics**

Roadway geometrics are defined in a simulation database. In a simulation database, *links* represent streets, and links are divided into *segments* to represent changes in cross-section geometry, where those changes include, but are not limited to, number of lanes (e.g., a lane is added or dropped), lane width, lane striping, grade, and horizontal curvature. *Lanes* are features of a segment and have their own geometric properties, such as lane width, and usage restrictions (e.g., high occupancy vehicle lanes). *Nodes* represent intersections, and *lane connectors* represent lane-to-lane movements between segments on the same link or between two links intersecting at a node. These elements - links, segments, lanes, nodes, and lane connectors - completely define the roadway geometry.

Other features of the simulation database, such as *centroids* and *centroid connectors* (**Section 7.1.3.4**) are important for microsimulation but do not describe roadway geometrics. Those features are described elsewhere in this document.
Satellite Imagery and Google Earth

Satellite imagery is a valuable resource for network development because it provides immediate, in-place visual cues and reference points to help you create and shape road segments and lanes to conform to lane striping, merge/diverge gores, stop bars, and roadway features and other lane markings that are visibly identifiable. TransModeler makes it simple to load satellite imagery by providing web map layers that automatically load imagery into a map window and update as you zoom in or out or pan around (Tools > Toolbars > Web Map Layers).

At times when the lane striping is worn or you want to see the signal heads, using the street view function in Google Earth is also advised. To use Google Earth (separate installation required), choose Tools > Toolbars > Web Map Layers to show the Web Map Layers toolbar, and then click Launch and interact with Google Earth (Help: Using Web Map Layers and Google Earth). It is worth noting that the Google satellite imagery and street view photography in Google Earth may not always be up to date. If recent roadway improvements have been made, a site visit may be necessary to accurately ascertain the existing condition.

Before a new link is added with the Add Link tool, the road class, number of lanes, lane width and directionality (one-way or two-way) can be set on the New Features tab of the Street Settings. Click on the TransModeler Sidebar to view the Street Settings. Additionally, to make it easier to align the roads with the satellite imagery, you can choose to make the road surface transparent during editing so that only the street’s edges and lane markings are visible. To do this, check Draw links and segments transparent on the Options tab in the Street Settings (Figure 7-8).
Adding a two-way link with transparent links and segments by clicking on the roadway centerline

Adding a one-way link with transparent links and settings by clicking on the left edge of the left-most lane

Figure 7-8. Adding New Links

However, it is also important to use engineering judgement when coding networks in TransModeler. At times, it may be justified to stray from what is observed satellite imagery. Drivers may in some circumstances use the road in ways that are contrary to what is implied or even expressly regulated by lane markings and signage. The objective in TransModeler should be to build a model that accurately reflects driver behaviors even if it does not strictly reflect the imagery. Figure 7-9 illustrates a few ways in which it may be necessary to deviate from the lane markings and geometry in order to simulate observed driver behaviors:

1. The length of the southbound left-turn lane can be increased if it is observed that drivers do not acknowledge the hatch markings limiting its length.

2. The westbound approach can be modeled as two separate turning lanes if it is observed that
drivers tend to form side-by-side queues within the single lane.

3. A channelized link can be added for the northbound right-turn movement if it is observed that drivers tend to depart the northbound through lane as the curve begins to form.

For example, flared lanes at intersections are often designed to be wide enough to accommodate more than one vehicle side-by-side but are not striped to be two lanes. Even in the absence of that striping, a short segment at the intersection should be coded with two lanes if drivers are known or observed to queue alongside one another while waiting for a gap.

![Road editing based on lane striping](image1.png) ![Road editing based on driving behaviors](image2.png)

Figure 7-9. Road Editing Based on Engineering Judgement

**Grade and Horizontal Curvature**

An effort to determine grades should be made when grade is known or expected to affect operations. As a rule of thumb, the Highway Capacity Manual (HCM) states that any uphill or downhill grades equal to or less than 2% on freeways and 3% on all other streets are considered to be “level terrain” (that is, roadway capacity within those thresholds are not significantly different compared to a road without grade). If it is determined that any road segment in the study area exceeds these thresholds, the local ODOT district should be consulted regarding the availability of grade data in the study area, whether from a statewide model network or statewide LIDAR data maintained by ODOT.

When grade data is available from these or other sources, grades can be manually entered in the Grade_AB and Grade_BA fields in the Segments dataview (Help: Segments). Fields with the prefix or suffix AB or BA indicate attributes that can vary by direction. The A-node-to-B-node, or AB, direction can be displayed visually in a map in TransModeler by showing arrowheads representing topology in the Segments layer style settings.
Horizontal curvature is automatically calculated based on the shapes of road segments, and the maximum speeds at which vehicles may travel are based on the horizontal curvature: *Simulation > Parameters > Vehicle Fleet > Performance > Maximum Speed > Horizontal Curve*. Segments should be split upstream and downstream of significant horizontal curves so that the local horizontal curvature that is automatically calculated will be as accurate as possible (Help: Effect of Horizontal Curvature on Maximum Speed). Figure 7-10 illustrates an example of this concept: the curvature of one segment representing a loop ramp with a long parallel freeway connector will inaccurately reflect the driving speeds along that segment (i.e., drivers will traverse the loop portion of the ramp too fast and the straight section that follows too slow). By splitting the segment at a point approximately where the loop ends, and the ramp becomes straight, a more accurate representation of the effects of the horizontal curve will be achieved.

Figure 7-10. Splitting Segments for Accurate Curvature
Elevation

The shape of a road segment is represented by shape points along the centerline (or left edge of the left-most lane, if one-way), which you can click and drag with the editing tools to change their longitude and latitude and, hence, the shape of the road. Each shape point also has an elevation. The elevation value can be used both for calculating grade and for visualization. The elevation value of a single shape point can be edited with the Edit Elevation tool on the Streets tab on the TransModeler Sidebar by clicking directly on a shape point. Alternatively, double-click on the segment somewhere other than on a shape point with the same tool to show the Edit Elevation dialog box (Figure 7-11), where the elevations of all shape points on the segment can be adjusted. The latter is the preferred method for coding elevation because it helps avoid discontinuous elevation changes between segments. (Help: Editing Segment Elevation).

Only a segment’s grade, not its elevation, will influence vehicle performance and driver behavior during simulation. However, the Edit Elevation dialog box pictured in Figure 7-11 does give the analyst the option to calculate the segment’s grade from the elevations of its shape points. The Update Grade box should only be checked if the grade should be calculated and used as input to the simulation.

It is not necessary for changes in elevation to be continuous across segments. The analyst may edit elevation solely for the purpose of achieving the visual effect of a grade separation without having any effect on a segment’s grade or vehicle performance. The analyst can accomplish the visual effect of grade separation quickly by choosing the Edit Elevation tool and, holding the UP key on the keyboard, single-clicking on the road that should pass over another near, but not inside of, the area where the two roads overlap. Alternatively, hold the DOWN key to click the road that should pass beneath the other. A new shape point should appear where the two segments cross.

If elevation changes abruptly between adjacent segments, there will be no adverse effect on the simulation and no simulation warnings will be generated, though the error-checking tools in TransModeler will highlight segments where abrupt changes occur should the analyst wish to identify and correct them for other reasons (e.g., 3D visualization).

Intersections

When coding the geometry of road segments at intersections, one of the first objectives should be aligning the ends of the links with the painted stop bars, if visible in satellite imagery or in design plans, on each approach using the Select tool. At approaches without visible stop bars, such as the major street approaches at two-way stop-controlled intersections (Figure 7-12), engineering
judgement should be used to position the ends of the links such that the lane connectors in the intersection trace a reasonable vehicle trajectory through the intersection.

Figure 7-12. Links on Approaches without Stop Bars

The stop bars of individual lanes can be re-positioned further downstream into the intersection, beyond the end of the link, using the Drag Stop Bar tool. Therefore, at approaches with staggered stop bars, the end of the link should be aligned with the most-upstream stop bar on the approach, and the Drag Stop Bar tool should be used to drag the stop bars of the other lanes to the appropriate position. Figure 7-13 shows the outlines of the road segments at an intersection with staggered stop bars.

Note that on intersection legs represented by two-way links with divided medians, you may be better able to shape the trajectories of lane connectors, and hence of vehicles as they travel through the intersection by holding the Ctrl key while editing the ends of segments on one side of the median with the Select tool. When you hold the Ctrl key to adjust the ends of segments with a median, you can move one side of the median independently of the other, and hence laterally offset the ends of the segments on opposite sides of the median.
A channelized turning movement is represented by a one-way link that intersects the approach link upstream of the intersection, where the turn diverges from the approach link, and the receiving link downstream of the intersection, where the turn merges with the receiving link. You can use the Add Channelized Turn tool to add the channelized turn by first clicking the approach link where the channelized lane diverges first and then the receiving link where the channelized lane merges.

**Pedestrians**

Pedestrian crossing activity can have a significant impact on traffic operations, and these impacts can be simulated in TransModeler. If significant pedestrian activity is known to be a factor at an intersection in the study area, the following steps should be taken to account for pedestrian impacts:

1. Add crosswalks using the Add Crosswalk tool on the Streets tab on the TransModeler Sidebar. Click on the lane connectors over which the crosswalk is positioned, generally just downstream of the end of the link. If the street is two-way, the crosswalk will be created in two parts: one for each direction of travel.
2. Use Select and click and drag the edges of each part of the crosswalk to change the angle of the crosswalk, or click and drag the center of the crosswalk to adjust its distance from the stop bar.
3. Enter pedestrian crossing volumes using the Choose Edit Pedestrian Volumes tool and clicking on either part of the crosswalk.
4. When prompted, create and save a pedestrian volumes (.ped) file. TransModeler will automatically add the file to the list of input files in the Project Settings.
5. In the Crosswalk dialog box, enter the crossing volumes in each direction and set the Distribution to Random.

**Roundabouts**

Roundabouts can be created at any intersection using the Add Roundabout tool (Help: Creating Roundabouts). The flare/angle of the links approaching the roundabout are adjusted by modifying the shape points of the approach and the circulating segments themselves, which will influence gap acceptance for vehicles entering the roundabout and, subsequently, the simulated operating capacity of the roundabout. Bypass lanes at roundabout approaches are created using the Add...
Channelized Turn tool described above. Modifying the stop bar position at roundabout approach lanes is the critical first step to realistically modeling gap acceptance tendencies. Multi-lane roundabout approaches are typically designed with staggered yield markings, which can either be modeled as a single link with a modified stop bar position (Help: Moving the Stop Bar on a Lane Connector) or as separate links for each lane (Figure 7-14).

Figure 7-14. Roundabout Stop Bar Positioning

The positions of stop bars will have an important influence on driver behavior, specifically relating to gap acceptance, and hence on the operating capacity of the roundabout (Section 7.3.5.2).

Freeways and Ramps

Freeways should be coded as one-way links instead of two-way links with medians to ensure accurate automatic designation of analysis type for freeway segment level reporting (Figure 7-15). To draw one-way links, click Street Settings on the TransModeler Sidebar to view the Street Settings dialog box. On the New Features tab in the Segments frame, check One Way. Or, when an editing buffer is active, the street settings can be accessed more directly on the Quick Street Settings tab on the sidebar.
On ramps and off ramps should meet the mainline link at the end of the painted area. In other words, assuming a right-side ramp, the vertex where the left corner of the ramp link and the right corner of the adjacent mainline link meet should be at the tip of the gore (Figure 7-16). If there is an acceleration lane downstream of an on ramp, then a segment with a full-width acceleration lane should be added for as long as there is a lane striping demarcating the acceleration lane. The Add Acceleration Lane tool on the Streets tab on the TransModeler Sidebar can be used to add an acceleration lane. Click first on the on ramp and a second time on the mainline link where the lane striping ends. Occasionally, there may be justification for adding a short acceleration lane even though the merge area is not striped for one in order to represent that length of the taper downstream of the ramp where merging vehicles from the ramp may travel briefly side-by-side with vehicles in the adjacent mainline lane. Judgement should be used in such cases, but the acceleration lane in the model should end at the point where it is not practical for vehicles to travel side by side for any part of their length. In TransModeler, one vehicle must be fully behind the vehicle in front, even if not fully centered in the lane, before it reaches the end of the lane connector at the downstream end of the lane.

The same applies for off ramps and deceleration lanes, but in reverse. The Add Deceleration Lane tool can be used to add a deceleration lane by clicking first on the mainline link where the striping of the deceleration lane begins (or where judgement dictates vehicles heading for the off ramp may travel side-by-side briefly with vehicles remaining on the mainline) and again on the off ramp.

Figure 7-15. Freeways as Separate One-Way Links
Figure 7-16. Freeway Merge and Diverge Segment Configurations
7.1.3.3 Lane Connectors

Lane connectors determine which movements are allowed at segment joints and nodes. Because they determine which movements are allowed, the lack of lane connectors also determine which movements are prohibited. A path is only possible if there are lane connectors for the specific movements along the entire path (Help: Lane Connectors). **Figure 7-17** illustrates lane connectors.

Lane connectors are added using the *Add Lane Connector* tool by clicking once on the lane the movement starts from and a second time in the lane to which the lane connector should connect. The map will provide feedback on which lanes are eligible connections (green) and which lanes are ineligible (red) when you hover your mouse over a lane after a lane has been identified with the first click. To delete a lane connector, use the *Delete Lane Connector* tool and click on a lane connector.

Lane connectors should not be used to facilitate lane changing. Rather, TransModeler will simulate lane changing maneuvers while vehicles are traveling on segments. In other words, diagonal lane connectors, as illustrated in **Figure 7-18**, should be avoided. For this reason, segment breaks and node breaks in general should be avoided if possible, particularly near intersections where output data will be collected.
Lane connector lengths should be a reasonable length needed to achieve the desired roadway geometry. For example, in Figure 7-18 the lane connectors are a reasonable length at about the length of a vehicle or less. There is not generally a need to make them longer or shorter unless the geometry requires it. Lane connectors that are too short can result in jumpy vehicle animation. Because lane changing maneuvers are not simulated while vehicles are traveling on lane connectors, lane connectors that are too long will limit lane changing opportunities and may thus impact operations.

The yield position of a lane connector determines where left-turning drivers will stop inside an intersection while waiting for a gap in the opposing movement. Yield positions are automatically calculated but can be manually adjusted using the Drag Yield Position tool (Help: Moving the Yield Position on a Lane Connector).

The connectivity bias attribute of lane connectors can be used to influence lane utilization. The connectivity bias can have a value from 0 to 1, where 0 means 0% of drivers are willing to use the lane connector and 1 means 100% of drivers are willing to use the lane connector. The connectivity bias is often used where there are lane drops as most drivers will be biased against the lane that is being dropped to avoid having to merge when the lane comes to an end. If it is believed that lane utilization phenomena are an issue at a specific site, the analyst should consider obtaining lane-level counts from permanent detector stations (i.e., if the signalized intersection operates under actuated control) or from manual observation. Obtaining this data for every intersection in the project would likely be too arduous and costly to be practical (Help: Lane Connectors). Based on empirical research of auxiliary through lanes (ATL) and on extensive sensitivity testing in TransModeler, a lane connector bias of 0.6 is recommended for lane connectors from a dropped lane if no other data are available.

In the context of modeling future-year proposed design configurations in which field data cannot be obtained, the use of modified connectivity bias values is discouraged in order to avoid the risk of influencing simulated driver behaviors to the point of overestimating performance.

### 7.1.3.4 Centroids and Centroid Connectors

Centroids in a simulation database represent origins and destinations of trips. Centroids may represent specific land uses (e.g., a commercial development, parking lot or garage, etc.) or TAZs (Figure 7-19), or they may simply be used to represent external stations or gateways at the boundary of a study area. Nodes on the boundary of a study area may also be used to represent the
origins and destinations of trips. Hence, centroids may not be necessary. Centroids are never used when turning volumes are used to represent input traffic demand (Section 7.2.1), but are particularly useful when using origin-destination matrices to define demand (Section 7.2.2).

Centroid connectors connect centroids to links in the simulation database to define where trips may enter the network when the centroid is the origin of a trip and where they may leave the network when the centroid is the destination of a trip. The road editing tools Add Centroid Connector and Delete Centroid Connector on the Streets tab on the TransModeler Sidebar are used to create centroids and centroid connectors (Help: Editing Centroids and Centroid Connectors).

![Centroid Representing a Specific Land Use and Centroid Representing a Traffic Analysis Zone](image)

**Figure 7-19.** Centroids Representing Specific Land Uses and Traffic Analysis Zones

### 7.1.3.5 Checking a Network for Errors

There are two ways to check a network for errors. The first way is to visually compare the network against satellite imagery (Section 7.1.3.2), and the second way is to run an error-checking routine to scan the road network for common coding errors (Help: Checking a Simulation Database for Errors). Choose **Tools > Error Checking > Check Network** to perform the scan. Features that are identified to have errors or potential errors will be automatically placed in selection sets with names beginning with “Check:” for review. The selection sets will be created in the corresponding map layer. To find the selection sets, click to show the Selection toolbar, change the working layer in the map, and choose a selection set name from the drop-down list on the toolbar (Figure 7-20). Individual network features that were selected for review can be quickly located in the map using the navigation buttons (Section 7.1.8.3).
Figure 7-20. Error-Checking with Selection Sets
7.1.4 Traffic Control and Management

This section provides guidance for proper specification of intersection control and traffic management inputs in TransModeler.

7.1.4.1 Intersection Control

The tools on the Intersections tab on the TransModeler Sidebar are used to define traffic control, whether unsignalized or signalized, at intersections.

Traffic Signal Timing

To the extent possible, signal timing data should be obtained to develop a simulation of existing conditions. The local ODOT district should be consulted to determine the appropriate source of existing signal timing information for the study area. If necessary, local agencies should be contacted to request the data. If signal timing information is not available, there are two options for estimating signal timings:

1. Observe and measure signal timings in the field during each analysis period.
2. Optimize signal timings using estimated turning volume demand or field-collected turning movement counts and assuming certain signal timing assumptions, such as minimum and maximum cycle lengths, ring-and-barrier structure, phase assignments, etc. (Help: Signal Optimization).

The local ODOT district should be consulted as to which method should be used on a project-by-project basis and to obtain concurrence on assumptions regarding signal timings for design-year scenarios. Signal timings in future design-year scenarios should be estimated by optimizing timings using turning volumes estimated from design-year demand.

Signal timings are entered using the tools on the Intersections tab on the TransModeler Sidebar. Create new timing plans or edit them by choosing the Edit Intersection Control tool and clicking on an intersection. TransModeler will open the Intersection Control Editor, where all phasing and timing variables can be defined. Delete signals and signal timings at an intersection using the Remove Intersection Control tool by clicking on the intersection.

If signal timings at closely-spaced intersections are operated by a single controller and timing plan, hold the Shift key when clicking on the intersection to open the Multiple Intersection Control dialog box. Continue to hold the Shift key while clicking intersections to add additional intersections.

When entering new signal timing plans in the Intersection Control Editor, choose Pretimed (Concurrent Phasing) or Traffic Actuated as the Control Type if the signals are pretimed or actuated, respectively (Figure 7-21).
Figure 7-21. Defining a New Signal Timing Plan with the Intersection Control Editor

Phasing and timing variables governing coordinated operation, including offset and reference point, are specified in the Phases tab (Figure 7-22).

Figure 7-22. Specifying Phasing and Timing in the Intersection Control Editor

For either pretimed or actuated control, a ring-and-barrier design is specified on the Ring and Barrier tab to determine which phases are served concurrently or in series and in what order (Figure 7-23).
The start time of the plan should be changed to reflect the time of day to which the signal timings apply. For example, click *Change* in the *Intersection Control Editor* and do the following:

1. For an AM peak scenario timing plan in which the time-of-day (TOD) plans are not explicitly known, set the start time to 08:00:00 (8:00 am) and enter the timing parameters that are fixed regardless of the time of day (ring-and-barrier design, yellow and all-red clearance intervals, RTOR restrictions, etc.), along with the plan-specific settings (phase splits, offset, etc.).

2. For a mid-day peak scenario timing plan in which the TOD plans are not explicitly known, create a new timing plan with a start time of 12:00:00 (12:00 pm) and choose the 08:00:00 plan created in Step 1 as the reference plan on which it is based. Check that the fixed settings are automatically copied over, and enter the remaining timings that are TOD-specific (e.g., phase splits, offset, etc.).

3. Repeat Step 2 for a PM peak scenario timing plan, entering a start time of 16:00:00 (4:00 pm) and choosing the 08:00:00 plan as the reference plan.

Choosing an existing plan as the reference plan when creating a new timing plan will reduce the data entry burden and error because TransModeler will keep timing inputs that should be fixed across all times of day synced each time you make changes to any of the plans that share a reference plan. Occasionally, the ring-and-barrier design might possibly change by time of day (e.g., permitted left-turn movements on major streets may be restricted during peak periods). If this is the case, such plans that stray from the template of the first plan should not be based on a reference plan.

**Detection for Traffic-Actuated Signals**

If the signal timings are actuated, automatically add or delete sensors for the traffic signal using the *Add Detectors* and *Remove Detectors* buttons, respectively (Help: Creating Traffic Signal
Timing Plans). The detector configuration that is assumed when adding detectors with these tools can be customized: **Tools > Traffic Signals > Edit Detector Defaults.** For sensors whose configuration does not match the detector defaults, use the **Add a Sensor** tool on the **Streets** tab on the **TransModeler Sidebar** and designate the **Vehicle Detection** type as Presence or Pulse. Once the sensors are added, they can be chosen to serve as call or extension detectors for a phase in the **Intersection Control Editor.** The phase to which a sensor is assigned can also be varied by the time-of-day plan.

![Phase Detector Default Settings](image)

**Figure 7-24. Phase Detector Default Settings**

**Stop or Yield Control**

To add stop or yield signs to one or more approaches at an unsignalized intersection, use the **Edit Intersection Control** tool and click on the intersection to open the **Intersection Control Editor.** Choose Stop or Yield as the **Control Type,** and identify which approaches have a stop or yield sign on the **Signs** tab. In the absence of signage at unsignalized intersections, yielding priority between conflicting movements is based on the road classes of the approaching links. Every road class has a **Priority** attribute (with “1” as the highest-ranking priority) that is used to help resolve right of way (**Section 7.1.5**).

7.1.4.2 Traffic Signal Optimization

**TransModeler** provides two ways of optimizing traffic signal operations: isolated signal optimization and corridor optimization.
Isolated signal optimization uses turning movement volumes to optimize the cycle length at a single intersection, while phase lengths are distributed in proportion to their degree of saturation. Isolated signal optimization is performed by using the Edit Intersection Control tool on the Intersections tab on the TransModeler Sidebar and clicking on an intersection in the map to open the Intersection Control Editor, and then by clicking the Optimization button on the Phases tab (Help: Signal Optimization).

Corridor optimization optimizes both the cycle lengths and offsets for a series of intersections along a specified corridor using simulation-based measures of effectiveness ( MOEs ). The simulation-based corridor optimization will work with simulation projects using either turning movements or trip matrices to define the demand. Corridor optimization uses simulation outputs to determine the best signal timing plans, so any warnings or significant queuing outside of the network (Section 7.3.2.1) should be resolved prior to running corridor optimization. To ensure that delays and queue lengths are properly reported in the simulation results on which the timing plans will be judged, superlinks should also be properly defined (Section 7.1.7) and a visual audit of the simulation should be conducted beforehand (Section 7.3.2).

On the Intersections tab on the TransModeler Sidebar, first define the corridor by choosing Add Waypoints and single-clicking a node at one end of the corridor and double-clicking a node at the other. The path between the points you click will be annotated in the map and should begin upstream of the first signalized intersection on the corridor and end downstream of the last Signalized intersections coinciding with the beginning or end of the path will not be included in the optimization. After confirming the path is properly defined, click Optimize the Corridor to open the Corridor Signal Optimization dialog box. Enter the parameters, including the weights for the various signal optimization MOEs, and then click Start (Help: Optimizing Coordinated Timing Plans).

Note that corridor paths can be defined along any sequence of turning movements (i.e., it is not limited to corridors oriented strictly in the EB/WB or NB/SB directions), but the signal phases that serve the movements along the designated corridor path must be set to Coordinated in the signal timings prior to running the corridor optimization.

Performance Index ( PI ) MOE Weights define the relative priority of the outputs collected during the optimization simulation runs and are used to compute the PI shown in the Signal Optimization Progress dialog box (Figure 7-26). Unless there is a compelling reason not to do so (in which case clear documentation is needed), the given default values for the PI MOE Weights should be used when optimizing a signalized corridor. If there are multiple possible cycle lengths to be considered, the PI for the best-performing plan at each cycle length is shown during optimization and after to
allow the analyst to compare the PI values between competing cycle lengths and choose the most desirable plan.

![Figure 7-26. Performance Index (PI) for Corridor Optimization](image)

In general, it is preferable to maximize the use of two-way links when developing arterial corridors, as it allows for two-way corridor signal optimization. However, there may be compelling reasons to code arterials as one-way links, such as modeling Superstreet or Median U-turn corridors, which typically feature separate coordination in both directions.

### 7.1.4.3 Speed Limits

When uninhibited by other vehicles or by traffic control, drivers in TransModeler will travel at a desired speed, a common driver behavior parameter in microsimulation. In TransModeler, the desired speed at which each driver chooses to travel is assumed to have a direct relationship with the posted speed limit: drivers are assumed to choose a speed based, in part, on the level of risk of receiving a speeding ticket (Help: Desired Speed Model). Further, speed limits may vary locally for a variety of reasons (e.g., school zones, work zones, curved ramps, etc.) that have important influences on traffic operations. For these reasons, it is important that speed limits be accurately defined.

Free-flow speed is also an important modeling concept but does not directly influence simulated driver behaviors. The free-flow speed is the average speed at which a road segment is traversed if all drivers travel at their desired speeds. Hence, the average desired speed on the segment should be very close to the free-flow speed. Free-flow speed has two other influences in TransModeler that should be noted:

1. If traffic demand is specified in an origin-destination (O-D) matrix, then the paths that vehicles take will be automatically computed by minimizing travel times based on free-flow speeds. (NOTE: This is true only of TransModeler SE. In TransModeler, there are other methods for defining the congested times that influence route choice).

2. MOE’s that determine the HCM level of service (LOS) for some facility types are based on
free-flow speed. Most notably, urban street LOS uses average speed thresholds that vary depending on the free-flow speed.

Speed limits vary by road class in TransModeler and can be reviewed or changed for all road links sharing the same road class Simulation > Road Classification > Edit Road Classes (Help: Road Class Definition). Speed limits can be found among a segment’s attributes though they are based on the road class of the link to which the segment belongs. This allows the speed limit on a segment to be more readily compared to the actual operating speed on the segment during simulation. To facilitate model review, speed limits can be displayed in the map as labels or with a color theme. To label segments, make Segments the working layer in the map, and click Labels on the main toolbar. To create a color theme on segments, make Segments the working layer in the map, click Color Theme on the main toolbar, and then click More Options.

When speed limits change locally and significantly, speed limit signs should be used to override the default speed limit using the Speed Limit Signs Toolbar: Tools > Toolbars > Speed Limit Signs (Help: Editing Speed Limit Signs). A driver in the simulation model will adjust their desired speed when encountering a speed limit sign, and the adjusted desired speed will prevail until the driver enters a link having a different road class than the previous link or when making a turning movement at an intersection. To restore the default speed limit of a road class after the reduced-speed area, a new speed limit sign showing the speed limit of the road class should be added. Figure 7-27 illustrates an example of adding speed limit signs in the context of a reduced-speed school zone with pedestrian crossings. Note that the speed limit values found in the segment attributes are only those derived from the road class and do not reflect the values displayed on speed limit signs.
Figure 7-27. Application of Speed Limit Signs in a School Zone
7.1.5 Road Classification

Road classification is important not only for establishing speed limits in the model but also for ensuring proper driving behaviors, namely as driving behaviors relate to merging onto a freeway, regulating right of way at intersections, and gap acceptance entering roundabouts. Road class ranking determines priority between turning movements where signage or signals do not explicitly regulate right of way (e.g., for left-turning movements from a major street to a minor street). TransModeler uses a road class' priority rank to determine which is the major street and which is the minor street (Help: Displaying and Editing Intersection Turning Movement Priority).

While the name given to a road class is not important, the names should be meaningful because of the implications they have for priority (e.g., one would expect movements from a Minor Arterial to have priority over those of a Local Street).

Also important in road classification in TransModeler are special types used to identify roundabout and freeway road classes. At roundabouts, the circulating roadway must use a road class having the special type designation Roundabout, and links intersecting the circulating links should not. Generally, links representing the splitter island should share the same road class as the upstream link (Figure 7-28). Defining the road classes this way ensures the proper yielding behavior for vehicles at roundabouts as well as for data entry of turning volumes at roundabouts.

On freeways, properly assigning road classes having special type designations Ramp and Freeway to entrance ramp and mainline links, respectively, is similarly critical for TransModeler to simulate merging and weaving behaviors as well as for proper data entry for weaving volumes.

When adding a new link with the road editing tools, the road class can be predetermined using the settings. Click Street Settings on the TransModeler Sidebar to define the road class of new links and other default properties for new streets.

The road class can be changed for existing links by making Links the working layer, clicking New Dataview on the main toolbar, and choosing an option from the drop-down list in the Class field for an individual record. Alternatively, you can show the dataview for a single link record by clicking on the link in the map using the Info tool.
To review road classification visually in the map, you can color links by road class: make Links the working layer in the map, click Color Theme on the main toolbar, choose Class from the Field drop-down list, and then click OK.

### 7.1.6 Naming Streets and Centroids

For purposes of data entry, map labeling, and organization of MOE’s in simulation output reports, it is important that street names be entered for all links in the network. It is useful, but not critical, when simulating traffic demand with O-D matrices to enter names for centroids.

#### 7.1.6.1 Naming Streets

The Links dataview (Figure 7-29) has a Name field where street names should be entered. While naming streets is optional, entering street names for every street will aid in data entry and output reporting. For example, naming streets will make it easier to enter signal timings because street names will be shown in the Intersection Control Editor and listed in drop-down lists on the sidebar, where choosing intersecting street names will automatically center the map on the intersection. In output reports, MOE’s will be grouped and sorted by street name.

Street names are entered for a link by making Links the working layer and clicking on it in the map with the Info tool. Fields will appear as rows and feature records as columns in the Info dataview. Enter the street name in the Name row.

To enter the same street name for multiple links at once, there are two options:

1. You can choose multiple links at once by holding the Shift key as you click links in the map with the Info tool. After selecting multiple links, right-click the Name field, choose Fill, and enter the street name in the Single Value box.

2. You can make a selection set of links using the Selection toolbar, or you may already have one for output reporting purposes. Make Links the working layer and click New Dataview to open the Links dataview. Right-click in the dataview, choose Show Selection, and choose the selection set name. TransModeler will display only the records in the selection set in the dataview. Right-click the Name field, choose Fill, and enter the street name in the Single Value edit box (Figure 7-30).
Importance of Street Names on Freeways

Street names are particularly important when it comes to freeways because output data in freeway LOS reports are automatically grouped by freeway name, sorted by distance from the end of the freeway, and labeled using the street names of arterials at adjacent interchanges. This makes freeway LOS reports easy to read and digest. However, the following are critical for the freeway LOS reports to be correctly and accurately grouped, sorted, and labeled:

1. Street names for freeway links must be consistently named.
2. Direction must be included in the name (e.g., “I-70 EB”).
3. Every link in the sequence of links making up the freeway facility must be named. Unnamed links will be omitted from the output report.
4. Street names must be entered at the arterials at the ends of ramps or, if the arterials are omitted from the network, names including the arterial street name should be given to the ramp links.

To label streets with their names in the map, make Links the working layer, click Labels on the main toolbar, and choose Name from the Field drop-down list.

7.1.6.2 Naming Centroids

The Centroids layer has a Description field where you can enter a name or description of each centroid. This will help with data entry in, and QA/QC of, O-D matrices. You can edit the descriptions of centroids by making Centroids the working layer, clicking on a centroid in the map with the Info tool, and entering a value in the Description row.
7.1.7 Superlinks

A superlink is a continuous sequence of links that together make up a span of the same street. Superlinks are critical for proper reporting of intersection LOS and queue measurements. Links themselves must often be split for a variety of reasons, such as to accommodate an important driveway or channelized turn, and so are not always convenient demarcations of streets for which to report measurements such as delay and queue length, which originate at an intersection but spill upstream across a multitude of links.

Superlinks give you control over delay and queue reporting and should be carefully specified. The links in Figure 7-32 are labeled with their IDs. If a queuing analysis were conducted for the eastbound approach, queues on Link 3 alone would be insufficient. Creating a superlink out of Links 1, 2, 3, and 4 ensures the queues and delays for the eastbound approach will be properly reported (Help: Defining Superlinks for Output Data Collection).

Three typical examples demonstrating the proper specification of superlinks in various contexts and settings are described below.

Figure 7-32. Superlink Example
Superlink Example 1: Channelized Right Turn Lanes

In the scenario depicted in Figure 7-33, the channelized right turn lane at the southbound approach to Node 10 (Link 3) is coded as a separate link. This causes the southbound and eastbound approaches of Node 10 each to be divided into two links. As a construct for modeling transportation networks, links and nodes in TransModeler offer enormous power and flexibility to capture the effects of geometry on operations accurately for nearly any geometry. As output reporting elements, links in this scenario are poor delineation of an intersection approach. At the southbound approach, Links 1-2-3 are defined as a superlink, allowing delay and queue lengths for the left- and right-turning movements to extend beyond Node 11. Likewise, at the eastbound approach, defining Links 4-5 as a superlink allows delay and queue lengths for the left-turning and through movements to be collected beyond Node 12.

Figure 7-33. Superlinks at a Channelized Right Turn Lane
Superlink Example 2: Roundabouts with Splitter Islands

Similar to channelized right turn lanes discussed in Example 1, roundabouts such as those depicted in Figure 7-34 are often designed such that the lanes serving the entering and exiting vehicles on a given approach are separated into two one-way links. The links on the same approach should be grouped together into the same superlink, allowing delay and queue lengths to be measured beyond the upstream nodes immediately adjacent to the roundabout.

Figure 7-34. Superlinks at Roundabouts with Splitter Islands
Superlink Example 3: Nodes in the Middle of Superlinks

In the scenario depicted in Figure 7-35, queues on the northbound approach to Node 10 are likely to exceed the lengths of Link 1. Similarly, queues on the southbound approach to Node 11 will likely exceed the length of Link 2. Therefore, Links 1-2 are defined as a superlink so that queuing and delay output will be collected over the combined length of both links.

Combining Links 1 and 2 into a single superlink makes it possible to attribute delays and queues to the appropriate source. However, combining Links 1 and 2 into a superlink also results in the loss of delay and queue length reporting at any nodes in the middle of the superlink, such as at Node 12. It is important to take this into consideration when defining superlinks. If delay and queue lengths at Node 12 are an important measure of performance, then this superlink should not be created, and steps will need to be taken in the presentation of the delays and queue lengths reported at Nodes 1 and 2 so that they are not erroneously interpreted.

The Superlink Manager (Output > Superlinks > Superlink Manager) is used to create, remove, and modify superlinks (Help: Creating and Modifying Superlinks Using the Superlink Manager).

To review superlinks visually in the map, you can color links by superlink: make Links the working layer in the map, click Color Theme on the main toolbar, choose Superlink from the Field drop-down list and List of Values from the Method list, and then click OK.

7.1.8 Selection Sets

A selection set is a group of records in a single map layer or dataview (Help: Selection Set Basics). They are extremely useful for identifying a subset of features for which you want to enter data or create a report. Some helpful utilities in TransModeler, including the error checker described in Section 7.1.3.5, will create selection sets automatically. You can use the Selection toolbar to create and manage selection sets and to browse map features in a selection set in the map.
7.1.8.1 Creating Selection Sets

To create a selection set, make the layer of interest the working layer. Click 🗃️ to show the Selection toolbar. Features can be selected with selection tools or with a query. The first four tools on the Selection toolbar (▶️ ▶️ ▶️ ⬇️) are used to select features on the map either by single-clicking directly on the feature or drawing a shape around features (Help: Selecting Features with the Selection Tools). To select features using a query, click 🌐 to open the Select by Condition dialog box and enter a query (Help: Selecting Features Based on Attributes).

Selection sets may be useful for no other purpose than to help you manage the data in your project. Some examples of useful selection sets include the following:

1. Signalized nodes
2. Nodes with turning movement counts
3. Segments with traffic counts
4. Weaving segments
5. Freeway links
6. Lane connectors with modified lane connectivity biases

7.1.8.2 Common Uses for Selection Sets

Specific applications for which selections sets are often used include the following:

1. Entering data: Features that share a common attribute value can be placed in a selection set to make data entry easier. Some examples of this include links that have the same street name (Section 7.1.6.1 - Naming Streets), links that have the same road class, and lanes that have the same widths.
2. Error checking: When the Check Network utility is run, features that have errors will automatically be placed in selection sets (Section 7.1.3.5).
3. Output reporting: When producing output tables or reports, you may choose to include only a subset of features (e.g., intersections) in the reports or tables.

7.1.8.3 Navigating to Features in a Selection Set

You may often find yourself wanting to navigate to features in a selection set in the map in order to review them, such as when selection sets are created for error-checking purposes. To navigate to features in a selection set in the map, choose the name of the selection set from the drop-down list on the Selection toolbar, and click Next Record or Previous Record 🎭 to the right of the drop-down list.

7.1.9 Dataviews and Supplementary Model Data

In many ways, dataviews are like spreadsheets. You can add columns (i.e., fields) and fill them with data manually or with values calculated from other columns using formulas. Dataviews allow you to augment the data TransModeler uses internally to represent the road network with your own data, most commonly for calibration, validation, or related purposes (Section 7.3.3). You can add fields in a dataview and fill it with values by doing the following:

1. Make the layer of interest the working layer.
2. Click New Dataview 📊 to open the dataview.
3. Right-click in the dataview and choose Modify.

4. Click Add Field and enter a field name in the Field Name column.

5. Enter text describing the contents of the field (e.g., the data source and/or date of a count) in the Field Description box to aid reviewers of the model.

6. To enter data, do one of the following:
   
   i. For a single feature: Use the Info tool on the main toolbar to click on a feature of the layer in the map and enter data in the Info dataview that appears.
   
   ii. For multiple features at once: Holding the Shift key, use the Info tool on the main toolbar to click on features of the layer in the map one at a time, or click and drag a circle around the features. You may need to expand the width of the Info dataview that appears or scroll left/right to see all the selected features in the dataview. Click the field in the Info dataview for which you want to enter data so that the entire row is highlighted. Right-click and choose Fill. Enter a value next to Single Value.

To enter, for example, directional counts, make Segments the working layer. Because counts and other data may vary by direction on two-way streets, you may need to add a pair of fields with the same name but with “AB” and “BA” prefixes or suffixes. The value in the AB field is interpreted as the value for the direction of travel from the link’s A node to its B node, a direction that is for all intents and purposes arbitrary for two-way links but is always in the direction of flow on one-way links. Therefore, data entered for one-way segments is always entered in the AB field. The AB direction is called the topological direction and is always the same direction for links and all segments belonging to the same link. To view the topological direction in the map as an aid while entering data, make sure Segments is the working layer, click Layer Style on the main toolbar, and check Topology.

7.2 Demand Input Development

Of all aspects involved in a simulation study, demand is the most challenging to measure, manage, and forecast accurately. As study areas grow, the degree of complexity generally increases. Simulation projects are thus identified with one of three types – Type I, Type II, and Type III – according to the format in which the demand should be specified. The appropriate demand format (e.g., turning movement volumes or O-D matrices, mix of passenger cars versus trucks, etc.) are based on the nature and objective of the project, and are determined during the scoping phase of the project in consultation with ODOT. Table 7-4 summarizes the demand specification by project type.
### Table 7-4. Project Types and Corresponding Demand Specification

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Description</th>
<th>Demand Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type I</td>
<td>Type I projects involve the smallest study areas having only one intersection or interchange, where project or mitigation impacts are likely to be localized.</td>
<td>Intersection turning volumes</td>
</tr>
<tr>
<td>Type II</td>
<td>Type II projects involve mid-sized study areas that are slightly or moderately more complex than a Type I project in that projects or mitigation measures carry a greater risk of impacting adjacent intersections, interchanges, or facilities.</td>
<td>O-D matrices supplied by ODOT Design Traffic or by StreetLight</td>
</tr>
<tr>
<td>Type III</td>
<td>Type III projects involve the largest study areas, generally because the impacts of the projects or mitigation measures are far-reaching, uncertain, or are of significant consequence in terms of cost, public acceptance, or other factors. Due to the size of the study area, Type III projects will always require the use of the full TransModeler software and not TransModeler SE.</td>
<td>O-D matrices produced by the Simulation Demand Estimation (SDE) process</td>
</tr>
</tbody>
</table>

A more detailed discussion of traffic demand specification for each project type can be found below. Broadly, there are two approaches to specifying demand: (1) as turning volumes and (2) as O-D matrices. Unless the study area is for a single intersection, the approaches will not have equivalent outcomes, and it is important to understand the strengths and limitations of each approach.

#### 7.2.1 Type I Projects: Demand as Turning Volumes

For a Type I project, traffic demand will be specified as turning volumes. The following sections provide additional guidance on using turning volumes as the demand specification.

#### 7.2.1.1 Demand as Turning Volumes: Drawbacks

The singular advantage of using turning volumes to specify demand is simplicity. It requires very little effort or care to collect turning movement counts (TMCs), enter them into the software, and begin a simulation. That simplicity, however, discourages critical evaluation of the model’s validity and risks misleading decision-makers, potentially leading to poor project selection or programming decisions.

Specifying demand as turning volumes, while commonplace in traffic engineering practice, has numerous drawbacks that may not be immediately evident. The major drawbacks are summarized in Table 7-5. Chief among these drawbacks is that when trips are simulated based on turning volumes, their “paths” are the consequence of a string of turning movements drawn randomly and independently at each intersection, one link at a time, until the path reaches a boundary of the network. A trip’s “destination” is similarly the result of random chance, potentially bearing little resemblance to actual traffic patterns. Any effort to suppress irrational or undesirable paths or O-D pairs by prohibiting certain movements (e.g., a U-turn at a diamond interchange) inevitably skews the simulated volumes elsewhere in the network away from the input volumes.

Irrational paths alone are not cause for great concern if the analysis is confined locally to an intersection or a very small network. However, as the size of the study area increases with each additional intersection or interchange, so too does the likelihood that the compound effects of those irrational paths influence model outputs in nuanced, unknowable ways.
In summary, using turning volumes to specify demand requires just as much caution and judgment as when developing O-D matrices. A simulation model developed for a Type I project will require the same critical examination, calibration, and validation as any other.

Table 7-5. Drawbacks of Turning Volumes as Demand Input for Simulation

<table>
<thead>
<tr>
<th>Drawback</th>
<th>Consequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning volumes are frequently taken from turning movement counts that represent served volumes, not demand.</td>
<td>Simulated volumes do not reflect demand, particularly where a lane group is oversaturated, and thus yield models that underestimate delay and queue lengths in existing conditions as well as the benefits of improvements in build scenarios.</td>
</tr>
<tr>
<td>O-D pairs and/or paths may be irrational. For instance, a trip can take a circuitous or winding path and even end the trip at a location near the start of the trip.</td>
<td>There may be numerous consequences of irrational paths. At a minimum, if irrational paths are visibly detected by astute members of a public or other non-technical audience, they may undermine confidence in the model and trust in the conclusions. At worst, irrational paths result in an increase in weaving and merging maneuvers that have direct impacts on output performance measures and decision-making.</td>
</tr>
<tr>
<td>The O-D pattern that is synthetically derived from the TMCs may exhibit weaving patterns – for example, high volumes of vehicles turning right from a minor to a major street and then immediately turning left at the next intersection.</td>
<td>O-D patterns that do not accurately reflect those observed in the field cannot be dismissed simply because the net effect on turning volumes locally at intersections is the same. It is the sequences of movements – i.e., the paths – that vehicles follow that will determine the concentration or dispersion of lane changing activity that may increase or alleviate friction, respectively, to the point of profoundly impacting operations.</td>
</tr>
<tr>
<td>Paths based on TMCs may produce U-turns that are difficult or impossible to completely prevent.</td>
<td>Many microsimulation tools, TransModeler included, have tools for prohibiting certain sequences of links that constitute U-turning movements, such as exiting a freeway at a diamond interchange and reentering the freeway in the opposite direction, but this suppression of certain link sequences should raise questions about how and which other paths are promoted to maintain consistency with the input turning volumes.</td>
</tr>
<tr>
<td>TMCs have errors and do not account for mid-block access points and on-street parking.</td>
<td>Unbalanced volumes between intersections, which may be the result of midblock access points, on-street parking, errors in the counts, or the fact that counts reflect demand at undersaturated intersections and underrepresent the demand at oversaturated ones, present a dilemma to the analyst because how unbalanced volumes should be treated (e.g., by adjusting them so that they are balanced or by allowing trips to begin or end midblock to make up for the gaps in volumes) depends on the cause of the imbalance, which may vary from location to location in the same model. Analysts will be tempted to apply a blanket treatment for the sake of expediency and skew the model in ways that are unforeseeable.</td>
</tr>
<tr>
<td>Though TMCs may be classified (e.g., light and heavy vehicles), microsimulation software packages, TransModeler included, do not provide for classified turning volumes as input. Rather, trucks and other types of vehicles are part of a global fleet mix or a fleet mix at the point of origin.</td>
<td>Paths simulated from turning volumes are generated one turning movement at a time based on the proportions of turning volumes at each node, with no foreknowledge of where the path will end, and hence no control over the destinations of trips as a function of vehicle class. The simulation therefore will not accurately reflect the pattern of heavy vehicle movements in the study area, potentially skewing model outputs.</td>
</tr>
</tbody>
</table>
Simulation based on turning volumes depends heavily on large numbers of pseudo-random (as opposed to truly random) numbers.

Because each turn a vehicle makes at each intersection is the direct consequence of a pseudo-random number, the path is effectively the joint probability of all the turning movements making up the path. As the number of feasible paths increases, the pool of low-probability paths increases, creating more opportunity for the imperfections inherent in pseudo-random number generation, which may be negligible at one intersection or a small number of intersections, to compound across larger study areas. The net effect will be widening gaps between input and simulated volumes at intersections increasingly distant from trip origins.

Turning volumes must be manually adjusted to simulate build scenarios that may alter the paths certain trips must take.

There are numerous cases in which project alternatives will result in paths in existing conditions being prohibited and replaced by new paths, necessitating the manual and tedious bookkeeping to subtract volumes from the “old” paths and to add them to intersections along the “new” paths. Some examples include alternative interchange configurations, replacing a two-way left-turn lane with a raised median, or converting two-way streets to one-way couplets or vice versa. The manual adjustment of volumes can be both time-consuming and error-prone. Moreover, adjustments in some scenarios may be subjective, especially if an alternative introduces more than one new path. The subjective judgement of the analyst may skew the analysis one way or another.

### 7.2.1.2 Entering Turning Volumes

Turning volumes are managed and entered using tools on the Intersections tab on the TransModeler Sidebar and summarized in Table 7-6.

Table 7-6. Tools for Managing Turning Volumes in TransModeler

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Display Turning Volumes" /></td>
<td>Display Turning Volumes</td>
<td>Click an intersection in the map to view the turning volumes</td>
</tr>
<tr>
<td><img src="image" alt="Edit Turning Volumes" /></td>
<td>Edit Turning Volumes</td>
<td>Click an intersection in the map to edit the turning volumes</td>
</tr>
<tr>
<td><img src="image" alt="Add/Remove Data Fields" /></td>
<td>Add/Remove Data Fields</td>
<td>Add, remove, or rename fields storing volumes for multiple analysis years and periods</td>
</tr>
</tbody>
</table>

When you are ready to enter turning volumes, you should have a plan for the volumes you intend to simulate, bearing in mind the following consideration: How many scenarios (i.e., existing and future, AM and PM, with and without signal timing improvements, with and without turning volumes representing proposed land uses, etc.) will be simulated for the build condition (e.g., existing condition vs. a geometric alternative)?

In TransModeler, turning volumes are stored in tables in a file format having a .bin extension. To minimize and simplify model development tasks, one table should be created for each geometric condition (e.g., an existing condition or build alternative). In the table, one field will contain the volumes representing one analysis year and period (e.g., an AM or PM peak hour) and should be thoughtfully named so that other users or reviewers of the model will readily recognize its purpose. For example, a field named “AM_2020” may represent AM peak hour volumes for an existing conditions (2020) scenario.
When you are ready to enter volumes, click Add/Remove Data Fields to set up the fields for all the scenarios and periods for which you want to enter volumes. You will tell TransModeler which period the field represents in the Project Settings (Section 7.1.2.5) prior to simulation.

7.2.1.3 Checking a Turning Movement Table for Errors

Before entering turning volumes, your road editing work should be complete. TransModeler will attempt to keep turning volume inputs in sync with subsequent changes you make to the road network, but significant road edits that involve splitting and joining links or creating new intersections may have the effect of invalidating some of the input turning movement data.

Similarly, you may create a simulation project for a build alternative from a copy of the project files representing existing conditions (Section 7.1.2.3). This way, the turning volumes for existing conditions will not have to be reentered where the intersection or interchange configuration does not change substantially. However, if the build alternative entails reconfiguring intersections or interchanges, it is likely that some of the data in the turning movement table for the build scenario will become invalid.

To identify records in the turning movement table that are inconsistent with the road network, choose Tools > Error Checking > Check Turning Movement Table.

7.2.1.4 Managing Unbalanced Turning Volumes

When the sum of turning volumes turning onto a link at the upstream node does not equal the sum of turning volumes at the downstream node, they are unbalanced. The various causes for unbalanced volumes and the most appropriate treatment for each are summarized in Table 7-7.
Table 7-7. Causes and Treatments for Unbalanced Turning Volumes

<table>
<thead>
<tr>
<th>Cause</th>
<th>Treatments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors in the source counts</td>
<td>If possible, seek recount or correction from the firm that performed the counts.</td>
</tr>
<tr>
<td></td>
<td>Examine other counts in the proximity to deduce which volumes are most likely in error, and adjust the volumes to balance the counts.</td>
</tr>
<tr>
<td></td>
<td>Ignore gaps in counts by entering a sufficiently high value for the <strong>imbalance threshold for Internal Link Sources and Sinks</strong>: Click Project Settings on the <em>Simulation</em> tab on the TransModeler Sidebar, highlight the turning movement table on the <em>Input</em> tab, click <em>Trip Table Settings</em>, and then click <em>Options</em> (Help: Turning Movement Table Demand).</td>
</tr>
<tr>
<td>Counts were recorded on different days</td>
<td>Adjust the volumes to balance the counts.</td>
</tr>
<tr>
<td></td>
<td>Ignore gaps in counts by entering a sufficiently high value for the <strong>imbalance threshold for Internal Link Sources and Sinks</strong>: Click Project Settings on the <em>Simulation</em> tab on the TransModeler Sidebar, highlight the turning movement table on the <em>Input</em> tab, click <em>Trip Table Settings</em>, and then click <em>Options</em> (Help: Turning Movement Table Demand).</td>
</tr>
<tr>
<td>Mid-block access points and on-street parking</td>
<td>No treatment is necessary. By default, the imbalance threshold mentioned above in this table is zero, allowing for trips to start or end midblock anywhere there is a gap in volumes. However, if you wish to allow trips to start and end midblock where it is warranted by midblock access points and on-street parking and you wish to ignore small gaps in counts that may be attributable to errors or counts from different days, then you may choose an imbalance threshold that is low enough to allow for gaps attributed to midblock access points and on-street parking but high enough to cover other gaps.</td>
</tr>
<tr>
<td>Upstream intersection is undersaturated and downstream intersection is oversaturated, hence having lower served/recorded volume</td>
<td>Similar to the case of midblock access points and on-street parking, attempt to determine an imbalance threshold for internal sources and sinks that is high enough to preclude trips ending on the link due to the gap but low enough to allow for trips to begin or end at midblock access points and on-street parking elsewhere in the network. If such an imbalance threshold cannot be determined, consider adjusting the volumes at the downstream intersection proportionally to recover the gap.</td>
</tr>
</tbody>
</table>

It is important to note that when the imbalance threshold for internal sources and sinks is used to preclude trips beginning or ending on links in the network with gaps less than the threshold, the importance of the accuracy of the turning volumes on the external links—those on the boundary of the study area—becomes critical and should be closely reviewed because they will be the ultimate arbiters of what volumes pass to downstream links. In other words, the volumes that are simulated on links downstream of external links will be subject to the volumes entering the link at the upstream end if the gap between the upstream and downstream volumes does not meet the imbalance threshold. Volumes that do not reflect the demand accurately on the external links will thus stifle the volumes elsewhere in the network. For this reason, scoping the study area such that external links are not oversaturated is of critical importance (**Section 7.2.4.1**), particularly when using turning volumes to specify demand.
7.2.1.5 Managing Oversaturated Conditions when Demand is Defined by Turning Volumes

It is critically important to recognize that turning movement counts collected in oversaturated conditions may underrepresent demand. Turning movement counts are often counted based on observation of vehicles passing the stop bar at an intersection. As such, the counts only reflect served volumes, which will be less than or equal to capacity. Vehicles remaining queued at the end of the data collection period, for example, contribute to a turning movement’s demand, but will be excluded from the counts. However, if the demand exceeds capacity, then a queue will form, but the queue will not be reflected in the turning movement counts alone. If served volumes and not demand are input to a simulation, then the simulation and its outputs will not be an accurate representation—in terms of queue lengths, delays, LOS and other performance measures—of existing conditions.

For some of the suggested treatments for turning movement counts at oversaturated intersections, see Section 7.2.1.4. The ODOT district should be consulted to determine the availability of queue count data that may be used to determine whether significant queuing has been observed in the field. For more information about queue counts, consult the Ohio Traffic Forecasting Manual.

7.2.1.6 Managing U-turns at Interchanges and Similar Scenarios

At times, there may be a need to prohibit vehicles from making an undesirable sequence of movements, such as exiting a freeway and immediately reentering the freeway in the opposite direction (Figure 7-36) or continuing in the same direction. Turn prohibitions can be used to prohibit these types of movements. Turn prohibitions are a series of links that define the sequence of movements that vehicles should not be permitted to take. To view, create, and delete turn prohibitions, open the Turn Prohibition Editor by choosing Tools > Toolbars > Turn Prohibition Editor (Help: Prohibiting Sequences of Links on a Path (Turn Prohibitions)).
7.2.1.7 Using Turning Volumes to Define Demand

Either single-period or multi-period turning volumes may be used in TransModeler. However, unless otherwise directed by ODOT, single-period volumes should be used. Single-period volumes are expressed as an hourly rate (vph). Additionally, a peak hour factor (PHF) may be specified (Figure 7-37). When single-period volumes are simulated, the vehicle departure rate will be constant for the duration of the simulation time period. A peak hour factor (PHF) less than 1.00 will be used to scale the simulated demand to volumes reflecting the highest-volume 15-minute period within the peak hour. Hence, a simulation of one hour will overestimate the one-hour volumes and will characterize the peak of the peak hour.

The PHF is equal to the total volume $V_T$ divided by the peak period volume $V_{15}$ multiplied by 4. Specifying a PHF equal to 1.00 implies that the total volume throughout the peak hour is distributed evenly, whereas a PHF equal to or less than 1.00 implies demand varying over the hour. If count data are not available to compute the PHF, the HCM suggests a default of 0.92.
7.2.1.8 O-D Matrices as an Alternative to Turning Volumes

It is acceptable, and often preferable, to use O-D matrices rather than turning volumes in a Type I project. With the O-D Matrix Toolbar in TransModeler, O-D volumes can be entered into a matrix by clicking in a map just as well as turning volumes can be entered into a turning movement table. To enter volumes into an O-D matrix, create a new, empty matrix (choose File > New and then Trip Matrix) and enter volumes using the O-D Matrix Toolbar (Section 0). But before you create a matrix, you will want to consider whether you want to leverage centroid descriptions (Section 7.1.6.2) so that you can label your matrices with text that will allow you to readily interpret the origins and destinations that the rows and columns, respectively, represent. If you will use centroids (Section 7.1.3.4), then you must first create the centroids at the boundaries of your study area and at centers of significant land uses inside the study area using the road editing tools (Section 7.1.3) before you create a matrix.

7.2.2 Type II and Type III Projects: Demand as O-D Matrices

In Type II and Type III projects, traffic demand will be specified as O-D matrices rather than as turning volumes.

For a Type II project, the O-D matrix volumes will be derived from one of two sources unless otherwise directed by ODOT:

- Design traffic supplied by ODOT or by a partner MPO or consultant
- StreetLight or a similar service

For a Type III project, the O-D matrix volumes will be derived from ODOT’s established Simulation Demand Estimation (SDE) process, which relies on travel demand modeling tools and origin-destination matrix estimation (ODME) methods.

The following sections provide additional guidance when using O-D matrices as demand inputs in TransModeler. Each section is labeled to indicate whether it applies to both Type II and Type III projects or only Type III projects.

But before beginning to develop O-D matrices, the study area and its boundaries should be well-thought-out and carefully planned (Section 7.2.4.1). Matrices in TransModeler use the unique IDs of node and centroid in the simulation database as row and column indices. Any edits to the road
network that result in a change to the IDs of nodes or centroids that represent origins (rows) and destinations (columns) in a matrix will lead to simulation errors and will require that the matrices be corrected or recreated. Further, the task of managing and editing O-D matrices is greatly simplified if centroids are used to represent all origins and destinations and helpful text is entered as centroid descriptions (Section 7.1.6.2). Centroid descriptions will automatically substitute the numerical centroid IDs in the row and column headings in a matrix window, making matrices easier to read and interpret.

7.2.2.1 Demand as O-D Matrices: Advantages and Disadvantages (Type II, Type III)

Because of the drawbacks of turning volumes as a demand input for microsimulation (Section 7.2.1.1), which magnify and compound as the study area grows, Type II and Type III projects will depend on demand defined in O-D matrices. O-D matrices have the advantage of:

1. Explicitly precluding or minimizing undesirable paths (e.g., U-turning paths at intersections or interchanges) or O-D pairs (e.g., right turns onto a major street followed by immediate left turns, or vice versa, which increase weaving and lane changing maneuvers).
2. Permitting the vehicle fleet mix (e.g., heavy vehicle percentage) to vary by origin and destination rather than by origin alone.
3. Obviating the need for any balancing of counts or steps to account for unbalanced turning volumes.

Although specifying demand in O-D matrices has these and other advantages, microsimulation with O-D matrices is perceived by many to increase the cost and complexity of microsimulation projects. O-D matrices are perceived to be more complex partly because O-D volumes are more difficult to observe directly in the field. One can easily, and relatively cheaply, collect turning movement counts and enter them into traffic analysis or simulation software. On the other hand, to observe O-D volumes requires measurements at multiple locations, namely at the boundaries of a study area. License plate surveys and Bluetooth data collection technologies partly overcome the measurement hurdle but still only produce a sample of the O-D pattern.

7.2.2.2 Sources of O-D Volumes or Patterns (Type II, Type III)

While O-D data can be collected through field measurement (e.g., license plate or Bluetooth), two established processes will be used to estimate O-D matrices in Type II and Type III projects.

In Type II projects, the primary source of O-D data will be design traffic produced by ODOT or by a partner MPO or consultant. In some Type II projects, at the express direction of ODOT, O-D data may be obtained from StreetLight in lieu of design traffic. ODOT maintains a subscription to StreetLight InSight, an online platform that allows users to download O-D matrices derived from aggregated location data anywhere in the state of Ohio. O-D matrices are estimated using an Iterative Proportional Fitting (IPF) process that attempts to fit the O-D pattern derived from location data to traffic counts at the study area’s boundaries. Hence, traffic volumes, whether ODOT certified traffic or traffic counts are a required input. Step-by-step guidance for the process is provided through StreetLight user support (Link).

To use the StreetLight InSight, first request access permission by contacting ODOT-Support@streetlightdata.com with the email addresses of the individuals who will need access, the ODOT project manager and project name, and the length of the project. If there
are any questions during the use of the StreetLight InSight service, contact StreetLight's Support Team at ODOT-Support@streetlightdata.com.

In Type III projects, O-D matrices will be produced using ODOT’s SDE methodology, which leverages travel demand models in metropolitan areas where such a model exists to provide a first approximation of the O-D volumes. Subsequently, valid and consistent traffic counts are used to refine that approximation to better fit observed traffic patterns. This methodology is consistent with standard practice, but that practice does not guarantee the O-D matrices will yield simulated volumes that immediately calibrate or validate well with field data.

One reason why simulated volumes may not calibrate or validate well with field data is because the O-D pattern produced by the travel demand model may bear little resemblance to the actual O-D pattern. Travel demand models are not calibrated nor validated at a geographic resolution suitable to support operational analysis. Moreover, while travel demand models in Ohio include time-of-day procedures that divide daily trips into time periods (AM peak, mid-day, PM peak, and overnight), they may not have the same temporal resolution as traffic counts (e.g., hourly) or that are suitable for operational analysis. Thus, the travel demand model represents a coarser, big-picture estimation of traffic demand.

Second, traffic counts are imperfect measurements and may contain errors that are difficult to detect and root out despite efforts to do so in the SDE process.

In Type II projects, O-D matrices obtained from StreetLight should be treated with the same caution and subjected to the same scrutiny during calibration and validation for some of the same reasons. Specifically, all known traffic measurements, including those on which StreetLight relies, are imperfect. Other reasons for caution are not knowable due to the proprietary nature of StreetLight’s data reduction and O-D development practices and assumptions.

Hence, whether a study is Type II or Type III, turning movement counts should still be prepared in TransModeler using the same tools described in Section 7.2.1.2. While the turning movement counts will not serve as inputs to the simulation, they can be readily compared to simulated volumes as part of the calibration process (Section 7.3.4). Type III projects will use turning movement counts directly, as they are an input to the ODME step in the SDE process.

Development of O-D matrices from ODME or StreetLight methods is not a guarantee that simulated volumes will match well with observed volumes. When O-D matrices are used to specify demand, turning movement counts are used to calculate goodness-of-fit measures for calibration, not as inputs to the simulation.

7.2.2.3 Editing Volumes in O-D Matrices (Type II, Type III)

There are two common cases in which you may want to edit the volumes in O-D matrices:

1. O-D volumes are available from a data source (e.g., ODOT design traffic), measured in the field, or will be inferred from turning movement counts.
2. Adjustments are needed to improve the model’s calibration with counts or validation with speeds, travel times, or queue lengths.

Volumes in O-D matrices can be edited using the tools on the O-D Matrix Toolbar, which is opened by clicking O-D Matrix Toolbar 🔄 on the main toolbar. When the O-D Matrix Toolbar is opened, the
input O-D matrix is also automatically opened. If there is more than one input matrix, you will be asked to choose the one you want to edit. The tools on the O-D Matrix Toolbar allow you to quickly find a row corresponding with an origin, column corresponding with a destination, or cell corresponding with an origin and a destination by clicking in the map:

1. When an origin is chosen (choose Click Origin and then click an origin node or centroid in the map), the corresponding row is highlighted in the matrix.
2. When a destination is chosen (choose Click Destination and then click a destination node or centroid in the map), the corresponding column is highlighted in the matrix.
3. When both an origin and a destination are chosen (Choose and then click an origin in the map; should then be automatically selected without having to click on it; click on a destination in the map), the corresponding cell is highlighted in the matrix.

Once the desired row, column, or cell in the matrix is chosen using the tools on the O-D Matrix Toolbar, simply type in a new value directly in the desired cell(s) (Help: Editing O-D Matrices).

7.2.2.4 Using O-D Matrices Estimated with the SDE (Type III)

ODOT’s SDE process uses ODME to estimate O-D matrices that match traffic counts. Like traffic simulation with turning volumes, ODME has been practiced for a very long time. While ODME might not be in the toolkit of every practicing transportation engineer or planner, it is a technique whose properties, benefits, and shortcomings are well understood. For relatively small and confined study areas where numbers of competitive alternative paths are few or none, ODME can be wielded quite fruitfully by experienced practitioners with sufficient and valid input data.

The shortcomings of ODME are best summarized in the following two points:

1. The matrix that ODME produces, however good the ODME-predicted fit between the model volumes and the counts, cannot be taken on faith or trusted out of hand.
2. Virtually any number of solutions - that is, matrices with slightly or very different patterns - may be able to produce the same quality of fit.

Another way to state point number 2 is also the explanation for number 1: an excellent fit with the counts does not necessarily equate to even a good fit with the true O-D pattern. Two very different patterns can match the same counts equally well and result in very different operating conditions.

To frame the problem, this truth is little more than another way of stating the case for validation as a follow-up step to calibration. A model can be well-calibrated to counts and be poorly validated.

The benefits of ODME, on the other hand, are compelling: more and more, the projects we want to evaluate are of a nature in which route choices are significantly impacted. Tools are needed to understand those impacts. This is true not just of larger, more complex (i.e., Type III) projects with competing route choices, but also in smaller, more straightforward (i.e., Type II) projects in which O-D matrices are used but ODME may not be. For example, alternative intersection and interchange designs, such as median U-turn (MUT) intersections and diverging diamond interchanges, and modern street design concepts, such as smart streets, all seek to minimize conflict points that are unsafe and make interchanges and intersections less efficient. When simulating based on turning volumes, those volumes must be tediously shifted around, such as from the direct turning
movements denoted with dashed lines to the diverted U-turn paths denoted with solid lines in Figure 7-38, without introducing errors.

Figure 7-38. Turning Volume Adjustments Needed to Evaluate an MUT

When O-D matrices are used, the costs associated with the task of manually adjusting turning volumes in numerous scenarios is traded for the additional costs associated with developing the O-D matrices upfront, whether through ODME or by other means, but with the benefit that no change to the demand is needed to simulate the alternatives once calibration is completed.

ODME will be performed according to the process prescribed in the SDE manual. This preceding ODME discussion is intended only to frame expectations for the matrices that the ODME process will produce. Analysts performing the simulation work should be prepared to review the matrices closely and even to adjust the volumes in the matrix using tools in TransModeler (Section 7.2.2.3) in order to improve the simulation model’s fit with the traffic counts in the calibration stage of the project. Manual adjustments to O-D matrices are routine in practice but should be made with careful judgment to address a clearly identified calibration objective (e.g., to improve the match observed queues). All adjustments and the rationale for those adjustments should be documented, and both the original, unchanged O-D matrices produced by the ODME and the adjusted O-D matrices should be delivered to ODOT for review.

7.2.2.5 Peak Hour Factors with O-D Matricies (Type I, Type II, Type III)

Traffic demand is rarely if ever steady for whole peak hour. Traffic is subject to ebb and flow, and the way in which bottlenecks form and dissipate is due in no small part to these temporal dynamics. The peak hour factor accounts for this temporal distribution.

The simplest way to define the temporal distribution when using O-D matrices in a Type I, Type II or Type III study is to apply a multi-period curve to each trip matrix. In a trip matrix’ settings, a time distribution can be defined in a curve in which the height of the curve in each interval reflects that proportion of the demand departing in that interval, and that distribution will be applied to all O-D pairs in the matrix. Table 7-8 provides the proportion of demand in each interval for PHFs ranging from 0.80 to 1.0.
When developing O-D Matrix Curve Data, care should be taken to include a warm-up period (Section 7.2.4.2), which will typically be 15 minutes for a one hour analysis period. Hence, an O-D Matrix Curve will span five 15-minute periods accounting for 15 minutes to load the network.

To use a curve to define the proportion of the volume that departs during each period:

1. Click Project Settings on the Simulation tab on the TransModeler Sidebar.
2. Click the Input tab and highlight the matrix file.
3. Click Trip Table Settings to view the Trip Matrix Settings.
4. Choose Curve-Based on the Setup tab.
5. Click the Curve tab and enter the number of intervals in the Intervals box (Figure 7-39).
6. Click and drag the upper-left corner of each bar in the chart to change the percentage of the demand in the matrix departing in each interval. Or, right-click the upper-left corner of each bar and enter the Percentage to edit the distribution (Help: Trip Matrix Setup).

![Figure 7-39. Example of O-D Matrix Curve](image-url)
Table 7-8. O-D Matrix Curve Data for Various PHF

<table>
<thead>
<tr>
<th>PHF</th>
<th>Warm-Up</th>
<th>Interval 1</th>
<th>Interval 2</th>
<th>Interval 3</th>
<th>Interval 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.80</td>
<td>20.00%</td>
<td>25.00%</td>
<td>31.25%</td>
<td>25.00%</td>
<td>18.75%</td>
</tr>
<tr>
<td>0.81</td>
<td>20.00%</td>
<td>25.00%</td>
<td>30.86%</td>
<td>25.00%</td>
<td>19.14%</td>
</tr>
<tr>
<td>0.82</td>
<td>20.00%</td>
<td>25.00%</td>
<td>30.49%</td>
<td>25.00%</td>
<td>19.51%</td>
</tr>
<tr>
<td>0.83</td>
<td>20.00%</td>
<td>25.00%</td>
<td>30.12%</td>
<td>25.00%</td>
<td>19.88%</td>
</tr>
<tr>
<td>0.84</td>
<td>20.00%</td>
<td>25.00%</td>
<td>29.76%</td>
<td>25.00%</td>
<td>20.24%</td>
</tr>
<tr>
<td>0.85</td>
<td>20.00%</td>
<td>25.00%</td>
<td>29.41%</td>
<td>25.00%</td>
<td>20.59%</td>
</tr>
<tr>
<td>0.86</td>
<td>20.00%</td>
<td>25.00%</td>
<td>29.07%</td>
<td>25.00%</td>
<td>20.93%</td>
</tr>
<tr>
<td>0.87</td>
<td>20.00%</td>
<td>25.00%</td>
<td>28.74%</td>
<td>25.00%</td>
<td>21.26%</td>
</tr>
<tr>
<td>0.88</td>
<td>20.00%</td>
<td>25.00%</td>
<td>28.41%</td>
<td>25.00%</td>
<td>21.59%</td>
</tr>
<tr>
<td>0.89</td>
<td>20.00%</td>
<td>25.00%</td>
<td>28.09%</td>
<td>25.00%</td>
<td>21.91%</td>
</tr>
<tr>
<td>0.90</td>
<td>20.00%</td>
<td>25.00%</td>
<td>27.78%</td>
<td>25.00%</td>
<td>22.22%</td>
</tr>
<tr>
<td>0.91</td>
<td>20.00%</td>
<td>25.00%</td>
<td>27.47%</td>
<td>25.00%</td>
<td>22.53%</td>
</tr>
<tr>
<td>0.92</td>
<td>20.00%</td>
<td>25.00%</td>
<td>27.17%</td>
<td>25.00%</td>
<td>22.83%</td>
</tr>
<tr>
<td>0.93</td>
<td>20.00%</td>
<td>25.00%</td>
<td>26.88%</td>
<td>25.00%</td>
<td>23.12%</td>
</tr>
<tr>
<td>0.94</td>
<td>20.00%</td>
<td>25.00%</td>
<td>26.60%</td>
<td>25.00%</td>
<td>23.40%</td>
</tr>
<tr>
<td>0.95</td>
<td>20.00%</td>
<td>25.00%</td>
<td>26.32%</td>
<td>25.00%</td>
<td>23.68%</td>
</tr>
<tr>
<td>0.96</td>
<td>20.00%</td>
<td>25.00%</td>
<td>26.04%</td>
<td>25.00%</td>
<td>23.96%</td>
</tr>
<tr>
<td>0.97</td>
<td>20.00%</td>
<td>25.00%</td>
<td>25.77%</td>
<td>25.00%</td>
<td>24.23%</td>
</tr>
<tr>
<td>0.98</td>
<td>20.00%</td>
<td>25.00%</td>
<td>25.51%</td>
<td>25.00%</td>
<td>24.49%</td>
</tr>
<tr>
<td>0.99</td>
<td>20.00%</td>
<td>25.00%</td>
<td>25.25%</td>
<td>25.00%</td>
<td>24.75%</td>
</tr>
<tr>
<td>1.00</td>
<td>20.00%</td>
<td>25.00%</td>
<td>25.00%</td>
<td>25.00%</td>
<td>25.00%</td>
</tr>
</tbody>
</table>

7.2.2.6 Traffic Analysis Zone Connectivity (Type III)

In Type III projects, the study area will likely include centroids representing traffic analysis zones (TAZs) in a travel demand model. The TAZs may cover large areas with multiple access points between the streets included in the simulation network and those inside the TAZ but that are not included in the network. In this case, close coordination with the analysts applying the SDE will be required, and that coordination may entail division of TAZs into smaller zones (e.g., micro-analysis zones, or MAZs) in order to improve the model’s calibration with counts.

However, even if TAZs from a travel demand model are not part of the O-D development process, it may be necessary to choose between (1) treating multiple access points (e.g., driveways) to the same land use as independent origins and destinations or (2) whether centroids are used to represent a singular origin and destination for the land use and are connected to multiple access points. Such considerations, summarized in Table 7-9, must be made prior to commencing O-D matrix development so that the necessary changes (i.e., addition of centroids and centroid connectors) can be made to the road network.
Table 7-9. Traffic Analysis Zone Connectivity for O-D Matrix Development

<table>
<thead>
<tr>
<th>Treatment of Origins/Destinations Inside the Study Area</th>
<th>Factors to Consider</th>
</tr>
</thead>
</table>
| Every driveway accessing the site is treated as a separate origin/destination. | This treatment is necessary if either of the following is true:  
  ▪ The volumes simulated at each access point are important to operations, or  
  ▪ The volumes simulated at each access point is important to the alternatives to be analyzed  
  Increasing the number of rows and columns in the matrix consequently increases the degree of difficulty at the model calibration and validation stages, whether ODME is used or not. |
| Centroids represent a site and connect to the multitude of driveways that access the site. | This treatment is necessary when you want to analyze the routes drivers will take to access the site when alternatives alter the paths that may be used to access the site.  
  Using centroids that connect to multiple access points introduces a route choice dimension to the model, for which TransModeler SE is only appropriate if the most direct routes to or from the site are the only ones that drivers take or are the routes predominantly chosen.  
  This treatment requires TransModeler if the purpose of the analysis is to model the impacts of congestion on alternative routes on the choices drivers make. |

7.2.3 Specifying the Vehicle Fleet Mix

The proportion of passenger cars, trucks, and buses that are simulated (i.e., the vehicle fleet mix) is defined globally for all trips (Simulation > Parameters > Vehicle Fleet > Classification > Class) by default but can be customized in two ways:

1. By matrix (for O-D matrices only)
2. By origin using Local Loading Parameters

Properly considering and specifying the vehicle fleet mix is an important model development step that should be taken in every project and that has important downstream implications for model calibration and validation.

7.2.3.1 Varying Vehicle Fleet Mix by Origin and Destination

A well-calibrated, well-validated model may hinge on simulating classes of vehicles having different spatial (i.e., O-D) demand patterns. For example, heavy vehicles may have a distinctly different O-D pattern favoring interstate over local street origins and destinations, or heavy vehicles may be concentrated at origins and destinations near industrial land uses.

To vary the vehicle fleet mix by matrix, the total demand can be divided into separate O-D matrix files for each vehicle class. The vehicle class can be defined in the Vehicle Class column on the Contents tab in the Trip Matrix Settings. When no vehicle class is specified for a matrix in the Trip Matrix Settings, the vehicle class for every trip in the matrix will be determined by the global vehicle fleet parameters, which can be reviewed or edited by choosing Edit Vehicle Classes from the Edit Parameters drop-down. When the simulation is started, TransModeler will combine all the input matrices to calculate total demand.
The differences between O-D patterns are then expressed in the volumes themselves, where each cell in the matrix contains a value representing the number of vehicles of the specified class traveling from the origin represented by row to the destination represented by the column.

7.2.3.2 Varying Vehicle Fleet Mix by Origin with Local Loading Parameters

Whether specifying demand by turning volumes or by O-D matrices, the vehicle fleet mix defined in the model parameters can be overridden at the origin using Local Loading Parameters that define customized fleet mix percentages applied to each desired origin (Help: Local Loading Parameters). For example, at a driveway serving a warehouse, the fleet mix might have a higher proportion of trucks than the rest of the network. You can define a fleet mix with a higher percentage of trucks and use that fleet mix at the driveway.

If those trucks also happen to depart on a known schedule (e.g., a surge of incoming or outgoing truck traffic at a warehouse, manufacturing plant, or other industrial land use), you can also define a local departure time distribution (i.e., what proportion of vehicles depart in which period) using Local Loading Parameters.

The Local Loading Parameters should be applied to nodes if turning volumes are used to specify the demand or if the origins of the trips whose fleet mix or time distribution you want to vary are nodes. If the origins of trips whose fleet mix or time distribution you want to vary are centroids, then the parameters should be applied to centroids.

Setting up local loading parameters is a three-step process:

1. Define the distribution(s): Tools > Local Loading Parameters > Edit Distributions
   i. Add a new Vehicle Class Distribution
   ii. Specify the Vehicle Classes to be included, and the associated Percentage for each one
   iii. Add a new Trip Departure Time Distribution
   iv. Specific the Start Time of each time interval, and the associated Scaling Factor for each one

2. Apply the distribution(s): Tools > Local Loading Parameters > Apply Distributions
   i. Add new fields to the Centroids and/or Nodes layer (depending on the how your demand inputs are defined) for each type of local loading parameter distribution defined in Step 1

3. Specify feature(s) to which the distribution(s) apply
   i. Choose Nodes or Centroids as the active layer
   ii. Open a Dataview table
   iii. Navigate to the newly-added field(s) describing the type(s) of loading parameter distribution defined in Step 1
   iv. Select the user-defined name of the field(s) from the drop-down list in the cells associated with each record (Node or Centroid) to which the distribution will apply in the simulation
7.2.4 Boundary Conditions

7.2.4.1 Geographic Boundary Conditions: Scoping the Study Area

Between the ODOT Project Development Process (PDP) Section 7 and the ODOT SDE Manual, there is ample guidance for establishing the simulation study area boundaries, and that guidance will not be repeated here. The simulation study area that will be simulated in TransModeler should be decided in consultation with ODOT staff during Traffic Early Coordination meetings and, if ODME will be used to develop O-D matrices, in accord with the SDE process. To put it succinctly, it should encompass all areas that will be impacted significantly by any of the project alternatives, including the facility under study and parts of parallel and adjacent facilities.

Once the study area and input demand are reasonably well established in TransModeler, basic checks on the suitability of the study area for microsimulation analysis should be made. The most basic check that should be performed is that traffic is not “denied entry” to the network in significant numbers for significant lengths of time. If queues on external links—those on the boundary of the study area—spill back to the boundary of the study area, preventing trips from entering the network and causing them to be held in a virtual queue outside the network, then the delays and queue lengths will be underreported and may skew the analysis.

Queues outside the network are easy to detect and to monitor in TransModeler: the number of Queued Trips anywhere in the network at any point during the simulation is displayed in the Simulation tab on the TransModeler Sidebar (see Section 7.3.2.1). Delays experienced by vehicles still queued outside the network when the simulation ends will also be reported in the Trip Statistics report (see Section 7.4.2.1). When trips are queued outside the network, you can determine the number queued outside the network on any link in the Queue_AB and Queue_BA fields in the Links dataview. To find the links with the longest virtual queues and to begin to investigate the cause, do the following:

1. Pause the simulation.
2. Make Links the working layer.
3. Click New Dataview to open the Links dataview.
4. Scroll right to locate the Queue_AB and Queue_BA fields.
5. Right-click the field name to highlight the column and choose Sort Decreasing.
6. Right-click in a cell having a high number of queued trips and click Zoom. TransModeler will center the map on the link.

The model inputs, including but not limited to the demand and signal timings, should be reviewed to make sure they are correct. If the inputs are deemed to be correct, attempts should be made to determine whether the queuing in the model is an accurate reflection of the field condition. The link should be extended up to, but not beyond, the nearest upstream intersection not represented in the model. If doing so allows for the link to successfully contain the longest queue during simulation (i.e., the number of queued trips in the Queue_AB or Queue_BA field remains close to zero for most of the simulation), then the problem is solved. Otherwise, in consultation with the ODOT Project Manager, consideration should be given to extending the network to include the next upstream intersection until the study area can contain the full length of the queue for most of the simulation. In this case, the O-D matrices must be revised to incorporate the added boundary nodes adjacent to the added intersection(s).
Build and future-year scenarios should also be monitored for queuing outside the network. If queues come close to extending outside the network in the model of existing conditions, then the study area should be extended in anticipation of longer queues in future years.

7.2.4.2 Temporal Boundary Conditions: Scoping the Analysis Period

Most simulation analyses will encompass at least some portion of the analysis period during which traffic conditions will be oversaturated. The FHWA Traffic Analysis Toolbox: Volume III (page 7) states:

“The geographic and temporal scopes of a microsimulation model should be sufficient to completely encompass all of the traffic congestion present in the primary influence area of the project during the target analysis period (current or future).”

In other words, the duration of the analysis period should include time periods before and after the period of oversaturated conditions, when conditions are not oversaturated. Using this criterion, if the analysis period is determined to be longer than one hour, it is recommended that the model input traffic demand be partitioned in 15-minute intervals, with at least one beginning and ending 15-minute interval in which demand is less than the capacity.

While ODOT recognizes the potential benefits of evaluating analysis periods longer than one hour, our requirement is that all traffic analysis be conducted as a one hour period. To account for potential oversaturated conditions, a 15-minute warm up period should be used for the analysis.

The following steps must be taken to account for the warmup period T:

1. The analysis period in the Project Settings to start T minutes prior to the time period in which output data will be collected in order to simulate the warmup period.
2. The demand inputs should define demand for the warmup period (Table 7-10).

Table 7-10. Steps to Adjust Demand Inputs for the Warmup Period

<table>
<thead>
<tr>
<th>If the Demand is:</th>
<th>Do the Following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly Turning Volumes</td>
<td>No change is needed</td>
</tr>
<tr>
<td>Single Hour O-D Matrices</td>
<td>Click Project Settings on the Simulation tab on the TransModeler Sidebar, highlight the O-D matrix on the Input tab, and click Trip Table Settings. Then, on the Setup tab, change the Start Time to be the start time of the warmup period (e.g., 15 minutes prior to the start time of the analysis period) and on the Options tab, uncheck Volumes are hourly. Lastly, on the Curve tab, make sure the number of intervals includes an interval for the warmup period and that the Sum of the percentages is equal to 100% (the volume in the matrix to be simulated during the analysis period) plus the percentage of the total analysis period that should be simulated during the warmup period (Figure 7-40). That % would typically be equal to or less than the percentage to be simulated in the first interval during the analysis period.</td>
</tr>
</tbody>
</table>
When ODME is to develop O-D matrices per the ODOT SDE methodology, a separate 15-minute O-D matrix representing a warmup period will generally be produced along with an O-D matrix for the analysis period.

7.3 Calibration and Validation

Calibration is the process of identifying a full set of model inputs and parameters such that the model’s outputs match measured field data. This is a way of demonstrating that the model is a reasonably accurate representation of observed conditions.

Validation is the act of proving or corroborating, usually with a second data source or dataset, that the calibrated model can also provide realistic results under different input data/scenarios. This ensures a more robust model with realistic internal mechanics, that is less likely to be over-fit to just one dataset. The purpose of calibration and validation is to build confidence in the model as a useful predictor of operations that are likely to result from a condition that cannot be observed, such as after a capital improvement or a change in land use or demand pattern. A classic example of a well-calibrated but poorly validated model is one of a freeway segment in which the volume matches the count well but on the incorrect side of the fundamental diagram. For example, take volume $V_A$ in Figure 7-41, which can be observed in two entirely different traffic flow regimes: one ($U_b$) stable and the other ($U_a$) unstable.
This example underscores the need not only for validation but for the validation metric to speak to the operating condition. Hence, in simulation projects performed using TransModeler for ODOT, calibration should be based upon counts and validation on one of the following measures of performance:

1. Speeds, which are available from INRIX through ODOT for some facilities.
2. Travel times, which can be collected from GPS-equipped probe vehicles.
3. Queue counts, which may be available through ODOT (see Section 2.4.4 in Volume 2 of the Ohio Traffic Forecasting Manual).

**Figure 7-42** illustrates a general calibration and validation process with count-based calibration and speed-based validation. The steps enclosed in the SDE box could be substituted for any O-D matrix development process, including one based on design traffic or StreetLight for a Type II project.

The iteration between Demand Adjustment and Simulation, however, will rely on traffic simulation expertise and experience. Subarea extraction, ODME, StreetLight, and other methods for developing O-D matrices are automated, but none guarantee a model that validates well to field observations (e.g., speeds or travel times). All O-D development methods have their respective weaknesses, not least of which are error or inconsistency or insufficiency in the field measurements (typically counts) on which they rely, and hence may require help from the analyst to scrutinize the O-D volumes and to make manual adjustments to the volumes in the matrices directly or to identify the error, inconsistency, or insufficiency in the original data and retry the O-D development method.
This guidance highlights the tools that are available in TransModeler for calibrating and validating and best practices for their application.

### 7.3.1 Familiarize with Existing Conditions

The first step in model calibration and validation can be taken prior to any model development, and that is to become familiar with the existing operating conditions in the field. Model development and calibration and validation efforts should be preceded and supplemented by a field review to observe roadway geometry, traffic control, traffic flow, and operations. In the event a site visit is impractical or not cost-effective, video should be obtained if it is available or consultation should be had with people (e.g., ODOT District, MPO, or City staff) having local knowledge of operating conditions.
A key objective of any field review or consultation should be to identify any unique situations or conditions that may not be evident in conventional data sources such as count and speed measurements. These may include, for example, bottlenecks that are the result of site distance or sun glare. In lieu, or in support, of first- or second-hand knowledge or video footage, online mapping resources such as Google Maps, which can give travel time predictions and provide maps of current travel conditions, which may reveal useful information about congestion patterns and bottleneck locations. Resources such as Google Street View may also prove a valuable resource for identifying geometric or site-distance issues that may help to better understand operations in existing conditions.

Part of the process of becoming familiar with existing conditions should be taking stock, in consultation with ODOT, of all available traffic count, queue length, or other data and identifying what role, if any, they will play in the model’s calibration and validation. Traffic count data may need to be collected. For guidance on traffic count data collection, refer to ODOT’s SDE manual.

7.3.2 Visually Audit the Model

When a familiarity with existing conditions has been established and the basic model inputs have been developed, the model is ready for a visual audit, the first of several steps in the calibration and validation process. A visual audit entails careful and critical visual inspection of the simulation to ensure that the model comports with expectations. This guidance discusses various visual cues you should look for during your visual audit. It is not enough simply to resolve error and warning messages produced by TransModeler. The model may still have errors or defects in inputs that are not detectable without visual inspection. You should be watchful for unusual driver behaviors, or behaviors that do not accurately reflect field observations.

7.3.2.1 What to Watch For

The quantitative techniques described below will help you quickly identify issues in the model that may require correction or, at a minimum, review and affirmation.

**Bottleneck Formation**

Informed by a familiarity with existing conditions (see Section 7.3.1), an audit of the model should seek to answer the basic question whether bottlenecks known to exist in the field form where and when they are expected. Similarly, do bottlenecks form in the model where they are not observed in the field? To help you visualize bottlenecks and to make quick comparisons between simulated and measured speeds if you have them, you can color-code vehicles based on their current speed:

1. Make Vehicles the working layer.
2. Click Layer Color Theme on the main toolbar.
3. Choose Speed from the Based on Values of drop-down list.
4. Click OK.

**Vehicles Queued Outside the Network**

When an intersection at the downstream end of an external link is congested, vehicles may queue to the boundary and spill outside the network (see Section 7.2.4.2). The number of trips queued outside the network at any given time during a simulation can be found on the Simulation tab on the TransModeler Sidebar. Alongside the Queued Trips are other vehicle counts that are continuously updated during simulation and may help to inform your visual audit (Figure 7-43).
Once the simulation has finished, you can create a Trip Statistics report to identify the number of trips that were still queued, or unserved, when the simulation ended.

![Simulation Status]

Figure 7-43. Reporting of Numbers of Queued Trips Outside the Network in TransModeler

The Queue_AB and Queue_BA fields in the Links dataview also keep a running tally during simulation of the number of vehicles queued outside the network on every link (see Section 7.2.4.2). Your audit should include review of the signal timing inputs, driver behaviors (e.g., lane utilization), and demand.

Vehicles Missing Turning Movements

A visual audit should also include monitoring of the number of Missed Trips on the Simulation tab on the TransModeler Sidebar. These are the number of instances in which vehicles have missed a turn they intended to make and could not find an alternative path to the original destination link. The most common cause of this is a very long queue in the lane a vehicle must be in to make a turn or exit. A vehicle may pass the back of queue in an adjacent lane and fail to change lanes before reaching the end of the link. A table summarizing all missed turning movements, even those in which vehicles were able to find an alternative path to their destination link after missing the turn, is automatically created every simulation and can be reviewed when the simulation is finished. After a simulation, choose Simulation > Logging > Browse Log of Missed Turns. You may restart the simulation and observe the locations with the highest numbers of missed turns and attempt to identify a cause.

High Control Delays

During simulation, the Control Delay field in the Vehicles dataview continuously updates to reflect the control delay currently experienced by a vehicle approaching a queue or in queue at a controlled intersection. To find vehicles with very high control delays and inspect the simulation for the validity of the delays, do the following:

1. Pause the simulation.
2. Make Vehicles the working layer.
3. Click **New Dataview** to open the **Vehicles** dataview.
4. Scroll right to locate the **Control Delay** field.
5. Right-click the field name to highlight the column and choose **Sort Decreasing**.
6. Right-click in a cell having a high delay value and click **Zoom**. TransModeler will center the map on the vehicle.

You may also color-code vehicles based on control delay:

1. Make **Vehicles** the working layer.
2. Click **Layer Color Theme** on the main toolbar.
3. Click **More Options**.
4. Choose **Control Delay** from the **Field** drop-down list.
5. On the **Styles** tab, choose **Color Set** (e.g., From green to red) that conveys control delay varying from low to high.
6. Click **OK**.

### Unbalanced Lane Utilization or Bottlenecks at Lane Drops

Other symptoms that might indicate omissions or errors in the model specification can only be uncovered by close observation of queuing patterns during simulation. In other words, the simulation model must pass the “eye test.” This is particularly important if the project is of high interest to the public and may be shown at a public meeting. Common errant behaviors that fall into this category may be unbalanced lane utilization at intersections or bottlenecks forming at lane drops. Such phenomena may be a perfectly realistic reflection of operations in the field but should be checked against knowledge of existing conditions if they have serious operational implications.

Problems of lane utilization and queuing at lane drops can both potentially be treated by adjusting the lane connectivity bias parameter (see Section 7.1.3.3), however, they can also be a symptom of the demand pattern, which should also be reviewed. For instance, unbalanced lane utilization may be due to large numbers of vehicles making a right turn very shortly following a left turn, causing them to favor the right lane of a dual left turn bay. You can visualize the path every vehicle is taking by using the **View Vehicle Path** tool on the **Simulation** tab on the **TransModeler Sidebar** and clicking on a vehicle in the map.

Another technique that will help to make sense of the lane utilization behaviors observed in the simulation model is to color-code the vehicles based on the next turn they will make:

1. Make **Vehicles** the working layer.
2. Click **Layer Color Theme** on the main toolbar.
3. Click **More Options**.
4. Choose **Next Turn** from the **Field** drop-down list.
5. On the **Styles** tab, choose a set of colors to help distinguish between left turners (“L”), through vehicles (“T”), and right-turners (“R”).
6. Click **OK**.

### 7.3.3 Check Count Data for Consistency

Ideally, the full set of traffic counts would be measured simultaneously (i.e. on the same day) across the study area. This would ensure that all of the data were generated by the same underlying demand pattern. Realistically, however, budget and resource constraints may dictate that the
dataset be assembled from subsets of observations spanning multiple days. These measurement days may be spread throughout the year, and even across more than one year. In addition, any traffic detector malfunction or human error during the count will lead to inconsistencies in the calibration and validation data.

Since an error-free dataset is unlikely in practice, basic checks are advisable to ease the calibration process and increase the probability of solving for plausible model inputs. We will discuss some of these checks here.

When multiple traffic counts are available for the same road segment, a single realistic value must be selected for inclusion in the calibration dataset. The use of more than one count per segment can lead to biased assessments of goodness of fit, regardless of whether these counts are similar to each other or otherwise. It is also generally a good idea to verify if the counts are consistent with the capacities that may be expected at each location. Formula fields may be used in a dataview in TransModeler to quickly compare counts against the number of lanes multiplied by an assumed maximum flow rate per lane to highlight potential problem areas where counts exceed capacity (Help: Doing Calculations with Data). Such occurrences could point to measurement errors, network coding errors (e.g. the number of lanes), or incorrect count data entry. A common issue encountered in practice is the count being placed on the wrong side of the street, or on a nearby parallel street.

It is recommended that traffic counts be spot-checked for spatial and temporal consistency in the vicinity of each count location. The counts should be reviewed to ensure that they are balanced at all segments between intersections in the corridor, in both directions. Because sparse count coverage is likely the norm, qualitative assessments may be conducted in the absence of counts on certain segments. For example, Figure 7-44 illustrates an infeasible pair of counts even if the unobserved off-ramp count were zero. Because traffic simulation implicitly enforces flow conservation, it will never be able to replicate the counts shown here. The selection tools and map labeling features in TransModeler can assist in the count review process. Maintaining a selection set of segments that have counts labeling the segments with their traffic count values, for example, will assist in the visual inspection of the network, allowing you to more quickly identify anomalies. To label segments with their counts, make Segments the working layer in the map, click Labels on the main toolbar, choose the fields containing the counts from the Field drop-down list, choose the desired font settings, and click OK.
7.3.3.1 Analyzing data from multiple days

When full datasets from multiple days are available, care must be taken to identify a day that is relatively free of extreme perturbations such as severe weather, major special events and serious accidents. These external factors may not be considered normal and hence should not be included in the calibration of the base case. Such outliers are better suited for scenario analysis or a segmentation of the model. If special events or weather effects are pronounced and frequent in the study region, a separate calibrated model for each such situation may be warranted since the underlying demand and behavioral patterns could vary significantly from regular days.

Traffic data from short- and medium-duration accidents may also serve as good validation scenarios under near-regular demand conditions but with network capacity disruptions.

7.3.4 Calculate Goodness of Fit

7.3.4.1 Calibration: How to Compare Segment and Turning Volumes to Counts

When the model has passed a visual audit, it is ready for calibration. As a matter of routine in any microsimulation analysis, simulated volumes should be compared with traffic counts. For a host of reasons, the simulated volumes may not compare well to counts, even when turning movement counts are used directly to specify the input demand (see Section 7.2.1.1 for some of the reasons for this) or when O-D matrices producing a good fit with the count data during the ODME process are used (see Section 7.2.2.4 for some of the reasons for this). To compare simulated volumes to field counts, there are three steps:

1. Ensure field counts are available in TransModeler.

   If comparing turning movement volumes, make sure a turning movement table containing counts is available (Section 7.2.1.2). If comparing segment volumes, such as directional counts from tubes or other device, make sure segment counts are available in fields in the Segments dataview. If counts are not already in the Segments dataview, add new fields to the Segments dataview and fill them with count data (Section 7.1.9).
2. Produce simulated volumes.

Check Report Aggregate Volumes in Simulation Settings before running a simulation. Choose the period length matching that of the counts from the Interval drop-down list (Help: Running a Simulation). Checking Report Aggregate Volumes will produce two output tables based on the simulation: Segment Volumes & Speeds and Turning Movement Volumes. Start a simulation and enter the desired file names for the tables.

3. Join the simulated volumes to the count table or dataview.

After the simulation is complete, choose File > Open to open the Segment Volumes & Speeds table if comparing segment volumes or open the Turning Movement Volumes table if comparing turning movement volumes. Right-click on the dataview and choose Join. If comparing segment volumes, choose Join any table to a map layer and choose Join. If comparing segment volumes, choose Join any table to a map layer and join the Segment Volumes & Speeds table to the Segments layer base on ID. If comparing turning movement volumes, choose Join turning movement tables, navigate to the field counts table to open it, and choose whether you want the counts or simulated volumes on the left or right side of the join.

After Steps 1-3 above, the tables containing the counts and the simulated volumes are joined together in a single dataview. The fields in the output segment volume table will begin with “AB_Vol_” and “BA_Vol_,” and fields named “AB_Vol” and “BA_Vol” will contain the volumes summed across all periods. Similarly, the fields in the output turning volume table will begin with “Vol_,” and “Vol” will contain the count summed across all periods.
Choose one of the following options for comparing the volumes:

1. Label the segments with the values from multiple fields to see both the count and simulated volume alongside the segment in the map. Make Segments the working layer, click Labels  on the main toolbar, and choose Multiple Fields in the Field drop-down list to label the segments (Help: Creating Labels). Figure 7-45 provides an example of segments labeled with counts and simulated volumes.

2. Display the turning movement data in the map so you can see both the counts and simulated volumes side by side. On the Intersections tab on the TransModeler Sidebar, two Data Fields can be. Choose the turning movement count field from one drop-down list and the field containing the simulated volumes from the other. The values in the second field will be displayed in parentheses. Figure 7-46 provides an example of an intersection displaying counts and simulated turning movement volumes.

3. Create a scatter plot of simulated volumes and counts that includes calculated goodness-of-fit measures, such as the slope and intercept of the regression equation, \( \text{R}^2 \) value, and the relative root mean square error (%RMSE) by choosing Tools > Calibration/Validation > Scatter Plot (Help: Scatter Plots).


5. Export the table to Excel and use Excel to do the goodness-of-fit analysis. Right-click in the dataview, choose Save Dataview As, and choose Excel from the Save as type drop-down list.

A model well-calibrated to counts will satisfy all the following targets:

- 85% of the peak-hour counts in the study area should be matched by peak-hour simulated volumes with an error less than or equal to 15% (the 85/15 rule).
- The slope of the regression line should be close to 1; specifically, not less than 0.95 and not greater than 1.05.
- The intercept of the regression line should be close to zero; specifically, an absolute value less than 10.

While the 85/15 rule can be confirmed with formula fields and selection sets in the dataview (e.g., by dividing the simulated volume by the count), you may find it simpler to do in Excel. The purpose of the second and third criteria are to ensure that there is no clear bias toward underestimation or overestimation in the 85/15 rule. For instance, a model may satisfy the 85/15 rule but with a slope closer to 0.85 than to 1.0, which would indicate a model that is systematically low relative to the counts and that may thus underestimate delay and other measures of congestion. A slope near 1 and intercept near 0 will ensure that no such bias exists.

%RMSE is another useful statistic that will clearly quantify the model’s fit to the data and facilitate the monitoring/assessment of calibration progress.

### 7.3.4.2 Validation: How to Produce Simulated Travel Time Outputs

When a good fit between simulated volumes and counts is achieved, the model is ready for validation. Validation is like calibration in that simulated outputs should be compared with observed data, only that data should be a different and independent set of measurements from than the counts against which the model was calibrated. Unless otherwise indicated by ODOT, validation should entail comparison of simulated speeds, travel times, or queue lengths with speeds, travel times, or queue lengths measured in the field.

To compare simulated with observed speeds, click *Project Settings* on the *Simulation* tab on the *TransModeler Sidebar* and choose to collect *Flow & Travel Time* data on the *Output* tab. After running a simulation, create a *Segment Statistics* report or table using the tools on the *Output* tab on the *TransModeler Sidebar*.

To compare simulated with observed travel times, there are three options:

1. If the observed travel time data include measurements between boundaries of the study area (i.e., between the origins and destinations of trips in the model), then choose to collect *Trip Statistics* on the *Output* tab in *Project Settings*, run a batch simulation, and create a *Trip Statistics O-D Matrix* using the tools on the *Output* tab on the *TransModeler Sidebar* (Section 7.4.2.1).

2. If the travel time data is for a specific corridor in the study area, then create selection sets of the links making up the corridor, choose the selection sets by clicking on *Choose Corridors/Urban Streets* on the *Output* tab on the *TransModeler Sidebar* (Help: Defining Urban Streets and Corridors for Output Data Reporting), and choose to collect *Flow & Travel Time* output on the *Output* tab in *Project Settings*. After running a batch simulation, create a *Corridor Travel Time* report in the *Output* tab (Help: Flow & Travel Time Reports).

3. If the travel time data are between specific locations within the study area (e.g., based on probe vehicle trips), such as ramp-to-ramp travel times, then add sensors to mark the starting and ending points of the measurements using the *Add Sensor* tool. In the *Edit Sensor Properties* dialog box, choose *Vehicle-to-Roadside Communication Data* for each sensor station, and choose to collect *VRC Sensor Data* output on the *Output* tab in *Project*
Settings. After running a batch simulation, create a \textit{VRC Sensor Matrix} using the tools on the \textit{Output} tab on the \textit{TransModeler Sidebar} (\textit{Help: VRC Sensor Reports}).

To compare simulated with observed queue lengths, click \textit{Project Settings} on the \textit{Simulation} tab on the \textit{TransModeler Sidebar} and choose to collect \textit{Lane Queue} data on the \textit{Output} tab. After running a simulation, create a \textit{Lane Queue} report or table using the tools on the \textit{Output} tab on the \textit{TransModeler Sidebar}.

### 7.3.4.3 Calibration Parameters by Facility Type

There are numerous parameters that can be used to calibrate a TransModeler simulation model and these vary by facility type. \textbf{Table 7-11} provides a list of calibration parameters, the corresponding TransModeler measure of effectiveness, and the observed or measured field data element with which the MOE can be compared. In theory, the more calibration parameters that can be used, the better the calibrated model will be.

\textbf{Table 7-11. Recommended TransModeler Calibration Parameters}

<table>
<thead>
<tr>
<th>Facility Type</th>
<th>Calibration Parameter</th>
<th>TransModeler MOE</th>
<th>Field Data Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeways/Multilane Highways</td>
<td>Free-Flow Speed</td>
<td>Average Speed(^1)</td>
<td>Observed Average Speed(^1)</td>
</tr>
<tr>
<td></td>
<td>Congested Speed</td>
<td>Average Speed</td>
<td>Observed Average Speed</td>
</tr>
<tr>
<td></td>
<td>Lane Volume</td>
<td>Flow(^2)</td>
<td>Directional Count</td>
</tr>
<tr>
<td>Two-Lane Highways</td>
<td>Free-Flow Speed</td>
<td>Average Speed(^1)</td>
<td>Observed Average Speed(^1)</td>
</tr>
<tr>
<td></td>
<td>Congested Speed</td>
<td>Average Speed</td>
<td>Observed Average Speed</td>
</tr>
<tr>
<td>Signalized Intersections</td>
<td>Back of Queue</td>
<td>95th-Percentile Queue(^3)</td>
<td>Back-of-queue(^4)</td>
</tr>
<tr>
<td></td>
<td>Turning Volume</td>
<td>Flow</td>
<td>Turning Movement Count</td>
</tr>
<tr>
<td></td>
<td>Lane Utilization</td>
<td>Flow(^3)</td>
<td>Lane Volume</td>
</tr>
<tr>
<td></td>
<td>Average Phase Duration</td>
<td>Average Phase Duration(^6)</td>
<td>Average Phase Duration</td>
</tr>
<tr>
<td></td>
<td>Saturation Flow Rate</td>
<td>Flow(^3)</td>
<td>Saturation Flow(^5)</td>
</tr>
<tr>
<td></td>
<td>RTOR</td>
<td>RTOR Flow(^6)</td>
<td>RTOR Count</td>
</tr>
<tr>
<td>Ramp Terminals/Alternative Intersections</td>
<td>Origin-Destination Traffic Demand</td>
<td>O-D Flows</td>
<td>O-D observations/estimates</td>
</tr>
<tr>
<td></td>
<td>Lane Utilization</td>
<td>Flow(^3)</td>
<td>Lane Volume</td>
</tr>
<tr>
<td></td>
<td>Back of Queue</td>
<td>95th-Percentile Queue(^3)</td>
<td>Back of Queue</td>
</tr>
<tr>
<td>Unsignalized Intersections/Roundabouts</td>
<td>Lane Utilization</td>
<td>Flow(^3)</td>
<td>Lane Volume</td>
</tr>
</tbody>
</table>

\(^1\)Under low demand  
\(^2\)Sensor-based volumes  
\(^3\)Lane-based  
\(^4\)Cycle-by-Cycle  
\(^5\)For “loaded” cycles  
\(^6\)To be included in a future version of TransModeler
7.3.5 Addressing Problems in Visual Audit or Goodness of Fit

7.3.5.1 Revisit and Review the Demand

When a traffic simulation model does not compare favorably with conditions observed in the field, the most common response is to first adjust model parameters to induce the desired outcome. However, before any model parameters are adjusted, you should first scrutinize the demand inputs, since demand inputs vary from one region to the next and generally cannot be measured directly. TransModeler’s default model parameters, on the other hand, are typically drawn from peer-reviewed and published literature that describes the data collection efforts and model estimation methodologies employed. Modifying model parameters first often undercuts the model’s credibility as well as its ability to serve as a reliable arbiter of the relative benefits of proposed alternatives.

For a variety of reasons, a great many of which are described in Section 7.2 of this guidance, measuring unmet demand in the field is fraught with challenges. All data collected in the field are susceptible to error and should not be taken on faith. Thus, counts and the demand inputs they inform should be reviewed with a skeptical eye and always against the backdrop of knowledge of existing conditions (Section 7.3.1) before any changes to model parameters are considered. Neither a good fit with counts in the ODME process nor demand specification based directly on turning movement counts is a guarantee that the demand inputs are an accurate representation of traffic patterns.

There will be situations when it is impossible to verify traffic counts or demand inputs with complete confidence. Once every effort within reason has been made to verify the counts and demand inputs, the second course of action should be to set up an analysis of the site in question (i.e., a signalized intersection approach or weaving section where the simulated performance does not compare well with observations) in HCS with equivalent demand inputs. The HCM methods implemented in HCS are, like all analytical tools, also not without faults but are generally grounded in empirical evidence and scrutinized by knowledgeable engineers and researchers. If an HCS analysis corroborates the simulation result, further adjustment of the demand inputs should be attempted until the simulation model, HCS analysis, and field observations are in reasonable agreement.

Only when the steps described above have been exhausted should you resort to adjusting driver behavior parameters. The exception to this is when the parameter adjustments are motivated by efforts to capture circumstances that are not explicitly captured in a traffic simulation model, such as the effect of sight distance or sun glare on following headways or speeds.

7.3.5.2 Driver Behavior Parameters You May Consider Adjusting

If, during a visual audit of the simulation, the operations do not compare well with observed operations in the field, there are a variety of driver behavior parameters that can be adjusted. Parameters adjusted in the Driver Behavior menu (Simulation > Parameters > Driver Behavior) affect the model globally. Local Parameters, which will override global values at specific locations, can be created for some parameters by placing a parameter marker at the location where the change in behavior is desired and another parameter marker at the location where the change in behavior should cease (Help: Local Parameters). The starting parameter marker should be placed far enough upstream so that drivers have enough time to adjust to the change in parameter value after passing the marker.
The potential driver behavior adjustments, where they can be found in TransModeler, their impacts, and whether a local parameter is available are summarized by desired adjustment in Table 7-12. If any driver behavior parameters are adjusted, the adjustment and rationale for the adjustment should be documented.

Driver behavior parameters that are applied globally (i.e., they are not adjusted locally using local parameter markers) can be assumed to apply equally in future years. Lacking any evidence on which to base any assertions about how drivers will behave differently in the future, the assumption is that driver behavior will not change in any substantive way. For instance, headway buffers adjusted to match observed saturation flow rates in the study area can be assumed to hold in future years if justified based on conditions observed under existing conditions. However, occasionally parameters may be adjusted locally to account for driver responses to location-specific geometric factors that are not captured generically by the driver behavior models. Examples of this include adjustments to lane connector connectivity bias to achieve an observed lane utilization at a signalized intersection. Those bias values may not hold in alternative geometric configurations.

All local parameters that were adjusted in the calibration to existing conditions should be critically examined in build scenarios and, if retained in the build model, should be supported by documentation justifying their retention.
Table 7-12. Summary of Potential Driver Behavior Parameter Adjustments

<table>
<thead>
<tr>
<th>Desired Adjustment</th>
<th>Parameter to Adjust</th>
<th>Impact of Increasing the Value</th>
<th>Local?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saturation Flow Rate or Capacity</td>
<td>Simulation &gt; Parameters &gt; Driver Behavior &gt; Acceleration &gt; Headway Buffers</td>
<td>Reduces Saturation Flow Rate or Capacity</td>
<td>Yes</td>
</tr>
<tr>
<td>Lane Utilization</td>
<td>Connectivity Bias attribute in the Lanes layer (Section 7.1.3.3)</td>
<td>Increases the proportion of vehicles that will consider using that lane connector</td>
<td>No</td>
</tr>
<tr>
<td>Lane Changing</td>
<td>Simulation &gt; Parameters &gt; Driver Behavior &gt; Lane Changing &gt; Mandatory (MLC) &gt; Look Ahead &gt; Initiation of Lane Connector Bias &gt; Response distance</td>
<td>Increases the distance at which the connectivity bias begins to affect the mandatory lane changing decision</td>
<td>No</td>
</tr>
<tr>
<td>Queue lengths and delays at two-way stops or permitted lefts</td>
<td>Simulation &gt; Parameters &gt; Driver Behavior &gt; Merging, Crossing, and Yielding &gt; Headway Thresholds</td>
<td>Increases the gaps vehicle require before making a merging or crossing maneuver</td>
<td>Yes</td>
</tr>
<tr>
<td>Roundabouts</td>
<td>Simulation &gt; Parameters &gt; Driver Behavior &gt; Roundabouts &gt; Headway Thresholds</td>
<td>Increases the gaps vehicle require before entering the roundabout</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Simulation &gt; Parameters &gt; Driver Behavior &gt; Roundabouts &gt; Circulating Lane Preferences (for multi-lane roundabouts)</td>
<td>Increases the proportion of vehicles that will consider using the lane connector that connects to that circulating lane</td>
<td>Yes</td>
</tr>
</tbody>
</table>

7.3.6 Conduct Sensitivity Testing

While a calibrated model may faithfully reproduce the observed data used for that purpose, a robust model needs to produce realistic and reasonable forecasts when the inputs and parameters are perturbed away from their calibrated values. Input changes could include increases to the O-D demand or shifts in departure profiles in response to day-to-day variations or demand management strategies. Network capacities may also vary with changes in vehicle/driver mix, incidents or work zones. The parameters used by various simulation components could also be known only approximately, and the effects of slightly different parameters (such as the coefficients in the route choice utility equations) could be empirically tested. The role of such experiments is to ensure that the model’s sensitivity and stability to small changes are both reasonable and realistic. These changes in outputs may be quantified in both absolute and percentage terms, judged qualitatively, and compared against similar studies from other regions. Ensuring appropriate sensitivities is key to the deployment of a useful model for scenario analysis.

7.3.7 Validate the Model

It is critical to make sure that the model is not over-fit to the narrow range of data used during the calibration stage. An over-fit model may show attractive goodness of fit statistics while performing poorly when tested against a few datasets. To guard against this occurrence, it is advisable to validate the model using data that were not part of the calibration step. One way to perform such
a validation is to use a hold-out sample: the available data are partitioned into two sets (one for calibration and one for validation). If multiple days of data can be obtained, then some of them can be used for calibration while others are set aside for testing the calibrated model’s ability to match data from the validation set. If only one set of data is available, a subset of these counts may be used for calibration. The model’s output flows from the other count locations can then be compared to the left-out data to see if the gaps were filled accurately by the model.

Another method of validation involves using different types of data altogether. For example, the model could be calibrated against traffic counts but validated against speeds or travel times to check if congestion patterns are being matched across both space and time. As indicated at the beginning of this section, this is not an automatic result since a specific value of count (flow) may be generated during both congested and free flowing traffic conditions. A well-calibrated and validated model should replicate both the counts and the formation and dissipation of bottlenecks, queues and spillbacks.

7.4 Output and Performance Measures

Performance measures are those outputs of the simulation that will be used to prioritize improvements, compare benefits of alternative improvements, weigh benefits of a project against its costs, or simply evaluate the merit of a project in addressing an identified need or mitigating an identified problem. The local ODOT district should be consulted to decide the performance measures that are pertinent to a project. The guidance provided here describes how TransModeler can be used to produce a broad spectrum of performance measures.

7.4.1 Preparing to Collect Output

There are four main steps to preparing to produce performance measures:

1. Choose which output to collect during simulation
2. Create any required or desired selection sets
3. Create superlinks
4. Choose whether to use a fixed random seed during simulation

7.4.1.1 Selection Sets for Output Reporting

Selection sets, described in Section 7.1.8, have multiple potential uses relating to simulation output. They can be used to designate a subset of network features (e.g., segments, nodes) for which outputs should be reported, and, when creating reports, which subset of features to include in the report. However, this guidance will focus instead on the specific cases in which selection sets must be defined to produce a desired performance measure. These include:

1. Queue Lengths: a selection set of nodes at which queues will be measured must be chosen in Project Settings (typically, controlled intersections of interest).
2. Corridor Travel Times: A corridor is defined in TransModeler as a specific stretch of road spanning multiple contiguous links. A selection set of links must be created for each stretch of interest.
3. Urban Street LOS: A selection set of links must be created for each contiguous sequence of links representing a single analysis segment of interest.
4. Interchange LOS: A selection set of the links making up the ramp and arterial links making
up the interchange must be created for each interchange.

In all cases, selection sets should be given a meaningful name. The selection sets for corridor travel times, urban street LOS, and interchange LOS will appear in the output reports. For this and other reasons, selection sets should be named in a way that make it easy for ODOT staff and other users of the model to understand their purpose.

Names of selection sets for corridor travel time and urban street LOS reports should begin with the street name, so that they will sort together in reports, and be followed by notable landmarks or cross streets at either end (e.g., Spring St: 4th St to 3rd St).

Similarly, selection sets for interchanges should begin with the name of the freeway and be followed by the name of the arterial (e.g., I-70 Brice Rd).

7.4.1.2 Superlinks for Output Reporting

A superlink is a contiguous sequence of links, typically representing a city block or stretch of roadway, between significant intersections of interest, often signalized intersections. See Section 7.1.7 for additional information about superlinks and how to create them. This guidance will focus on their importance as it relates to preparing for output data collection.

Without superlinks, queue measurements will truncate at the boundary of the link immediately intersecting at the intersection where the measurement begins, and delays accumulated by vehicles experiencing control delay while traversing multiple links on the approach to the controlled intersection will be reduced to those delays experienced on the link immediately intersecting at the controlled intersection. For these reasons, superlinks are critical for queue length and delay reporting.

However, to help with the task of defining superlinks, TransModeler will provide several various warnings when superlinks are not defined or are not defined correctly. For example, if superlinks have not been defined before a simulation that is configured to collect queue or delay output is started, a warning message will appear. Additionally, if delays are experienced on superlinks that do not have a controlled intersection at the downstream end, TransModeler will issue warnings during simulation that refer to the links that should be reviewed.

7.4.1.3 Choosing Which Output to Collect

The types of output that should be collected during the simulation will depend on the types of facilities being evaluated (e.g., freeway, urban street, etc.) and on the purpose and need for the analysis (e.g., alternatives analysis). Identify the output to be collected during the simulation by clicking Project Settings and choosing from the output groups on the Output tab.

Table 7-13 summarizes the Output Groups that should be chosen depending on the facility or facilities being studied, the MOEs that can be reported with each group, and whether a selection set of features (i.e., intersections) or superlinks must be created to report certain MOEs. The MOEs listed in Table 7-13 are the minimum that should be reported for each facility type. Other MOEs can be reported in TransModeler and may be required depending on the project. The MOEs to be reported should be decided with concurrence from the local ODOT district in the scoping stage of the project.
Table 7-13. Output Groups

<table>
<thead>
<tr>
<th>Facility</th>
<th>Output Group</th>
<th>MOEs</th>
<th>Selection Set?</th>
<th>Superlink?</th>
</tr>
</thead>
<tbody>
<tr>
<td>System-wide</td>
<td>Trip Statistics</td>
<td>Total Delay, Average Travel Speed, VMT and VHT</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Flow &amp; Travel Time</td>
<td>VMT and VHT</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Intersections</td>
<td>Delay</td>
<td>Control Delay, LOS</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Lane Queue</td>
<td>Queue Lengths in Distance and Vehicles Queued</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Interchanges</td>
<td>Delay</td>
<td>Travel Time, LOS</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Lane Queue</td>
<td>Queue Length, Vehicles Queued, Spillback Rate</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Freeways</td>
<td>Flow &amp; Travel Time</td>
<td>Density, LOS</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flow, Speed, Density</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Urban Streets</td>
<td>Flow &amp; Travel Time</td>
<td>Corridor Travel Time</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Average Travel Speed, LOS</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

7.4.1.4 Fixing Random Seeds - What You Should Know

Like most traffic simulators, TransModeler is a Monte Carlo simulation. Random number generators and probability distributions are part of the model infrastructure necessary to simulate complex human decisions and behaviors, which are imperfectly understood, imperfectly measured, and imperfectly modeled. Consequently, every simulation will produce a different answer even when model inputs are identical. Just as volumes and operating conditions vary in the field from day to day, so do the outputs of a simulation. Random events, such as queue starvation or cycle failure, may occur in one cycle at a traffic signal but not in the next or in one simulation but not another depending on a chain of pseudo-random events. Microsimulation partly draws its power from the stochastic processes that, though imperfect, reflect real-world phenomena that are inherently heterogenous and random.

The results of a simulation can be replicated when the random seed is fixed. A random seed is a number that initializes the sequence of numbers produced by a random number generator. Fixing the seed is not recommended. Instead, the stochastic properties of microsimulation should be viewed as an asset. Most guidance suggests that microsimulation models should be run many times to achieve a specific level of confidence in the mean of the performance measures reported. This is the general guidance provided here. However, this may be superseded when some ongoing Federal Administration (FHWA) initiatives are completed and new federal guidance becomes available.

In short, it is recommended that both the mean and the standard deviation of a performance measure be reported for a scenario. Both of these metrics are reported automatically for all performance measures in TransModeler. Two scenarios may have different mean measures of performance after running multiple times, but if the standard deviation is high, the differences should not be considered significant. Batch simulations with a minimum of ten runs for each scenario are recommended for reporting statistical summaries of performance measures.

By default, every simulation that is run in TransModeler is automatically assigned a new and different random seed and so will have a different outcome from any other. If, for any reason, results need to be replicated, a non-zero random seed can be entered in the Simulation Settings opened from the Simulation tab on the TransModeler Sidebar (Help: Running a Simulation).
7.4.2 System Performance Measures

The simplest way to characterize the performance of an alternative, particularly if the study area is narrowly focused on the facility or facilities under study, is with a summary measure of overall system performance. System performance measures are simple because they summarize the performance across trips and facilities in one or a small number of measures. However, system performance measures can mask serious, local problems. One example is a signal timing strategy that benefits the majority of trips on a coordinated arterial at the expense of trips on the side streets. Judged by system performance alone, such a strategy may appear attractive. However, the LOS experienced by some users of the system may be deemed unacceptable. For this reason, system performance should not be the only scale used.

The system performance measures that may be used to evaluate a scenario include:

1. Vehicle-Miles Traveled (VMT),
2. Vehicle-Hours of Travel (VHT), and

VMT, VHT, and VHD can be summarized in one of two reports in TransModeler:

1. Trip Statistics: miles and hours traveled, and total delay experienced are tracked on a per-trip basis and summarized for completed trips as well as for partially completed trips and trips denied entry to the network.
2. VMT & VHT: miles and hours traveled, and total delay experienced are summed individually for every segment as vehicles traverse a segment.

7.4.2.1 System Performance from Trip Statistics

Miles traveled, hours traveled, and delay are measured and reported for each trip individually. System VMT, VHT, and VHD are summarized by aggregating those measurements across all trips in a Trip Statistics report. Miles traveled and delay experienced are accumulated as a vehicle traverses segments along its path. Each time a vehicle traverses a segment, the segment’s length is added to the trip’s mileage, and delay, calculated as the difference between experienced time on the segment and travel time according to the segment’s free-flow speed, is added to the trip’s total delay experienced. The hours traveled during a trip is calculated as the difference between arrival and departure time. VMT is thus computed from the sum of distances traveled by all trips, VHT from the sum of all trips’ travel times, and delay from the sum of delays experienced by all trips.

These trip statistics are reported separately in TransModeler for completed trips, trips that were in the network when the simulation started, trips that are still en route when a simulation ends, and trips denied entry to a congested link at its origin when the simulation ends. It is tempting to use the summary measures for completed trips to compare alternatives. However, it is possible that in some scenarios, many more trips are denied entry than in others. For this and other reasons, it is important to consider multiple measures of VMT, VHT, and VHD rather than those summarized only from completed trips.

System performance measures are most appropriate when:

1. Providing a quick, high-level picture of performance in networks spanning large numbers of intersections or interchanges or having multiple intersecting facilities in a single measure,
but not at the expense or exclusion of more detailed consideration of the performance of those individual intersections, interchanges, or facilities.

2. Identifying or filtering a subset of better-performing projects or alternatives from a large set of proposed alternatives in the earlier, planning stages of an analysis.

System measures - VMT, VHT, and VHD - are the principal measures of performance reported in the Trip Statistics report in TransModeler. The Trip Statistics reports include accounting for all trips that were simulated for any part of the analysis period, even if only part of the trip occurred within the analysis period or if a trip failed to enter the network by the end of the simulation due to denial of entry.

7.4.2.2 System Performance from Segment Statistics

Miles traveled, hours traveled, and delay are measured and reported for each segment independently, and system VMT, VHT, and VHD can be summarized by aggregating those measurements across all segments in a VMT & VHT report. Additionally, the system performance measures are automatically grouped in a VMT & VHT report by a segment or link attribute of your choosing. This allows you to summarize VMT, VHT, and VHD by road class, street name, or another distinguishing attribute. Miles traveled and delay experienced are added to a segment’s totals when as a vehicle traverses the length of the segment. The hours traveled on a segment is calculated as the difference between the time a vehicle enters the segment and leaves the downstream end, and hours of delay as the difference between that time and a travel time assuming free-flow speed. VMT is thus computed by multiplying the length of the segment by the number of vehicles that traverse it, VHT from the sum of times all vehicles spent on the segment, and delay from the sum of delays experienced by all vehicles on the segment.

7.4.3 Travel Time Performance Measures

Travel time is a simple but powerful measure of performance because it relates directly to the traveler/user experience. Reduced travel times generally translate to improved mobility and LOS and so are a common and worthy goal of many capacity improvements and congestion mitigation strategies. When comparing travel times to a base, no-build condition, it is possible to estimate the improved trip times that users of the facility might enjoy. VMT, VHT, and VHD performance measures also point to travel time improvements, but in terms that are not directly relatable to users of the facility. There are two ways to report travel times: by trip or by corridor. These options are described below.

7.4.3.1 Origin-Destination Travel Times by Trip

Trip-based travel time (i.e., origin-to-destination travel time), is reported with Trip Statistics (Section 7.4.2.1). To be able to create reports of O-D travel times based on trip statistics, you must choose Trip Statistics on the Output tab in the Project Settings before simulating.

Trip travel times are simply calculated as the difference between a trip’s arrival and departure times. It is worth noting, however, that if multiple paths are possible between the same origin and destination, that trips traveling between the same origin and destination may not necessarily travel the same path. To report trip travel times by origin and destination, use the Output tab on the TransModeler Sidebar to create a Trip Statistics O-D Matrix. TransModeler will create a matrix file (.mtx) containing multiple matrices. In the matrix, each row represents an origin and each column
a destination, and each matrix displays a summary measure such as minimum, maximum, average, and standard deviation of travel time and other statistics. To display the travel time matrix, right-click in the matrix window and choose *Average Travel Time* from the *Show Matrix* menu.

![Travel Time Matrix](image)

Figure 7-47. Origin-Destination Travel Times in a Trip Statistics O-D Matrix

### 7.4.3.2 End-to-End Travel Times by Corridor

Corridor-based travel time is reported for selection sets of corridors specifically chosen for corridor travel time or urban street LOS reporting. To be able to create reports of corridor travel times, you must do the following before simulating:

1. Choose *Flow & Travel Time* on the *Output* tab in the *Project Settings*.
2. Create a selection set of links for each corridor (Section 7.1.8)
3. Identify selection sets to be used for corridor reporting by clicking *Choose Corridors/Urban Streets* on the *Output* tab on the *TransModeler Sidebar*.

Corridor travel times are computed only from trips that travel the entire length of the corridor in sequence based on the time the vehicle enters the first link in the set at one end and time it leaves the last link in the set at the other. Travel time experienced by trips that enter or depart the
corridor at an intermediate location - at any point downstream from the first link or upstream of the last link in the selection set - are excluded from the reported travel time.

7.4.4 Queue Length Performance Measures

Queue length is often a useful measure as a design (e.g., deciding turn bay length) or signal optimization criterion and not as a determinant of LOS, though queue length probably tracks closely with control delay and other performance measures at signalized and unsignalized intersections. Queue length also has important uses as a performance measure in analyzing operations: queues that become too long at one intersection will interfere with the operation of midblock through lanes or upstream intersections. Microsimulation is the best tool with which to analyze the queuing interactions between intersections and facilities. HCM methodologies for interrupted flow facilities (i.e., intersections, interchanges, and urban streets) seek to predict queue lengths, which can inform judgments about the adequacy of storage bay lengths locally at an intersection, but they cannot assess the subsequent impacts on adjacent upstream intersections. Hence, queue length should be used as a determining factor when deciding whether highway capacity analysis alone is suitable for a given project or whether microsimulation is needed to overcome this limitation.

To be able to create reports of queue lengths, you must do the following before simulating:

1. Create a selection set of nodes where you want to report queue lengths (Section 7.1.8)
2. Choose Lane Queue and the selection set on the Output tab in the Project Settings.

At nodes for which queue output data are reported, queue lengths are measured at semi-regular intervals throughout a simulation run. These measurements, or “observations”, are collected into a sampled “set” that are used as the basis for reporting average, maximum and percentile queue lengths both in distance and numbers of vehicles. Note that percentile queue measures are derived explicitly from the simulated measurements rather than from statistical estimation methods that assume a normal distribution per the FHWA Traffic Analysis Toolbox, Vol. 3 Section 6.3.3.

Queue length measurements are confined to superlinks, from the stop bar where the first vehicle in queue is found up to but not beyond the upstream end of the superlink to which the link at the stop bar belongs. If a queue extends upstream beyond the superlink, spillback has occurred, and queue reports will include a spillback rate (i.e., the percentage of the measurements that extended beyond the end of the superlink) to signal either that the superlink is not sufficiently long to cover the queue or that the queue is spilling through an upstream intersection where queue lengths may also be reported.
When persistent spillback is evident in the queue reports, it is important to observe the simulation and to note the interaction between queues at adjacent intersections. The queue length at one intersection with spillback, for example, may not tell the queue’s entire story, nor will the queue length at the adjacent intersection, which may experience far shorter queues without the spillback effects from the first intersection.

### 7.4.5 Level of Service Performance Measures

For most projects, unless otherwise requested by the local ODOT district, LOS should be used to describe the performance of a facility or to rank or compare scenarios or alternatives. Per the HCM, measures of performance that determine LOS (i.e., service measures) are specifically chosen to describe quality of service “from the traveler’s perspective.” LOS is also relatively standard among practitioners, is well-documented in the HCM, and offers a degree of parity between analyses performed with HCS and TransModeler for ODOT. LOS reports created in TransModeler derive LOS from simulation-based performance measures rather than from the deterministic methods and equations in the HCM. The performance measure used to determine LOS in TransModeler is always the same used in the HCM and hence is dependent on the facility being analyzed (e.g., control delay for intersections, density for freeways).

However, while simulation-based LOS in TransModeler and HCS-predicted LOS will share common footing in the performance measures and HCM-defined threshold ranges for LOS for any given facility type, the methods by which the LOS are calculated are inherently different. Thus, the two are not expected to yield the same value for reasons that will vary by facility type.

#### 7.4.5.1 Intersections and Roundabouts

LOS at intersections is determined by control delay, one of multiple causes of total delay, the latter of which is often determined in microsimulation models as the difference between simulated and
free flow travel times. To report intersection LOS in TransModeler, you must choose Delay on the Output tab in the Project Settings before simulating. The Intersection LOS output report automatically labels the data tables according to the intersecting links’ street names, so it is important to label the street names accurately and consistently for ease of review (Figure 7-49).

Figure 7-49. Intersection LOS Report Labeled by Street Names

It is important to distinguish between control delay and other measures of delay commonly found in microsimulation practice. Control delay is that component of total delay attributable to the control characteristics of the intersection - delay that would not have been incurred were the control not present. Delay is also caused by geometric factors (e.g., lane width, grade, and curvature) and by interactions with other vehicles (e.g., incidents, rail crossings, parking maneuvers, and bus stops). Stopped delay, another common measure of delay in microsimulation, is that time spent below a specific speed threshold. Figure 7-50 illustrates the differences between total delay, control delay, and stopped delay.
Before comparing LOS between TransModeler and HCS, it is worth noting that control delay and its relationship to queue formation and discharge are among the most complex phenomena found in simulated traffic operations because of their continuously evolving shape in time-space and varying sensitivities to large numbers of interdependent variables. As such, the HCM methodologies for signalized and unsignalized intersections, interchanges, roundabouts and urban streets feature intensive computational models which require a great level of discernment to objectively compare against simulation-based performance measures.

7.4.5.2 Interchanges

LOS at interchanges is determined by Experienced Travel Time (ETT) – Control Delay combined with Extra-Distance Travel Time (EDTT) – for all movements traveling through the configuration. Interchange LOS is based on threshold ranges of ETT as defined in the HCM Interchanges methodology (HCM 6th Edition Exhibit 23-10). To report experienced travel times and LOS at interchanges in TransModeler, you must:

1. Choose Delay on the Output tab in the Project Settings.
2. Create a selection set of links for each interchange (Section 7.1.8)
3. Identify selection sets to be used for interchange reporting by clicking Choose Interchanges on the Output tab on the TransModeler Sidebar.

Note that the HCM Interchanges methodology is limited strictly to the operations of the surface street intersections; freeway Links are not included in the methodology and hence should not be
included in the selection set (Figure 7-51). Furthermore, the HCM Interchanges methodology has only been validated for interchanges in which the ramp terminals are either both signalized intersections or both roundabouts. LOS for interchanges with unsignalized intersections or any type of mixed-control interchange configuration has not yet been validated, so Interchange LOS reports in TransModeler should not be reported for any such type of interchange.

Figure 7-51. Example of a Selection Set for Interchange LOS

7.4.5.3 Freeways

LOS on freeway facilities is determined by density. A single freeway segment in the context of HCM analyses - that is, a basic, merge, diverge, or weaving segment - may span one or more segments in a simulation database. The reverse is also true: it is possible for a single segment in a TransModeler simulation database to span what would be treated as two analysis segments in the context of HCM methods. TransModeler will automatically determine what kind of analysis is appropriate for each segment in the simulation database, negating the need for selection sets to define them, and will automatically calculate density and the appropriate lanes and influence area of a ramp in a merge or diverge segment. Hence, to report freeway LOS in TransModeler, you need only choose Flow & Travel Time on the Output tab in the Project Settings before simulating.
**Figure 7-52** illustrates the extent of the influence areas for a merge and diverge segment, in which density is measured to report LOS. Though the influence areas span three simulation database segments in each direction and terminate in the middle of long segments, the density reported for the segments nearest to the merge or diverge will automatically be measured only within the extent of the influence area indicated in green.

For this reason, you do not generally need to divide links or segments in any particular way in order to report freeway LOS accurately, with the following exception: there must be at least as many simulation database segments as HCM freeway segment analysis types in TransModeler. If this condition is not met and a segment must be split in two for LOS to be reported appropriately, a warning message will be logged.

A common example of such a configuration is an on-ramp without an acceleration lane followed by an off-ramp without a deceleration lane, connected only by a basic segment with no lane additions or lane drops. Even though the entire length between the on-ramp and off-ramp gores could be modeled with a single segment, it would be analyzed as multiple segments in the context of the HCM freeways methodology. Thus, if the distance between the ramp gores is greater than 3,000’ - the sum of the merge and diverge influence areas - then the segment should be split in two locations to create three segments (**Figure 7-53**) so that TransModeler can report densities for the merge, basic, and freeway segments independently. The HCM 6th Edition Chapter 10 (Freeway Facilities Core Methodology) should be consulted for clarification on freeway segment analyses.
In a Freeway LOS report, densities, measured in passenger car equivalents (PCE) per mile per lane, and LOS are reported by segment. When there are multiple segments within the influence area of a merge or diverge, or multiple basic segments between a merge and diverge, or multiple segments within a weaving section, the densities and LOS values will be duplicated for each segment because the densities are measured across segment boundaries. If you want to divide the segment density and LOS reporting at a location of your choosing, you may split the link to create a node. Density calculations will not span multiple links. Therefore, links should generally be continuous through merge, diverge, or weaving segments. A node dividing two links on a freeway should be avoided unless its purpose is deliberately to effectuate reporting of separate LOS measures.

Segments are ordered in a freeway LOS report upstream-to-downstream according to their distance from the upstream-most segment the freeway and grouped into separate directions or facilities according to their street names (Section 7.1.6.1). Therefore, all consecutive links within a freeway facility should be named consistently and should include the direction in the name.
Figure 7-54. Freeway LOS Report, Organized by Street Name and Segment Type

Note that density is also reported in other reports in TransModeler (e.g., the Segment Statistics report) but are raw densities measured indiscriminately across all lanes and irrespective of segment type or distance from a ramp. Therefore, density values found in other reports should not be compared to densities in freeway LOS reports.

7.4.5.4 Urban Streets

LOS on urban streets is determined by average travel speed, though the cutoff thresholds for each LOS grade varies depending on the free-flow speed. To report average travel speeds and LOS on urban streets in TransModeler, you must:

1. Choose Flow & Travel Time on the Output tab in the Project Settings.
2. Create a selection set of links for each span of urban street for which you want to report LOS (Section 7.1.8).
3. Identify selection sets to be used for interchange reporting by clicking Choose Corridors/Urban Streets on the Output tab on the TransModeler Sidebar.

TransModeler will automatically report average travel speed and LOS separately for each direction if an urban street selection set spans two-way links. The free-flow speed used to determine the cutoffs used to determine LOS will be taken from the road class of the first link in the selection set on the presumption that the road class and free-flow speed are, as they should be, consistent for
the length of the selection. **Figure 7-55** illustrates a stretch of arterial divided into three selection sets in order to report urban street LOS locally for three different sections of interest.

![Figure 7-55. Selection Sets for Urban Street LOS Reporting](image)

7.4.6 Presentation Requirements

7.4.6.1 Customizing Reports and Report Layout

A variety of reports can be created with the tools on the *Output* tab on the *TransModeler Sidebar* (Help: Overview of Output Reports). These tools are summarized in **Table 7-14**.
Table 7-14. Tools for Creating Output Reports in TransModeler

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create Report" /></td>
<td>Create Report</td>
<td>Create a preformatted document-style summary of the performance measures grouped and sorted by street name</td>
</tr>
<tr>
<td><img src="image" alt="Create Table" /></td>
<td>Create Table</td>
<td>Create a table (.bin) summarizing the performance measures</td>
</tr>
<tr>
<td><img src="image" alt="Instant Report" /></td>
<td>Instant Report</td>
<td>Create a document-style report for a single feature (e.g., an intersection) by clicking on it in the map</td>
</tr>
<tr>
<td><img src="image" alt="Instant Chart" /></td>
<td>Instant Chart</td>
<td>Create a bar chart of a performance measure across time intervals (e.g., 15 minutes) for a single feature (e.g., an intersection) by clicking on it in the map</td>
</tr>
<tr>
<td><img src="image" alt="Create Theme" /></td>
<td>Create Theme</td>
<td>Create a thematic map coloring segments in the map based on the value of a performance measure</td>
</tr>
</tbody>
</table>

When you create a report using the Create Table tool ![Create Table](image), the contents of the report will appear in a dataview. From the dataview, the data can be exported to Excel, where you can customize the presentation of the performance measures or arrange them side-by-side for easier comparison across multiple scenarios. Right-click in the dataview, choose Save Dataview As, and choose Excel from the Save as type drop-down list.

### 7.4.6.2 Graphical Representation of Performance Measures

Whereas the preceding sections discuss reports that present performance measures in tabular format, it is useful and may sometimes be required to create visual aids that help to add context to the numerical and tabular performance measures.

**Maps**

When intersection delay by turning movement is among the performance measures requested by the local ODOT district, maps should be created illustrating the delay and LOS for each movement. To help with this task, maps can be saved as images in TransModeler by choosing the File > Save As menu command and choosing an image file type from the Save as type drop-down list in the Save As dialog box. Subsequently, the image can be used to help create these visual aids in another graphics design software.
**Heat Charts**

When reporting LOS for freeway or urban street facilities, heat charts of travel speed will help visualize operations along a corridor along its length and over a span of time (Figure 7-57).
By choosing Flow & Travel Time output on the Output tab in the Project Settings before simulating, you will be able to create heat charts from segment statistics on the Output tab on the TransModeler Sidebar. Segment statistics include such performance measures as density or speed, and heat charts display the change in performance measure over time and space. In the heat charts, the horizontal axis represents time, divided into the chosen output interval, and the vertical axis represents distance from upstream end to downstream end on the chosen freeway or urban street. The vertical axis can be labeled with any character field in the Segments dataview. For example, a field may be created in which the Interstate exit numbers, landmark names, cross-streets names, or other descriptive text may be entered. To add a field to store labels to be used in a heat chart:

1. Make Segments the working layer and click New Dataview to open the Segments dataview.
2. Right-click in the dataview and choose Modify to open the Modify Table dialog box.
3. Click Add Field.
4. Enter a field name (e.g., “Heat Chart Label”) in the Field Name column, choose Character in the Type column, and enter an appropriate field width (in number of characters) in the Width column.
5. Lastly, use the Info tool to click on segments in the map and enter labels in the new field.
Note that a value need not be entered for every segment, but only for those that will aid the audience in interpreting location in the heat chart.

### 7.4.6.3 Project Submittal Requirements

The following materials are to be included in the submittal of a project involving microsimulation analysis:

1. An Archive .zip folder copy of the TransModeler simulation project. The following settings should be applied before the archive .zip folder is created:
   i. Turn off all map labels
   ii. Turn off all map color themes
   iii. Switch all selection sets to ‘Inactive’

2. Any files from other programs used to compile and summarize output data (e.g., Excel spreadsheets)

3. Technical documentation including:
   i. Executive Summary
   ii. Project Background
   iii. Description of Scenarios Analyzed
   iv. Methodology
   v. Measures of Effectiveness (MOE’s)
   vi. Volume Development
   vii. Deviations from Default Values
   viii. Scenario Analysis Summaries
      - Base Year No-Build Analysis
      - Future-Year No-Build Analysis
      - Base Year Build Analysis (if applicable)
      - Future-Year Build Analysis
   ix. Conclusions and Recommendations

For review purposes, a printable digital copy of the report/documentation submittal is preferable, although ODOT may require hard copies as well. The number of hard copies will be determined during the scoping process of each project. For plan sheets, such as site plans, the digital submittal should be legible and to scale when printed as a 11”x17” sheet. Use of the Portable Document Format (PDF) is preferred.

### 7.5 Appendix

#### 7.5.1 Factors to Consider During Scoping

When scoping a project, one of the most important decisions will be whether to use turning volumes or O-D matrices to specify the demand. Numerous factors may inform this decision that are not of a technical nature and/or are not foreseen by this document. Non-technical factors may include budget or schedule, one or both of which may be highly constrained and hence may necessitate a quicker analysis based on turning volumes.
These factors are discussed below.

**What does the ODME approach entail specifically?**

In general, ODME will add to the project schedule because ODME:

1. Represents a multi-part task (i.e., developing the seed matrix, populating a model with traffic counts, running ODME, and reviewing results) in the model development process that simply takes time and care to do correctly,
2. Will be run by the travel demand modeling consultant and so will call for scheduling and coordination, and
3. Is often an iterative process requiring ODME to be run more than once before a satisfactory matrix is produced.

Steps can be taken to minimize the schedule impacts of these factors. For instance, parts of the ODME process can be performed in parallel with other model development tasks. Efforts to develop the seed matrix, for instance, can begin early and continue while counts are collected, and the simulation network is developed. Coordinating work that can be done in parallel will be key to shortening project development schedules. Also, some of the reasons that ODME can be an iterative process, including discovery of errors in counts after the fact, can be mitigated by taking care up front to review inputs to the ODME.

If the project schedule and the travel demand modeling consultant cannot accommodate ODME, then the project should move forward with turning volumes.

**Are operations of adjacent facilities in the study area a significant concern?**

If the project involves analysis of more than one facility (e.g., two intersecting arterials or freeways or an arterial and a freeway), then interactions between the facilities and/or weaving activity near the intersection or interchange between the facilities are likely to be more sensitive to O-D patterns in traffic traveling between the two facilities. It will also be more difficult to detect and to mitigate the effects that the drawbacks of simulation based on turning volumes may have on model results when there are multiple facilities, as opposed to one facility, in the model. For this reason, simulation based on O-D matrices, through which a logical distribution of trips between origins and destinations can be exercised, is recommended.

**Are there five or more intersections or four or more interchanges?**

Like the rationale recommending use of O-D matrices when studying multiple facilities, the implications of the drawbacks of demand based on turning volumes become increasingly difficult to discern and to account for the longer a facility becomes, even when the model includes only one facility. While steps can be taken to prohibit certain paths, such as U-turns at interchanges, these steps have secondary effects that will influence the volumes of vehicles taking permitted paths that overlap the prohibited paths. Moreover, those effects compound and become more difficult to manage as the total number of feasible paths (which necessarily increases with the number of intersections and interchanges) increases.

As intersections increase in number, more opportunities arise for complications in weaving volumes between adjacent and nearby intersections. The same is true of interchanges. As previously described in Section 7.2.1.1, specifying demand by turning volumes precludes any control over the numbers of vehicles taking low-probability paths, such as short trips on a major arterial that require
significant lane changing activity (e.g., a right turn followed closely by a left turn on a multi-lane highway). For these reasons, five intersections and four interchanges are the thresholds at which demand by O-D matrices is recommended. However, demand by turning volumes in study areas that are near these thresholds may be permitted with concurrence from ODOT.

*Are O-D volumes available or trivially derived from TMCs?*

Even when a smaller, simpler traffic study does not meet the thresholds and criteria stated above warranting use of O-D matrices, it may be advisable to use O-D matrices if the either the design volumes are available as O-D volumes or if the TMCs can be trivially translated into O-D volumes, as may often be the case. The decision between O-D matrices and TMCs in such cases is subject to the judgement and experience of the analyst but should be made with concurrence from the Office of Roadway Engineering.
Chapter 8. Presentation of Results

The purpose of this chapter is to provide guidelines on the requirements for analysis documentation and presentation of the results.

8.1 Presentation of Results

Understanding how the results will be used by decision makers is critical to producing a good and effective traffic analysis report. As such, the analyst should present the traffic analysis results in a manner that is concise and understandable to the intended audience. For instance, elected officials and other representatives of the public need to see performance measures that are easily understood by the general public. In such cases, presentation and format of the report should also target a non-technical audience while providing the needed details for a technical reviewer to independently analyze and verify the analysis results presented in the document.

Traffic analysis results can be presented in the following three formats:

- Tabular format
- Graphical format
- Animation (microsimulation analysis only)

The results presented in the above formats should be adequately discussed to enable both technical and non-technical readers to comprehend the content of the analysis.

8.1.1 Tabular Summaries

Tabular summaries should be included for analysis conducted for all studies. This would include Feasibility Studies, Interchange Studies, Corridor Studies and Traffic Impact Studies.

Tables are used to present summaries of the results of the analysis. Raw data from the analysis outputs and other details of the analysis should be attached in the appendices. The outputs from TransModeler analysis should be post-processed to report the average MOEs from multiple simulation runs. Tabular summaries should be prepared to present the results of the comparison of the MOEs for each alternative. Different patterns or colors should be used to discern failing conditions within the elements of the network when comparing the alternatives. Colors used to present key information in the tables should be carefully selected such that the document can maintain its readability when reproduced in black and white ink. At a minimum, the cells should be highlighted using the following color scheme:

- LOD D = Yellow
- LOS E = Orange
- LOS F = Red
- v/c ratio > 0.93 = Orange
- v/c ratio >= 1.0 = Red
- QSR >= 1.0 = Red
Signalized Intersection Tables

Tabular summaries should be developed in two sets. The first set contains tables summarizing analysis results of the entire network for one alternative. These tables are essential to review the integrity of the analysis and provide information used for general comparative analysis. See Table 8-1 for a sample intersection traffic analysis results table. The second set includes a summary of the comparative MOE across multiple alternatives. This table allows the reviewer to clearly understand the operational differences between alternatives rather than flipping through multiple report pages for comparisons. This table is less detailed in regard to specific movements and MOEs at the intersection, but allows the reviewer an easy visual comparison of the intersection results for multiple alternatives. See Table 8-2 for a sample intersection alternatives table.

An intersection traffic analysis results table similar to Table 8-1 is required for analysis conducted for all studies. Depending on the study and the number of alternatives being evaluated, an intersection alternatives comparison table similar to Table 8-2 may also be needed to compare the results.

Table 8-1. Sample Intersection Traffic Analysis Results Table

<table>
<thead>
<tr>
<th></th>
<th>Eastbound Main Street</th>
<th>Westbound Main Street</th>
<th>Northbound Oak Street</th>
<th>Southbound Oak Street</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LT</td>
<td>TH</td>
<td>RT</td>
<td>LT</td>
</tr>
<tr>
<td><strong>2020 AM Peak Hour - No Build Condition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOS Delay</td>
<td>C</td>
<td>D</td>
<td>C</td>
<td>F</td>
</tr>
<tr>
<td>v/c</td>
<td>28.9</td>
<td>42.1</td>
<td>34.8</td>
<td>146.3</td>
</tr>
<tr>
<td>QSR 50th %ile Queue</td>
<td>0.16</td>
<td>0.29</td>
<td>1.15</td>
<td>0.46</td>
</tr>
<tr>
<td></td>
<td>0.62</td>
<td>0.22</td>
<td>1.27</td>
<td>0.75</td>
</tr>
<tr>
<td></td>
<td>62'</td>
<td>112'</td>
<td>570'</td>
<td>675'</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>F</td>
<td>106.8</td>
<td>A</td>
</tr>
<tr>
<td><strong>2020 PM Peak Hour - No Build Condition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOS Delay</td>
<td>C</td>
<td>D</td>
<td>D</td>
<td>F</td>
</tr>
<tr>
<td>v/c</td>
<td>34.3</td>
<td>37.1</td>
<td>36.6</td>
<td>156.1</td>
</tr>
<tr>
<td>QSR 95th %ile Queue</td>
<td>0.08</td>
<td>0.45</td>
<td>1.16</td>
<td>0.25</td>
</tr>
<tr>
<td></td>
<td>0.40</td>
<td>0.33</td>
<td>1.47</td>
<td>0.60</td>
</tr>
<tr>
<td></td>
<td>40'</td>
<td>166'</td>
<td>660'</td>
<td>544'</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>F</td>
<td>122.8</td>
<td>A</td>
</tr>
</tbody>
</table>
Table 8-2. Sample Alternatives Comparison Table

<table>
<thead>
<tr>
<th></th>
<th>No Build – AM</th>
<th>Alternative 1 – AM</th>
<th>Alternative 2 – AM</th>
<th>Alternative 3 - AM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LOS</td>
<td>Delay</td>
<td>LOS</td>
<td>Delay</td>
</tr>
<tr>
<td>Intersection A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NB</td>
<td>E</td>
<td>57.5</td>
<td>E</td>
<td>60.8</td>
</tr>
<tr>
<td>SB</td>
<td>F</td>
<td>97.0</td>
<td>D</td>
<td>54.4</td>
</tr>
<tr>
<td>EB</td>
<td>E</td>
<td>64.9</td>
<td>D</td>
<td>48.3</td>
</tr>
<tr>
<td>WB</td>
<td>F</td>
<td>97.2</td>
<td>E</td>
<td>60.5</td>
</tr>
<tr>
<td>Overall Int.</td>
<td>F</td>
<td>80.0</td>
<td>D</td>
<td>56.2</td>
</tr>
<tr>
<td>Intersection B</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NB</td>
<td>D</td>
<td>37.5</td>
<td>D</td>
<td>40.7</td>
</tr>
<tr>
<td>SB</td>
<td>D</td>
<td>49.5</td>
<td>D</td>
<td>54.3</td>
</tr>
<tr>
<td>EB</td>
<td>D</td>
<td>49.0</td>
<td>C</td>
<td>26.6</td>
</tr>
<tr>
<td>WB</td>
<td>D</td>
<td>36.7</td>
<td>D</td>
<td>52.1</td>
</tr>
<tr>
<td>Overall Int.</td>
<td>D</td>
<td>43.9</td>
<td>D</td>
<td>44.2</td>
</tr>
<tr>
<td>Intersection C</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NB</td>
<td>B</td>
<td>18.3</td>
<td>B</td>
<td>15.9</td>
</tr>
<tr>
<td>SB</td>
<td>C</td>
<td>27.5</td>
<td>C</td>
<td>20.8</td>
</tr>
<tr>
<td>EB</td>
<td>C</td>
<td>29.1</td>
<td>C</td>
<td>21.4</td>
</tr>
<tr>
<td>WB</td>
<td>N/A</td>
<td>N/A</td>
<td>B</td>
<td>17.7</td>
</tr>
<tr>
<td>Overall Int.</td>
<td>C</td>
<td>25.4</td>
<td>B</td>
<td>19.9</td>
</tr>
</tbody>
</table>

Freeway Facilities Results Tables
Tabular summaries for the Freeway Facility operational results must be provided that show the results for the individual segments as well as the overall facility results. Information in the table must include:

- Segment number
- Analysis type
- Location
- LOS
- D/C
- Facility length
- Facility Space Mean Speed
- Facility density
- Facility travel time
- Facility LOS

Table 8-3 shows a sample Freeway Facilities analysis results table.
### Table 8-3. Sample Freeway Facility Operational Results

#### HCS Results (Segments)

<table>
<thead>
<tr>
<th>Segment</th>
<th>Analysis Type</th>
<th>Location</th>
<th>2045 AM No-Build</th>
<th>2045 AM Build</th>
<th>2045 PM No-Build</th>
<th>2045 PM Build</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>LOS</td>
<td>D/C</td>
<td>LOS</td>
<td>D/C</td>
</tr>
<tr>
<td>Seg-1</td>
<td>Basic</td>
<td>South of Off-Ramp to SR-73</td>
<td>D</td>
<td>0.86</td>
<td>D</td>
<td>0.86</td>
</tr>
<tr>
<td>Seg-2</td>
<td>Diverge</td>
<td>Off-Ramp to SR-73</td>
<td>C</td>
<td>0.86</td>
<td>C</td>
<td>0.86</td>
</tr>
<tr>
<td>Seg-3</td>
<td>Basic</td>
<td>North of Off-Ramp to SR-73</td>
<td>C</td>
<td>0.77</td>
<td>D</td>
<td>0.77</td>
</tr>
<tr>
<td>Seg-4</td>
<td>Merge</td>
<td>On-Ramps from SR-73</td>
<td>F</td>
<td>0.88</td>
<td>D</td>
<td>0.88</td>
</tr>
<tr>
<td>Seg-5</td>
<td>Basic</td>
<td>North of On-Ramps from SR-73</td>
<td>F</td>
<td>0.89</td>
<td>E</td>
<td>0.89</td>
</tr>
<tr>
<td>Seg-6</td>
<td>Basic</td>
<td>North of On-Ramps from SR-73</td>
<td>F</td>
<td>1.19</td>
<td>E</td>
<td>0.89</td>
</tr>
<tr>
<td>Seg-7</td>
<td>Diverge</td>
<td>Off-Ramp to Austin</td>
<td>F</td>
<td>1.19</td>
<td>E</td>
<td>0.89</td>
</tr>
<tr>
<td>Seg-8</td>
<td>Basic</td>
<td>North of Off-Ramp to Austin</td>
<td>D</td>
<td>1.00</td>
<td>D</td>
<td>0.75</td>
</tr>
<tr>
<td>Seg-9</td>
<td>Weaving</td>
<td>Between Austin &amp; I-675 WB</td>
<td>D</td>
<td>0.87</td>
<td>D</td>
<td>0.98</td>
</tr>
<tr>
<td>Seg-10</td>
<td>Basic</td>
<td>North of Off-Ramp to I-675 WB</td>
<td>C</td>
<td>0.86</td>
<td>C</td>
<td>0.64</td>
</tr>
<tr>
<td>Seg-11</td>
<td>Merge</td>
<td>On-Ramp from I-675 WB</td>
<td>F</td>
<td>1.08</td>
<td>D</td>
<td>0.81</td>
</tr>
<tr>
<td>Seg-12</td>
<td>Overlap</td>
<td>Between On-Ramp from I-675 WB &amp; Off-Ramp to SR-725</td>
<td>F</td>
<td>1.11</td>
<td>D</td>
<td>0.83</td>
</tr>
<tr>
<td>Seg-13</td>
<td>Diverge</td>
<td>Off-Ramp to SR-725</td>
<td>F</td>
<td>1.11</td>
<td>D</td>
<td>0.83</td>
</tr>
<tr>
<td>Seg-14</td>
<td>Basic</td>
<td>Between SR-725 Off-Ramp/On-Ramp</td>
<td>C</td>
<td>0.86</td>
<td>C</td>
<td>0.72</td>
</tr>
<tr>
<td>Seg-15</td>
<td>Merge</td>
<td>On-Ramp from SR-725</td>
<td>C</td>
<td>0.86</td>
<td>E</td>
<td>0.86</td>
</tr>
<tr>
<td>Seg-16</td>
<td>Basic</td>
<td>North of On-Ramp from SR-725</td>
<td>C</td>
<td>0.87</td>
<td>D</td>
<td>0.87</td>
</tr>
<tr>
<td>Seg-17</td>
<td>Basic</td>
<td>North of On-Ramp from SR-725</td>
<td>F</td>
<td>1.17</td>
<td>D</td>
<td>0.87</td>
</tr>
<tr>
<td>Seg-18</td>
<td>Diverge</td>
<td>Off-Ramp to Dixie</td>
<td>F</td>
<td>1.17</td>
<td>D</td>
<td>0.87</td>
</tr>
<tr>
<td>Seg-19</td>
<td>Basic</td>
<td>North of Off-Ramp to Dixie</td>
<td>C</td>
<td>0.89</td>
<td>D</td>
<td>0.75</td>
</tr>
<tr>
<td>Seg-20</td>
<td>Merge</td>
<td>On-Ramp from Dixie</td>
<td>F</td>
<td>1.12</td>
<td>D</td>
<td>0.84</td>
</tr>
<tr>
<td>Seg-21</td>
<td>Basic</td>
<td>North of On-Ramp from Dixie</td>
<td>F</td>
<td>1.13</td>
<td>D</td>
<td>0.85</td>
</tr>
</tbody>
</table>

#### HCS Results (Facility)

<table>
<thead>
<tr>
<th>Facility Length, mi</th>
<th>12.33</th>
<th>12.33</th>
<th>12.33</th>
<th>12.33</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Mean Speed, mi/h</td>
<td>52.9</td>
<td>61.9</td>
<td>50.0</td>
<td>61.0</td>
</tr>
<tr>
<td>Density, pc/mi/ln</td>
<td>35.7</td>
<td>31.7</td>
<td>37.3</td>
<td>32.2</td>
</tr>
<tr>
<td>Travel Time, min</td>
<td>14.00</td>
<td>12.00</td>
<td>14.80</td>
<td>12.10</td>
</tr>
</tbody>
</table>

| LOS |
| F | D | F | D |
8.1.2 Graphical Presentation

Graphical presentation of the data and results should be carefully created to help understanding of the results. The analyst should simplify the presentation such that both technical and non-technical audiences can easily understand them. Overdoing the presentation by decorating the graphical summaries should be avoided.

Graphical displays are excellent visual tools and are very effective in identifying the effects of each alternative on traffic operations within the analysis area. The lane schematics and link-node diagrams that were developed in the analysis stage can easily be converted into a tool for displaying the results.

Graphical presentation requirements will be dependent on the type of study. The following data will need to be displayed graphically:

- **IMS/IJS**
  - Operational Results
    - Segment Number
    - Analysis Type
    - Location
    - LOS
    - D/C
  - Geometric Data - Stick-figure of No-Build/Build conditions containing:
    - Number of mainline lanes
    - On-ramps/Off-ramps (are they 1-lane or 2-lanes?)
    - Merge/Diverge/Weave configurations
    - Interchanges labeled
    - Ramp metering for the No-Build/Build condition
    - Speed limits
    - Clear distinction between No-Build/Build (i.e. Build shown in red, or No-Build shown with dotted lines and Build shown with solid lines)

- **IOS/Feasibility Studies/Corridor Studies/TIS**
  - Operational Results
    - Graphical presentation typically not necessary
  - Geometric Data - Overall Network
    - Stick-figure of Study Area along crossroad (aerial can be used)
    - Streets labeled
    - Speed limit(s) clearly labeled within the Study Area
    - Distance between intersections (stop bar-to-stop bar if signalized intersection radius return-to-radius return if unsignalized intersections)
    - Clear distinction between No-Build/Build (i.e. Build shown in red, or No-Build shown with dotted lines and Build shown with solid lines)
  - Geometric Data - Intersections
    - Intersection analysis point (I-1, Int-1, etc.)
    - Traffic control type (signal, TWSC, AWSC, Roundabout, including channelized right-turn lanes (free, yield, stop)
    - Number/type of lanes (including channelized right turns, TWLTL, add/drop lanes)
- Number of thru lanes entering/exiting each approach (upstream/downstream travel lanes)
- Full-width length of turn lanes
- Intersection PHF

Examples of operational results and geometric data graphics are shown in Figure 8-1, Figure 8-2, Figure 8-3 and Figure 8-4.

8.1.3 Animation

One of the advantages of microsimulation over analytical tools is its ability to describe or demonstrate the problem and potential solutions by animating the individual vehicles trajectories from the model. Animation can be very effective tool to present traffic analysis results to non-technical audience such as elected officials, policy makers and the general public. Like graphical summaries, animation is an excellent visual tool that can identify and compare the effects of each improvement alternative on traffic operations.

It is possible to record animation from the analyzed system in video format and present the video in various public information platforms such as public meetings and project websites. The animation should be created from parts of simulation results that best exhibit the findings of the analysis. This includes both the time period selected and the viewing angle/location. If it is desired to show a comparative analysis of two alternatives, a side by side display of animations with same traffic loadings should be prepared.

Screen shots of animation of critical locations can also be prepared and presented to the public as still images.
Figure 8-1. Example Operational Results 1
Figure 8-2. Example Operational Results 2
Figure 8-3. Example Geometric Data 1
Figure 8-4. Example Geometric Data 2

NOTES: TURN LANE LENGTHS INCLUDE STORAGE ONLY (NO DIVERGING TAPER)
- FREE-FLOW/SLIP-LANE UNDER YIELD CONTROL
- PROPOSED IMPROVEMENTS
Chapter 9. Documentation

The purpose of this chapter is to provide guidelines on the requirements for analysis documentation. The documentation will be a brief summary to report the overall model process, calibration steps, and calibration results.

9.1 Analysis Documentation

In order to streamline review and to allow for replication of the analysis, the calibration and validation process and resulting changes to the base model should be documented. The documentation should provide justification for any changes of the values of the default parameters and supportive statistics which compares field-measured and calibration MOEs.

The Model Development Documentation form (found here) is provided so that the analyst can easily complete the documentation required to be included in the appendix of the file report or in the project file. The completed documentation form should be submitted with the traffic analysis submission.

Model Development Documentation form must be completed for all Complex Type projects. Also, any Standard Type project where recommended ODOT default values described in this manual were changed will require the completion of the form.

For Standard Type projects that did not change any recommended ODOT default values, the documentation form is not required. A statement should be included with the traffic analysis discussion that no default values were changed.

The form includes the following information:

9.1.1 Project Specific Data

Contains information regarding project specific collected data. This data will have been collected either from other data sources or through field measurement and are critical to the analysis models.

9.1.2 Base Model Development

Contains model assumptions and coding techniques for complex or unconventional geometrics or operations for the base model.

9.1.3 Base Model Calibration and Validation

Contains calibration and validation process, which include calibration targets, and documentation supporting evidence of changing default parameters. Calibration and validation is limited to Complex Type projects only.

9.1.4 Error Checking

Contains information on the errors that could not be resolved.

9.1.5 Alternatives Model Development

Contains assumptions and coding techniques for complex or unconventional geometrics for the alternative models (if they differ greatly from existing conditions).
9.2 Reviewers Checklist

The Reviewers Checklist form must be completed for all traffic analysis and submitted with the traffic analysis.

The Reviewer’s Checklist form (found [here](#)) is used to help ensure quality control on all ODOT analyses. The purpose of quality control reviews is to verify that parameters and assumptions match the study requirements, analyses are performed appropriately, models are properly calibrated, and results are reasonable. Additionally, this checklist will help to ensure that all required files are submitted as part of the review.